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Warranty and liability 
 

Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These application examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
application examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 

Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 

 

Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of Siemens Industry Sector. 

 

Security 
informa-
tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, solutions, machines, equipment and/or 
networks. They are important components in a holistic industrial security 
concept. With this in mind, Siemens’ products and solutions undergo continuous 
development. Siemens recommends strongly that you regularly check for 
product updates. 

For the secure operation of Siemens products and solutions, it is necessary to 
take suitable preventive action (e.g. cell protection concept) and integrate each 
component into a holistic, state-of-the-art industrial security concept.  Third-party 
products that may be in use should also be considered.  For more information 
about industrial security, visit http://www.siemens.com/industrialsecurity. 

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit 
http://support.automation.siemens.com. 

 

 

http://www.siemens.com/industrialsecurity
http://support.automation.siemens.com/
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1 Task Description and Solution 

1.1 Task 

The standardization of automation technology for process engineering plants, in 
the chemical industry for example, is a great challenge. Various processes and 
process steps, different devices and flexibility in the production process make this 
task very difficult.  

One approach for standardization is structuring the user software into equipment 
modules. 

In the DIN EN 61512 standard an equipment module is defined as device control 
within technical equipment. A technical equipment consists of the user program as 
well as of the physical equipment. 

1.2 Solution 

1.2.1 Equipment Modules 

This application example contains standardized equipment modules in form of 
software typicals (process tag types), which are supplied in SIMATIC PCS 7 as a 
multiproject. 

 Reducing the required know-how for application development 

 Reducing the configuration workload 

 Illustrating typical control strategies 

 Unified structures 

 Flexible structure of partial automation solutions 

 

The equipment modules supply a template containing the typical components of a 
partial automation solution, its control, the required logic and the visualization. 

An equipment module is configured independently of the automation hardware and 
is part of a preconfigured PCS 7 project, including the process visualization. Due to 
the hardware-independent configuration and the modular structure, the equipment 
modules can be integrated and added to PCS 7 projects at will. The equipment 
modules are created on the basis of the function blocks and process tag types of 
the PCS 7 Advanced Process Library (APL) and Industry Library (IL). 



1 Task Description and Solution 1 Task Description and Solution 

1.2 Solution 1.2 Solution 
 

Equipment Modules 
Entry-ID: 53843373,    V2.2,    04/2014   6 
 

C
o
p

y
ri

g
h

t 


 S
ie

m
e

n
s
 A

G
 2

0
1

4
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

1.2.2 Overview of the general solution 

Schematic layout 

The following figure shows an example of the equipment modules as part of the 
automation solution. 

Figure 1-1 

Charge of ingredients Pressure control

Temperature control 

Discharge product

Stirrer tank

Equipment modules Partial automation solution

 

 

Description 

The concept of equipment modules offers pre-programmed and unified 
components for creating an automation solution, such as dosing or tempering. 

The equipment modules have been realized in the PCS 7 multiproject as follows:  

 the Component view contains one project for the automation system (AS) and 
one project for the operator station (OS) respectively. 

 the Plant hierarchy contains a hierarchy folder for each equipment module. 

In the AS project all control functions have been realized in form of CFC charts 
(Continuous Function Chart). Furthermore, the AS-project contains a simulation 
which simulates a process, e.g. filling level change, within an equipment module. 

The OS project contains the visualization with one process image each per 
equipment module and shows: 

 the schematic layout of the equipment module 

 a simulation 

 the relevant characteristic values (KPI = Key Performance Indicator) 

 a display of the control quality 

Restriction 

The industrial process is not simulated within the equipment module. 
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Required knowledge 

Basic knowledge of the following subject areas is required: 

 Configuration with SIMATIC PCS 7 and APL 

 Knowledge of control engineering 

 Basic knowledge of process engineering 
 

1.2.3 Core functionality 

The overview screen and the structure of a process image of an equipment module 
are described below. A detailed description of the core functionality of an 
equipment module is available in chapter 5.  

Visualization user interface 

 

Figure 1-2 

Overview Screen Process Image

The visualization user interface of the Equipment Modules consists of an overview 
screen and a process image for each equipment module. 

Overview screen 

The overview screen contains a schematic display, in form of a material flow chart 
of the industrial plant, which contains all equipment modules in the example 
project. 

Via the button of an equipment module you go to the respective process image, 
which contains the functionality and the specific information of an equipment 
module. The process images depicted a respective section from the P&I diagram of 
a plant. 
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Process display 

The process image of the equipment module consists of the following main 
components: 

 Schematic layout of the equipment module 

 Simulation 

 Faceplates for controlling the individual components (aggregates) 

 Trend display for visualizing the controller response 

The process image gives the operator the overview of the respective equipment 
module so he/she can track the response during runtime via the respective 
equipment module by means of time intervals. 

1.2.4 Used hardware and software components 

The application document was created using the following components: 

Hardware components 

Table 1-1 

Component Note 

SIMATIC PCS 7 ES/OS 547C BCE 
WXP 

Used for the PCS 7 V7.1.3 sample project 

SIMATIC PCS 7 ES/OS IPC547D W7 Used for the PCS 7 V8.0 and PCS 7 V8.0 SP1 
sample projects 

 

NOTE If the hardware differs, please observe the minimum installation requirements of 
the software components. The minimum requirements are available in the 
readme file of PCS 7. 

 

Standard software components 

 

Table 1-2 

Component Note 

SIMATIC PCS 7 V7.1 SP 3 Component of SIMATIC PCS 7 ES/OS 547C BCE 
WXP 

SIMATIC PCS 7 V8.0 Component of SIMATIC PCS 7 ES/OS IPC547D 
W7 

SIMATIC PCS 7 V8.0 SP1 Component of SIMATIC PCS 7 ES/OS IPC547D 
W7 

S7-PLCSIM License is not part of SIMATIC PCS 7 

APL Library V7.1 SP5 + Upd1 Component of SIMATIC PCS 7 V7.1 SP3 

APL Library V8.0 Component of SIMATIC PCS 7 V8.0 

APL Library V8.0 SP1 Component of SIMATIC PCS 7 V8.0 SP1 
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Example files and projects  

The following list contains all files and projects that are used in this example. 

Table 1-3 

Component Note 

53843373_EquipmentModules_PCS7V713.zip PCS 7 V7.1.3 sample project 

53843373_EquipmentModules_PCS7V80.zip PCS 7 V8.0 sample project 

53843373_EquipmentModules_PCS7V801.zip PCS 7 V8.0 SP1 sample project 

53843373_EquipmentModules.pdf This document 

 

NOTE The PCS 7 example project is based on the PCS 7 Industry Library (IL) and the 
PCS 7 Advanced Process Library (APL). Whereas the APL is covered by the 
SIMATIC PCS 7 Engineering license, you must obtain a separate Engineering 
license and Runtime licenses for IL.  

The download contains the block "SimAn", which requires a license. The usage 
of this block in your configuration environment or in the process mode obligates 
you to purchase the PCS 7 Industry Library licenses. 

Ordering information can found under the following Entry ID: 60982306. 

 

 

NOTE All procedures, descriptions and screenshots relevant for PCS 7 are based on 
the PCS 7 V7.1 SP3 and are applicable to the PCS 7 V8.0 and PCS 7 V8.0 SP1 
without restrictions. The innovated faceplates of the APL V8.0 do not affect the 
way of operation of the equipment modules and are not described separately. 

 

http://support.automation.siemens.com/WW/view/en/60982306
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2 Basics 

2.1 General 

Automation systems 

Industrial processes, e.g. in the chemical or pharmaceutical industry, are controlled 
using automation technology. 

The degree of automation of the plants varies considerably and depends on the 
plant type and the process.  

An automation solution normally comprises the following aspects: 

 Measurement and control  

 Controlling including higher-level control strategies, if necessary 

 Transmission, processing and display of information 

 Meeting defined steps and procedures 

 Considering complex interactions 

 Ensuring constant product quality 

Process control  

The primary task of the operator is the operative process management based on 
process and plant information regarding production process and its logistics and 
auxiliary processes. 

Using process management guarantees the directed and reproducible adjustment 
of operating conditions and ensures meeting defined tolerance ranges. In the case 
of a failure, measures need to be taken in order to return the process to the desired 
state. Additionally, the process sequence shall be optimized continuously regarding 
costs, quality and safety. 
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2.2 Standardized plant components 

Partial automation solution 

The figure below shows the components of a bioethanol production plant. The 
process is divided into several process steps, such as fermentation and distillation. 

The individual process steps are divided into units, which in return consist of 
various equipment modules such as dosing or agitating. 

This division is the basis for the structure of the partial automation solution. 

 

Figure 2-1 Process steps of the bioethanol process 

2 3 4 5 6 7

Automation solution

1

 

Unit 

The term “unit” stands for a unit in industrial process plants (e.g. stirrer tank 
reactor, fermenter) including the device, sensors, actuators and automation 
software (hardware and software). 

Structured units exist for continuous as well as discontinuous processes.  

A unit variant is the so-called “package unit”. Examples for “package units” are 
refrigeration plants, vacuum systems and packaging machines. Here the 
manufacturer of the mechanical process engineering device provides an 
automation software specifically designed for this device, which is located on a 
separate hardware. The “package unit” is integrated as a whole into a higher-level 
process control system.  

Equipment Module 

An equipment module is a component of a unit and contains sensors, actuators 
and the automation hardware and software. Equipment modules are designed and 
configured to be used in specific applications, e.g. in process technology (doser, 
filling level or temperature control).  

The automation solution of an equipment module is structured as follows: 

 Interconnected and configured process tags 

 Simulation for illustrating the principle of operation 

Each equipment module is summarized in a hierarchy folder and can be integrated 
into existing projects. 
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Control Module 

The control module (aldo control unit) consists of actuators and sensors. In PCS 7, 
the control module is realized with software typicals (process tag types), e.g. for a 
valve, motor or a controller.  

The realization in the CFC chart contains all relevant blocks, interconnections and 
basic parameters. A process tag type is generated from the CFC and is stored in 
the PCS 7 master data library. Any number of instances can be created with this 
process type, e.g. using the Import/Export wizard (IEA).  

Each individual controller designation (process tag designation) is based on a 
uniform name convention. This means the designation states the function and task 
of the control module. 

Unit Template 

A unit template is composed of several equipment modules. 

In a unit template, equipment modules are combined into a partial automation 
function. Additionally a unit template contains a CFC chart with economic or 
process engineering characteristic numbers (KPI characteristics), a CFC chart for 
monitoring the operating time and CFC charts for simulation. 

A unit template is summarized in a hierarchy folder and can be easily integrated 
into and adjusted to existing projects.  

As opposed to the “package units”, the Unit concept does not set up any local 
“insular control” with proprietary hardware, but creates prefabricated software 
solutions for frequently occurring units in a central process control system. Partial 
automation solutions for industrial plants are supplied in a standardized, 
prefabricated and user editable format. The templates only need to be adjusted to 
the existing process technology as well as the automation hardware. This clearly 
reduces the engineering expenses for further similar automation tasks. 

Configuration via templates 

The configuration using templates can be performed on unit level, on equipment 
module level or control module level. 

On the control module level, a template for creating instances is generated via the 
process tag type in PCS 7. Configuration and interconnection of the process tag 
types can be automated using an import/export file.  

Equipment modules or units are duplicated as a unit and adjusted to the respective 
process technology. 

The equipment module and the unit template contain all functions required for the 
automation in form of:  

 CFC charts (instances of process tag types) 

 SFC charts  

 OS pictures 
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3 Design and Structure 

3.1 Name convention of the CFC charts 

A uniform name convention was used for the process tag designation, where the 
function is labeled according to the European EN 62424 standard. The following 
figure shows the composition of a process tag name: 

Figure 3-1 

 FIC_Reflux

Function

F = Flowrate (first letter)

I = Display (second letter)

C = Control (third letter)

Name

 

The following table contains all letters used in the application and their meaning: 

 

Table 3-1 

First letter Meaning 

F Flow rate (“Flow”) 

L Filling level (“Level”) 

N Motor 

P Pressure 

Q Quantity 

S Speed, frequency 

T Temperature 

X User’s choice (first letter) 

Y Control valve 

 

Table 3-2 

Subsequent letter Meaning 

C Control 

F Ratio („Fraction“) 

I Indication 

S Binary control function or switching function (not safety-
relevant) 
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3.2 Plant view 

The equipment modules are realized in two hierarchy layers in the Plant view. 

In the AS project “EquipmentModules_AS_Prj” the first hierarchy layer is empty 
and the subordinate hierarchy layer contains a hierarchy folder for each equipment 
module with the required CPC charts in it. 

The first hierarchy layer of OS project “EquipmentModules_OS_Prj” contains the 
overview screen of all “EquipmentModules.pdl” equipment modules. The 
subordinate hierarchy layer contains a hierarchy folder for each equipment module 
with a process image. The following figure shows a schematic representation of the 
folder structure, i.e. the names of the subfolders deviate from the folder names 
used in the PCS 7 projects. 

Figure 3-2 

EquipmentModules

EquipmentModules

EquipmentModule 1

CFC

LIC_RefluxDrum

Anwenderprogramm

CFC

Simulation

Simulation

EquipmentModules

PDL

EquipmentModule 1

EquipmentModule 1

PDL

AS Project

OS Project

CFC

LIC_Level

EquipmentModule 2

CFC

PI_Tank

Anwenderprogramm

CFC

Simulation

Simulation

CFC

PIC_Split

EquipmentModule 2

EquipmentModule 2

PDL
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4 Control Module 

4.1 Introduction 

A control module is used for controlling individual devices such as motors, valves 
and controllers. The blocks required for this task, e.g. for controlling a valve are 
combined in a process tag. If the same process tag is used several times in the 
project, a process tag type is created from this process tag in PCS 7 and filed in 
the master data library. This process tag type can be used flexibly in the project as 
an instance. 

This chapter gives you detailed information on the structure and functioning of the 
process tag type which form the basis of the process tags of the equipment 
modules. All process tag types are filed in the “EquipmentModules_Lib” master 
data library of the PCS 7 project. 

 

Figure 4-1 

 

 

The process tag types are divided as follows: 

 Measured value display in the “AMON” folder 

 Controller in the “CTRL” folder 

 Motor in the “MOT” folder 

 Valve in the “VAL” folder 

The process tag types have a compact and structured design, i.e. all blocks 
relevant for a process tag are located at defined locations. Relevant channel blocks 
are located in subchart B of a CFC chart. 

Detailed information on configuration and parameter settings is available in chapter 
5 “Equipment Modules”. 
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4.2 “CTRL” controller 

The controller process tag contains the control block, additional monitoring and 
locking functions (interlock functionality) and a connection to a sequential control. 

The process tag types used as an instance in equipment modules are described 
below:  

 “CTRL__Std” for standard PID controls 

 “CTRL_Std4Valve” for standard PID controls with valve connector 

 “CTRL_Std4MPC” for standard PID controls with MPC setpoint specification 

 “CTRL_Splitrange” for controls with a manipulated variable and two actuators 

 “CTRL_RatioMain” and “CTRL_RatioComp” for ratio control 

 “CTRL_MPC4Valve” Multi-variable controller for one control variable 

 “CTRL_MPC” Multi-variable controller for standard control operations 

 

4.2.1 Standard controller 

Process tag type “CTRL__Std” is used for fixed value and cascade control.  

Examples for standard controls are: 

 Filling level control with inlet and outlet 

 Temperature control 

The figure below shows the structure of the controller process tag. 

 

Figure 4-2 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 1

Sheet 2
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Subchart A 

Sheet 1 contains the following blocks: 

 C (“PIDConL”): PID controller  

 CPM (“ConPerMon”): block for permanent monitoring of the control quality 

The operating mode, setpoint, actual and manipulated value outputs of the 
controller are interconnected with the CPM block. 

Sheet 2 contains the following blocks. 

 Connector (“ConnPID”): block for SFC connection (no component of the APL 
or the standard library) 

 Logic blocks for selecting the operating mode and for interlocking 

– SP_LiOp (“Or04”): setpoint source internal / external 

– SP_IntLi (“Or04”): internal setpoint value via interconnection 

– MV_Forced (“SelA02In”): forced manipulated value with selection (“In1” 
undefined, “In2” SFC connection) 

– MV_ForOn (“Or04“): activates forced manipulated value “In2” (MV_Forced) 
at the PID controller 

– ManModOpLi (“Or04”): formation of an OR output signal from field device 
in maintenance mode (channel blocks PV and MV) and invalid process 
value (channel block PV in subchart “B”, sheet 1). 

With the SFC connection operation-relevant data are transferred to the PID 
controller via the logic blocks. Additionally, channel blocks and the interlock block 
(subchart “A”, sheet 3) influence the output signals of the logic blocks.  

 

Sheet 3 contains the following block: 

 Intlock (Intlk08): block for calculating a standardized interlock with optional 
display on the OS. 

Interlock becomes active for invalid process value (MV channel block in subchart 
“B”, sheet 2). In the case of the active interlocking, the controller goes to manual 
mode and uses the forced manipulated value “In1” of the “MV_Forced” block. 

 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value 

 Sqrt (“SwSqrt”): linearization block (block description in the appendix) 

Simulation block “SimAn” is interconnected with “Pcs7AnIn” a channel block. The 
simulated process value is “0”. A linearization of the process value is not performed 
(Mode = 0 in the Sqrt block). 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 
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Sheet 2 contains the following blocks. 

 MV (“Pcs7AnOu”): channel block for signal processing of an analog output 
value 

 CSF (“Or04”): formation of an OR output signal from output “Bad” (process 
value invalid) of channel blocks PV and MV  

 OosAct (“Or04”): formation of an OR output signal from output “OosAct” (field 
device in maintenance mode) of channel blocks PV and MV 

The “PV_In” input of the channel block is interconnected with output “MV” 
(manipulated value) of the PID controller. Additionally, the channel block is 
interconnected with simulation block “SimAn” (subchart “B”, sheet 1). 

 

NOTE If no simulation is used, the real process value (e.g. positioner) must be 
interconnected at output “PV_Out” of channel block MV (“Pcs7AnOu”). The 
simulation is deactivated by entering the value “0” at simulation block “SimAn” at 
input “Sim2Act0p. 

 

 

4.2.2 Standard controller with valve connection 

Similar to "CTRL__Std", the process tag type "CTRL_Std4Valve" is used for fixed 
value and cascade control. In contrast to "CTRL__Std", however, the process tag 
does not include a channel block for the control valve (MV), but is interconnected 
with a valve process tag type ("Val_An"). 

The following section describes the changes as compared with the process tag 
type "CTRL_Std" and which are highlighted in green in the figure below. 

Figure 4-3 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 1

Sheet 5 Sheet 2

Sheet 4

 

Subchart A 

Sheet 3 contains the interlock block which uses the following signals of the valve 
process tag for a standardized interlock with optional display in the OS: 

 signaling of an invalid process value ("Bad" signal) at the MV and Rbk channel 
block  

 signaling of field device maintenance (OosAct signal) at the MV and Rbk 
channel block  
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Sheet 5 contains the following interconnection blocks for quick engineering.  

 to_Valve ("ComStruIn"): Transmits the manipulated variable (MV) and the 
interlock status to the valve process tag 

 from_Valve ("ComStruOu"): Receives the feedback from the actuating signal 
(Rbk), messages indicating invalid process values and field device 
maintenance of the channel blocks MV and Rbk, the control unit (OutUnit) and 
scaling (ScaleOut) of the valve process tag. 

 Subchart B 

 In sheet 1, the messages from the channel blocks of the valve process tag are 
additionally identified at the blocks CSF and OosAct (shifted from sheet 2).  

 Sheet 2 no longer contains a channel block for the signal processing of an 
analog output value, as it is already included in the valve process tag.  

4.2.3 Standard controller with MPC setpoint specification 

Similar to "CTRL_Std4Valve", the process tag type "CTRL_Std4MPC" is used for 
fixed value and cascade control. In contrast to "CTRL_Std4Valve", however, the 
"CTRL_Std4MPC" process tag includes an additional block for connection to the 
process tag of the multi-variable controller ("CTRL_MPC"). Control is effected via 
the manipulated variable of the MPC process tag. 

 

NOTE The following two connections between the process tags "CTRL_Std4MPC" and 
"CTRL_MPC" are to be configured: 

 the blocks "ComStruOu" of the MPC controller and "ComStruIn" of the PID controller 

 the associated MV output parameter of the MPC controller and the SP_Ext input 
parameter of the block "ConnPID" of the PID controller 

 

 

The following section describes the changes as compared with the process tag 
type "CTRL_Std4Valve" which are highlighted in green in the figure below. 

Figure 4-4 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 1

Sheet 2Sheet 5

Sheet 4
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Subchart A 

Sheet 5 additionally contains the following block: 

 to_MPC ("ComStruIn"): Transmits control commands from the PID controller 
("SP_InHiOut", "SP_InLoOut", "PV_Out", "CascaCut", "PV_UnitOut") to the 
MPC controller. 

4.2.4 Split range controller 

Process tag type “CTRL_Splitrange” is used for controlling several manipulated 
variables with one actuator (with restricted effective range and, possibly, opposed 
direction of control action).  

Examples for split range controllers are: 

 Temperature control with separate manipulated variables for heating and 
cooling 

 Pressure control with separate valves for gas feed and for heating and venting 

The figure below shows the structure of the controller process tag. 

 

Figure 4-5 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 1Sheet 4

Sheet 5

 

Subchart A 

Sheet 1 contains the following blocks: 

 C (“PIDConL”): PID controller with continuous output signal 

 CPM (“ConPerMon”): block for permanent monitoring of the control quality 

The outputs operating mode, setpoint, actual and manipulated value of the 
controller are interconnected with the CPM block. 

 

Sheet 2 contains the following blocks.  

 Connector (“ConnPID”): block for SFC connection (no component of the APL 
or the standard library) 

 Logic blocks for selecting the operating mode and for interlocking 

– SP_LiOp (“Or04”): setpoint source internal / external 
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– SP_IntLi (“Or04”): internal setpoint value via interconnection 

– MV_Trk (“SelA02In”): forced manipulated value with selection (“In1” 50, 
“In2” SFC connection) 

– MV_TrkOn (“Or04”): activates forced manipulated value “In2” (MV_Forced) 
at the PID controller 

– ManModOpLi (“Or04”): formation of an OR output signal from field device 
in maintenance mode (channel block PV in subchart “B”, sheet 1 and 
channel blocks of the valve process tags) and invalid process value 
(channel block PV in subchart “B”, sheet 1). 

– ModLiOp (“Or04”): operating mode selection between operator (value “0”) 
and interconnection or SFC (value “1”) 

– ManModLi (“Or04”): manual mode via interconnection or SFC (controlled 
via ModLiOp = 1) 

With the SFC connection operation-relevant data are transferred to the PID 
controller via the logic blocks. Additionally, channel blocks and the interlock block 
(subchart “A”, sheet 3) influence the output signals of the logic blocks. 

 

Sheet 3 contains the following block: 

– Intlock (Intlk08): block for calculating a standardized interlock with optional 
display on the OS. 

The interlock becomes active for an invalid process value (channel blocks from 
valve process tags). 

 

Sheet 5 contains the following blocks. 

 Lock_Val_Ans (“Or04”): during active interlocking (value “0”) or automatic 
mode of the PID controller (AutAct = “1”) an interconnected valve block is 
operated in automatic mode with output value “Out1” / “Out2” of the 
“SplRange” block. 

 Split range (“SplRange”) block for dividing the output signal of a PID controller 

 Communication blocks for transfer and receiving of control commands (valve 
process tags) 

 to_Val_An1/to_Val_An2 (“ComStruI”): the blocks transfer output values and 
operating modes to valve process tags. 

 from_ValAn1/from_ValAn2 (“ComStruO”): the blocks receive output value, 
operating mode, unit and scaling of the process values from valve process 
tags. 

The split range block divides the manipulated value of the PID controller between 
its outputs (Out1 and Out2). The limit values (Out1Scale and Out2Scale) are 
configured from the communication blocks (from_ValAn1 and from_ValAn2).  

Additionally, the status information (invalid process value, field device in 
maintenance mode) of channel block Rbk of the valve process tags for interlocking 
(subchart “A”, sheet 3) and operating mode selection ModLiOp and ManModLi 
(subchart “A”, sheet 2). 
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Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value 

 Sqrt (“SwSqrt”): linearization block (block description in the appendix)  

 CSF (“Or04”): formation of an OR output signal from output “Bad” (process 
value invalid) of channel blocks PV and the channel blocks of the valve 
process tags. 

 OosAct (“Or04”): formation of an OR output signal from output “OosAct” (field 
device in maintenance mode) of channel block PV and the channel blocks of 
the valve process tags. 

Simulation block “SimAn” is interconnected with “Pcs7AnIn” a channel block. The 
simulated process value is “0”. A linearization of the process value is not performed 
(Mode = 0 in the Sqrt block). 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 
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4.2.5 Ratio controller 

The ratio controller is composed of a flow rate controller for the main components 
and another flow rate controller for each added component.  

Examples for ratio controllers are: 

 Mixing control of liquids or gases with defined mixing ratios 

 Fuel feed in a defined ratio with air supply for gas burners 

Main component 

Process tag type “CTRL_RatioMain” is used for the main component of ratio 
control, where the setpoint value is default. The flow rate for a further mixing 
component is automatically controlled with the controller process tag 
“CTRL_RatioComp” via a defined ratio.  

The figure below shows the structure of the controller process tag. 

Figure 4-6 

Subchart “ A“ Subchart “ B“

Sheet 1

Sheet 2

Sheet 3

Sheet 1Sheet 4

Sheet 5

Sheet 6

 

Subchart A 

Sheet 1 contains the following blocks: 

 C (“PIDConL”): PID controller with continuous output signal 

 CPM (“ConPerMon”): block for permanent monitoring of the control quality 

The outputs operating mode, setpoint, actual and manipulated value of the 
controller are interconnected with the CPM block. 

 

Sheet 2 contains the following blocks.  

 Connector (“ConnPID”): block for SFC connection (no component of the APL 
or the standard library) 

 Logic blocks for selecting the operating mode and for interlocking 

– SP_LiOp (“Or04”): setpoint source internal / external 

– SP_IntLi (“Or04”): internal setpoint value via interconnection 
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– MV_Forced (“SelA02In”): forced manipulated value with selection (“In1” 
SFC connection, “In2” PID controller) 

– MV_ForOn (“Or04“): activates forced manipulated value “In2” (MV_Forced) 
at the PID controller 

– ManModOpLi (“Or04”): formation of an OR output signal from field device 
in maintenance mode and invalid process value from channel block PV 
(subchart “B”, sheet 1) and interlock block (controller process tag for 
further component, channel block of the valve process tag). 

– ModLiOp (“Or04”): operating mode selection between operator (value “0”) 
and interconnection or SFC (value “1”) 

– ManModLi (“Or04”): manual mode via interconnection or SFC (controlled 
via ModLiOp = 1) 

With the SFC connection operation-relevant data are transferred to the PID 
controller via the logic blocks. Additionally, channel blocks and the interlock block 
(subchart “A”, sheet 3) influence the output signals of the logic blocks. 

 

Sheet 3 contains the following block: 

 Intlock (“Intlk08”): block for calculating a standardized interlock with optional 
display on the OS. 

The interlock becomes active for an invalid process value (channel blocks from 
valve process tags). 

 

Sheet 5 contains the following communication blocks for transfer and receiving of 
control commands (valve process tag for the main component): 

 to_Valve (“ComStruIn”): the communication block forms a structure from the 
manipulated value (MV) of the PID controller and the interlock output (Out) for 
the transfer to a valve process tag. 

 from_Valve (“ComStruOu”): the communication block contains the signals, 
relevant for the interlock (Intlock block), from the channel block (Rbk) of the 
valve process tag. 

Sheet 6 contains the following communication blocks for transfer and receiving of 
control commands (controller process tag for the further components): 

 to_Slave (“ComStruIn”): the communication block forms a structure from the 
outputs (setpoint value, manipulated value, message for cascade connection, 
process value) of the PID controller and the outputs (invalid process value, 
scaling of the process value) of the channel block (PV) for a transfer to the 
controller process tag for further components. 

 from_Slave_1 (“ComStruOu”): the communication block contains the signals, 
relevant for the interlocking and scaling, of the PID controller and the channel 
block of the controller process tag for further components. 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value 

 Sqrt (“SwSqrt”): linearization block (block description in the appendix)  

 CSF (“Or04”): formation of an OR output signal from output “Bad” (process 
value invalid) of channel blocks PV (subchart “B”, sheet 1) and the channel 
blocks of the controller process tags for further components. 
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Simulation block “SimAn” is interconnected with “Pcs7AnIn” a channel block. The 
simulated process value is “0”. A linearization of the process value is not performed 
(Mode = 0 in the Sqrt block). 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 

 

 

Further mixing component “CTRL_RatioComp” 

Process tag type “CTRL_RatioComp” is used for each further mixing component of 
the ratio control, where the setpoint value is derived from the main current via a 
defined ratio factor. 

The figure below shows the structure of the controller process tag. 

Figure 4-7 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 4

Sheet 5

Sheet 6

Sheet 1

Sheet 2

 

Subchart A 

Sheet 1 contains the following blocks: 

 C (“PIDConL”): PID controller with continuous output signal 

 CPM (“ConPerMon”): block for permanent monitoring of the control quality 

The outputs operating mode, setpoint, actual and manipulated value of the 
controller are interconnected with the CPM block. 

 

Sheet 2 contains the following blocks. 

 Connector (“ConnPID”): block for SFC connection (no component of the APL 
or the standard library) 

 Logic blocks for selecting the operating mode and for interlocking 

– SP_LiOp (“Or04”): setpoint source internal / external 

– SP_IntLi (“Or04”): internal setpoint value via interconnection 

– MV_Trk (“SelA02In”): forced manipulated value with selection (“In1” not 
defined, “In2” SFC connection) 
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– MV_TrkOn (“Or04”): activates forced manipulated value “In2” (MV_Forced) 
at the PID controller 

– ManModOpLi (“Or04”): formation of an OR output signal from field device 
in maintenance mode (channel blocks PV and MV) and invalid process 
value (channel block PV in subchart “B”, sheet 1). 

– ModLiOp (“Or04”): operating mode selection between operator (value “0”) 
and interconnection or SFC (value “1”) 

– ManModLi (“Or04”): manual mode via interconnection or SFC (controlled 
via ModLiOp = 1) 

With the SFC connection operation-relevant data are transferred to the PID 
controller via the logic blocks. Additionally, channel blocks and the interlock block 
(subchart “A”, sheet 3) influence the output signals of the logic blocks. 

 

Sheet 3 contains the following block: 

 Intlock (“Intlk08”): block for calculating a standardized interlock with optional 
display on the OS. 

The interlock becomes active for an invalid process value (channel blocks of the 
controller process tags (main component and further mixing components) and 
valve process tags). 

 

Sheet 4 contains the following blocks. 

 RatioSel (“Not01”): block for switching between internal and external ratio 
value in the ratio block 

 Ratio (“Ratio”): block for creating a ratio value 

To create the ratio, the Ratio block uses the setpoint value of the main component. 
Via parameter “RatLiOp” = 0 it is defined, that the ratio value is specified by the 
user and the internal value is used. 

 

Sheet 5 contains the following communication blocks for transfer and receiving of 
control commands (valve process tag): 

 to_Valve (“ComStruIn”): the communication block forms a structure from the 
manipulated value (MV) of the PID controller and the interlock output (Out) for 
the transfer to a valve process tag. 

 from_Valve (“ComStruOu”): the communication block contains the signals, 
relevant for the interlock (Intlock block), from the channel block (Rbk) of the 
valve process tag. 

 

Sheet 6 contains the following communication blocks for transfer and receiving of 
control commands (controller process tag of the main component): 

 to_Master (“ComStruIn”): the communication block forms a structure from the 
outputs (setpoint value, block “Out of order” message , message for cascade 
connection, process value) of the PID controller, of the SCF block (invalid 
process value, scaling of the process value) of the channel block (PV) for the 
transfer to controller process tag for further components. 

 from_Master (“ComStruOu”): from the controller process tag of the main 
component, the communication block contains the signals, relevant for the 
interlocking, of the CSF block as well as the setpoint value of the PID 
controller. 



4 Control Module 4 Control Module 

4.2 “CTRL” controller 4.2 “CTRL” controller 
 

Equipment Modules 
Entry-ID: 53843373,    V2.2,    04/2014   27 
 

C
o
p

y
ri

g
h

t 


 S
ie

m
e

n
s
 A

G
 2

0
1

4
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value 

 Sqrt (“SwSqrt”): linearization block (block description in the appendix) 

Simulation block “SimAn” is interconnected with channel block “Pcs7AnIn”. The 
default process value is “0”. A linearization of the process value is not performed 
(Mode = 0 in the Sqrt block). 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 

 

 

Sheet 2 contains the following blocks. 

 MV (“Pcs7AnOu”): channel block for signal processing of an analog output 
value 

 OosAct (“Or04”): formation of an OR output signal from output “OosAct” (field 
device in maintenance mode) of channel blocks PV and MV 

 CSF (“Or04”): formation of an OR output signal from output “Bad” (process 
value invalid) of channel blocks PV and MV 

The “PV_In” input of the channel block is interconnected with output “MV” 
(manipulated value) of the PID controller. Additionally, the channel block is 
interconnected with simulation block “SimAn” (subchart “B”, sheet 1). 

 

NOTE If no simulation is used, the real process value (e.g. positioner) must be 
interconnected at output “PV_Out” of channel block MV (“Pcs7AnOu”). The 
simulation is deactivated by entering the value “0” at simulation block “SimAn” at 
input “Sim2Act0p”. 
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4.2.6 Multi-variable controller for one control variable 

The process tag type "CTRL_MPC4Valve" is used for fixed value control 
operations, whereby the controlled variable is influenced by one or several 
disturbance variables. 

An example for multi-variable control with one control variable is the regulation of 
the pH value. 

The figure below shows the structure of the controller process tag. 

Figure 4-8 

Subchart „A“

Sheet 1

Sheet 2

Sheet 4

Sheet 5

Subchart „B“

Sheet 1

Sheet 2

 

Subchart A 

Sheet 1 contains the following blocks: 

 MPC ("ModPreCon"): Model-based predictive controller (multi-variable 
controller)  

 CV_Bad ("Or04"): Creates an OR output signal of the channel blocks’ 
hardware errors in the display and valve process tag at the MPC input. 

 CV_Oos ("Or04"): Creates an OR output signal from the channel blocks' 
"OosAct" message (field device in maintenance mode) in the display and valve 
process tag at the MPC input. 

 MV1_TrkOn ("Or04"): Forced manipulated variable (MV1) for the MPC 
controller after hardware error (CV_Bad). 

 MV1_Scale ("StruScIn"): Allocates the manipulated variable scaling to 
MV1HiLim, MV1LoLim, MV1ManHiLim and MV1ManLoLim. 

 AutoExcitation ("AutoExci"): Process excitation signals for the predictive MPC 
controller (only during commissioning of the controller).  

 

Sheet 2 contains the following blocks: 

 Blocks for static operating point optimization of control variables of the MPC 
controller  

 SP1OptHiLim ("Add04"): Adjustment of the upper tolerance limit for SP1 

 SP1OptLoLim ("Add04"): Adjustment of the lower tolerance limit for SP1  

 Connector ("ConnMPC"): Block for the SFC connection (not included in the 
APL or standard library) 
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Sheet 4 contains the following blocks: 

 MPC_CPM_1 ("ConPerMon"): Block for the permanent control quality 
monitoring (SP1Out, MV1 and CV1Out) 

 QI_1 ("MonAnL"): Display and limit monitoring of the mean control deviation for 
the time window defined in "MPC_CPM_1" ("TimeWindow") 

 

Sheet 5 includes the following connection blocks for quick engineering: 

 to_Valve ("ComStruIn"): Transmits the manipulated value (MV) and out-of-
service status ("OOsAct") to the valve process tag. 

 from_Valve ("ComStruOu"): Receives the feedback from the actuating signal 
(Rbk), messages indicating invalid process values and field device 
maintenance of the channel blocks MV and Rbk, the control unit (OutUnit) and 
scaling (ScaleOut) of the valve process tag.  

Subchart B 

Sheet 1 contains the following blocks: 

 Sim ("SimAn"): Simulation block (see block description in the appendix) 

 PV ("Pcs7AnIn"): Channel block for signal processing of an analog input value 

 Sqrt ("SwSqrt"): Linearization block (see block description in the appendix)  

The simulation block "SimAn" is interconnected with a "Pcs7AnIn" channel block. 
Linearization of the process value is not performed (Mode = 0 in the Sqrt block). 
 

Note If no simulation is used, the real process value must be interconnected at the 
input "PV_In" of the PV channel block ("Pcs7AnIn"). The simulation is 
deactivated by entering the value "0" at the input "Sim1Act0p" of the simulation 
block "SimAn". 
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4.2.7 Multi-variable controller for standard control operations  

The process tag type "CTRL_MPC" is used, among others, for fixed value and 
cascade control. In contrast to "CTRL__Std", however, the multi-variable controller 
manages up to four interlinked manipulated and controlled variables. The process 
tag type in the example below is laid out for up to 3 control variables and, if 
required, one further measurable disturbance variable can be acquired. 

 

Note For further information and notes on the model-based predictive controller for 
more than one measurable disturbance variable, please refer to the document 
"SIMATIC Process Control System PCS 7 PCS 7 Advanced Process Library 
V8.0" under the entry ID: 57265842. 

 

 

Due to the complexness of control operations (influenced by up to four control 
variables), the multi-variable controller is preferably used for slower control actions. 

Examples of multi-variable control operations include: 

 regulation of the pH value 

 control of a distillation process (rectification) 

The figure below shows the structure of a controller process tag. 

Figure 4-9 

Subchart „A“

Sheet 1

Sheet 2

Sheet 4

Sheet 5

Subchart „B“

Sheet 1

Sheet 2

Sheet 3Sheet 6Sheet 3

 

Subchart A 

Sheet 1 contains the following blocks: 

 MPC ("ModPreCon"): Multi-variable controller  

 CV_Bad ("Or04"): Creates an OR output signal of the channel blocks’ 
hardware errors in the display process tags "CV" at the MPC input. 

http://support.automation.siemens.com/WW/view/de/57265842
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 CV_Oos ("Or04"): Creates an OR output signal from the channel 
blocks'"OosAct" message (field device in maintenance mode) of the display 
process tags "CV" at the MPC input. 

 MV1_TrkOn ("Or04"): Forced manipulated variable (MV1) for the MPC 
controller after hardware error (CV_Bad) or if the cascade connection between 
the MV1-PID controller and the slave controller has been interrupted. 

 MV2_TrkOn ("Or04"): Forced manipulated variable (MV2) for the MPC 
controller after hardware error (CV_Bad) or if the cascade connection between 
the MV2-PID controller and the MV2 slave controller has been interrupted. 

 MV3_TrkOn ("Or04"): Forced manipulated variable (MV3) for the MPC 
controller, after hardware error (CV_Bad) or if the cascade connection between 
the MV3-PID controller and the MV3 slave controller has been interrupted. 

 AutoExcitation ("AutoExci"): Process excitation signals for the predictive MPC 
controller (only during commissioning of the controller). 

 

Sheet 2 contains the following blocks: 

 Blocks for static operating point optimization of control variables of the MPC 
controller  

– SP1OptHiLim ("Add04"): Adjustment of the upper tolerance limit for SP1 

– SP1OptLoLim ("Add04"): Adjustment of the lower tolerance limit for SP1 

– SP2OptHiLim ("Add04"): Adjustment of the upper tolerance limit for SP2 

– SP2OptLoLim ("Add04"): Adjustment of the lower tolerance limit for SP2 

– SP3OptHiLim ("Add04"): Adjustment of the upper tolerance limit for SP3 

– SP3OptLoLim ("Add04"): Adjustment of the lower tolerance limit for SP3 

 

Note When applying the operating point optimization function, the control variable is 
not assigned to an exact setpoint (e. g. SP1) but to a tolerance range. The 
associated actual value (CV1) may vary within this tolerance. This definition of a 
tolerance range makes the controller more flexible and effective, since the 
process needs not be continuously adjusted to a fixed value. 

 

 

 Connector ("ConnMPC"): Block for SFC connection (not included in the APL or 
standard library), disturbance variable detection "DV1" and transmission of the 
manipulated value to the controller process tags "MV1" to "MV3". 

 

Sheet 4 contains the following blocks: 

 Suppr_CPM_Calc_1 ("Or04"): Suppression of CPI calculation and message,  
if the message suppression was initiated at "MPC_CPM_2" and 
"MPC_CPM_3" (CPI_SuRoot = 1), or if a control performance warning is active 
(CPI_WL_Act = 1). 

 Suppr_CPM_Calc_2 ("Or04"): Suppression of CPI calculation and message,  
if the message suppression was initiated at "MPC_CPM_1" and 
"MPC_CPM_3" (CPI_SuRoot = 1), or if a control performance warning is 
active(CPI_WL_Act = 1). 

 Suppr_CPM_Calc_3 ("Or04"): Suppression of CPI calculation and message,  
if the message suppression was initiated at "MPC_CPM_1" and 
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"MPC_CPM_2" (CPI_SuRoot = 1), or if a control performance warning is active 
(CPI_WL_Act = 1). 

 MPC_CPM_1 ("ConPerMon"): Block for permanent control performance 
monitoring (SP1Out, MV1 and CV1Out) 

 MPC_CPM_2 ("ConPerMon"): Block for permanent control performance 
monitoring (SP2Out, MV2 and CV2Out) 

 MPC_CPM_3 ("ConPerMon"): Block for permanent control performance 
monitoring (SP3Out, MV3 and CV3Out) 

 QI_1 ("MonAnL"): Display and limit monitoring of the mean control deviation 
within the time window ("TimeWindow") defined in "MPC_CPM_1" 

 QI_2 ("MonAnL"): Display and limit monitoring of the mean control deviation 
within the time window ("TimeWindow") defined in "MPC_CPM_2" 

 QI_3 ("MonAnL"): Display and limit monitoring of the mean control deviation 
within the time window ("TimeWindow") defined in "MPC_CPM_3" 

 

Sheet 5 contains the following blocks: 

 from_CTRL_1 ("ComStruOu"): Receipt of control commands from the 
subordinate PID controller process tags for the MPC controller parameters 
("MV1ManHiLim", "MV1ManLoLim" and "MV1Trk") and the block 
"MV1_TrkOn". 

 from_CTRL_2 ("ComStruOu"): Receipt of control commands from the 
subordinate PID controller process tags for the MPC controller parameters 
("MV2ManHiLim", "MV2ManLoLim" and "MV2Trk") and the block 
"MV2_TrkOn". 

 from_CTRL_3 ("ComStruOu"): Receipt of control commands from the 
subordinate PID controller process tags for the MPC controller parameters 
("MV3ManHiLim", "MV3ManLoLim" and "MV3Trk") and the block 
"MV3_TrkOn". 

 

Note The "ComStruOu" blocks help to reduce the amount of configuration work to be 
carried out, i.e. only the following connections are to be configured for each PID 
controller: 

 The "ComStruOu" block of the MPC controller with the "ComStruIn" 
block of the PID controller. 

 The associated MV output parameter of the "ConnMPC" block with the 
SP_Ext input parameter of the "ConnPID" block of the PID controller.  

 

 

Sheet 6 contains the following blocks: 

 to_Indicate_1 (“ComStruIn“): Transfer of signals (analog measured value, unit, 
scale and messages) of the channel block PV1 to the measured value display 
process tag type 

 to_Indicate_2 (”ComStruIn“”): Transfer of signals (analog measured value, unit, 
scale and messages) of the channel block PV2 to the measured value display 
process tag type to_Indicate_3 (“ComStruIn”): Transfer of signals (analog 
measured value, unit, scale and messages) of the channel block PV3 to the 
measured value display process tag type  
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Subchart B 

Sheet 1 contains the following blocks: 

 Sim ("SimAn"): Simulation block (see block description in the appendix) 

 PV1 ("Pcs7AnIn"): Channel block for signal processing of an analog input value 
(CV1) 

 PV1_Scale (“StruScIn“): Scale of the process value for scaling the MPC 
setpoint  

 Sqrt1 ("SwSqrt"): Linearization block (see block description in the appendix)  

The simulation block "SimAn" is interconnected with the "Pcs7AnIn" channel blocks 
PV1 to PV3. No linearization of the process value in the "SwSqrt" block (Mode = 0). 
 

Note If no simulation is used, the real process value must be interconnected at the 
input "PV_In" of the relevant PV channel block ("Pcs7AnIn"). Simulation can be 
deactivated by entering the value "0" at the input "Sim1Act0p" of the simulation 
block "SimAn". 

 

 

Sheet 2 contains the following blocks: 

 PV2 ("Pcs7AnIn"): Channel block for signal processing of an analog input value 
(CV1) 

 PV2_Scale (“StruScIn“): Scale of the process value for scaling the MPC 
setpoint  

 Sqrt2 ("SwSqrt"): Linearization block (see block description in the appendix)  

  

 Sheet 3 contains the following blocks: 

 PV3 ("Pcs7AnIn"): Channel block for the signal processing of an analog input 
value (CV1) 

 PV3_Scale (“StruScIn“): Scale of the process value for scaling the MPC 
setpoint  

 Sqrt3 ("SwSqrt"): Linearization block (see block description in the appendix)  
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4.3 “AMON” measured value display 

General 

Operator control and monitoring of an analog measured value occurs in the 
process tag for measured value display. 

In addition to monitoring, limit values with priorities can be defined. 

Subsequently, the following process tag types are described, which are used as 
instance in equipment modules:  

 “AMON__Std” for measured value display 

 “AMON_Flow” for measured value display with measured value linearization 

 “AMON_Connect” for measured value display for multi-variable control system 

4.3.1 Standard measured value 

Process tag type “AMON__Std” is used for monitoring and measured value display 
of linear signals. 

Examples for measured value display are: 

 Display of a filling level 

 Display of a pressure 

The figure below shows the structure of the process tag for measured value 
display. 

Figure 4-10 

Subchart „A“ Subchart „B“

Sheet 1 Sheet 1

 

Subchart A 

Sheet 1 contains the following block:  

 I (“MonAnL”): block for operator control and monitoring of an analog measured 
value. 

The MonAnL block is used for operator control and monitoring of the analog 
process tag (PV channel block in subchart “B”, sheet 1). Monitoring the tolerance, 
warning and alarm limits is switched visible in the properties of the block. The limit 
values are entered at the block inputs. In the case of limit violations, or if the 
inclination of the signal does not correspond to the requirements, messages are 
generated and output. 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value 
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Simulation block “SimAn” is interconnected with channel block “Pcs7AnIn”. The 
default process value is “0”. 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 

 

 

4.3.2 Linearized measured value 

Process tag type “AMON__Flow” is used for monitoring and measured value 
display of signals, which require linearization, e.g. flow measurement (restrictor 
measurement). For non-linear signals, a square root correction can be performed.  

Examples for measured value display are: 

 Display of a flow rate 

The figure below shows the structure of the process tag for measured value 
display. 

Figure 4-11 

Subchart „A“ Subchart „B“

Sheet 1 Sheet 1

 

Subchart A 

Sheet 1 contains the following block: 

 I (“MonAnL”): block for operator control and monitoring of an analog measured 
value. 

The MonAnL block is used for operator control and monitoring of the analog 
process tag (PV channel block in subchart “B”, sheet 1). Monitoring the tolerance, 
warning and alarm limits is switched visible in the properties of the block. The limit 
values are entered at the block inputs. In the case of limit violations or if the 
inclination of the signal does not correspond to the requirements, messages are 
generated and output. 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 PV (“Pcs7AnIn”): channel block for signal processing of an analog input value  

 Sqrt (“SwSqrt”): linearization block (block description in the appendix) 

Simulation block “SimAn” is interconnected with channel block “Pcs7AnIn”. The 
default process value is “0”. A linearization of the process value is not performed 
(Mode = 0 in the Sqrt block). 
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NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 

 

4.3.3 Standard measured value for MPC 

Process tag type “AMON__Connect” is used for monitoring and measured value 
display of linear signals. The process tag contains no channel blocks and is used 
for measured value display of the multi-variable controller. 

The figure below shows the structure of the process tag for measured value 
display. 

Figure 4-12 

Subchart „A“

Sheet 1

Sheet 2

Sheet 4

Sheet 5

 

Subchart A 

Sheet 1 contains the following block: 

 I (“MonAnL”): block for operator control and monitoring of an analog measured 
value. 

Monitoring the tolerance, warning and alarm limits is switched visible in the 
properties of the block. The limit values are entered at the block inputs. In the case 
of limit violations or if the inclination of the signal does not correspond to the 
requirements, messages are generated and output. 

 

Sheet 5 contains the following block: 

 from_CTRL ("ComStruOu"): The communication block contains a structure, 
which transfer a process value, process value unit, scaling and error status 
(CSF and Oos) to the display. 

 

NOTE For using the maintenance release, the output “MS_Release” of the display block 
must be interconnected additionally at input “MS_Release” of the channel block. 
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4.4 “Val_An” valve 

General 

The following process tag types are described below, which are used as instance 
in equipment modules: 

 “Val_An_Afb1” for controlling an analog valve with feedback signal 

4.4.1 Analog valve (continuously adjustable valves) with position feedback 

The process tag type is used for controlling an analog valve with feedback signal. 
The control signal can be formed via a ramp function. 

The block forms the manipulated value difference from the difference between the 
control signal and the recorded manipulated value feedback. In this way, it is able 
to monitor the compliance with an upper and lower limit value.  

Examples for the valve process tag are: 

 Controlling and monitoring a flow volume (solids, liquids and gases) 

 Controlling and monitoring a flow volume with adjustable rest position 

The figure below shows the structure of a valve process tag. 

Figure 4-13 

Figure 4-14 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 3

Sheet 4

Sheet 5

Sheet 6

Sheet 1

Sheet 2
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Subchart A 

Sheet 1 contains the following block:  

 V (“VlvAnL”): valve block for controlling an analog control valve and positioner 

The valve block contains the external manipulated value from a controller process 
tag via a communication block (from_CTRL in subchart “A”, sheet 6) and controls 
the MV channel block (subchart “B”, sheet 2). The feedback from the control signal 
is given by channel block Rbk (subchart “B”, sheet 1). 

 

NOTE The lower (MV_LoLim = “0”) and upper (MV_HiLim= “100”) limit value for limited 
output of the manipulated value is preconfigured. If a limited manipulated value is 
required, you interconnect the MV_ExtOut output. 

 

 

Sheet 3 contains the following block: 

 Permit (“Intlk08”): switch-on enable for the valve (“1” = enable for 
opening/closing the valve from rest position) 

Intlock (“Intlk08”): block for calculating a standardized interlock with optional display 
on the OS. 

 Protect (“Intlk08”): protective interlock, which after the active signal is going 
(“0”) requires a reset of the valve block 

 BypassAct (“Or04”): forming an OR output signal of the BypAct outputs of the 
interlock blocks (Permit, Intlock and Protect). When bypass is active (“1”) the 
valve block outputs a configurable message (“bypass active”).  

The interlock becomes active for an invalid process value of channel blocks Rbk 
and MV. 

 

Sheet 6 contains the following communication blocks for receiving and transfer of 
control commands (controller process tag): 

 from_CTRL (“ComStruOu”): the communication block contains a structure 
which transfers an external manipulated value and the operating mode 
(automatic mode with external manipulated value) to the valve block. 

 to_CTRL (“ComStruIn”): the communication block forms a structure from 
outputs of the channel blocks (“Process value invalid” message, “Field device 
in maintenance mode”, unit and scaling of the process value and readback 
process value). 
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Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimAn”): simulation block (block description in the appendix) 

 Rbk (“Pcs7AnIn”): channel block for feedback of an analog input value 

Simulation block “SimAn” is interconnected with channel block “Pcs7AnIn”. The 
default process value is “0”. The standard value (PV_Out) of the channel block is 
interconnected with the valve block for the manipulated value feedback. 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block PV (“Pcs7AnIn”). The simulation is deactivated by 
entering the value “0” at simulation block “SimAn” at input “Sim1Act0p”. 

 

 

Sheet 2 contains the following blocks: 

 MV (“Pcs7AnOu”): channel block for signal processing of an analog output 
value 

 OosAct (“Or04”): formation of an OR output signal from output “OosAct” (field 
device in maintenance mode) of channel blocks Rbk and MV 

 CSF (“Or04”): formation of an OR output signal from output “Bad” (process 
value invalid) of channel blocks Rbk and MV 

The “PV_In” input of the channel block is interconnected with output “MV” 
(manipulated value) of the valve block. Additionally, the channel block is 
interconnected with simulation block “SimAn” (subchart “B”, sheet 1). 

 

NOTE If no simulation is used, the real process value (e.g. positioner) must be 
interconnected at output “PV_Out” of channel block MV (“Pcs7AnOu”). The 
simulation is deactivated by entering the value “0” at simulation block “SimAn” at 
input “Sim2Act0p”. 
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4.5 “MOT” motor 

General 

In this process tag the motor is controlled at constant speed. A motor block 
monitors and controls the motor state via control signals. When using an analog 
value, monitoring for limit value violation is additionally possible. 

Subsequently, the following process tag types are described, which are used as 
instance in equipment modules:  

 “MOT_1sp_1fb_1cm__Std” for controlling a motor 

 “MOT_spd_cl_FbDrive” for controlling drives 

4.5.1 Motor with feedback 

The process tag type is used for controlling a motor with feedback signals (motor 
on, maintenance, motor error, local starting and stopping).  

Examples for the motor process tag are: 

 Controlling an agitator 

 Controlling a centrifugal pump with electric motor 

The figure below shows the structure of a motor process tag. 

 

Figure 4-15 

Subchart „A“ Subchart „B“

Sheet 1

Sheet 2

Sheet 1

Sheet 2

Sheet 3

Sheet 1

Sheet 2

Sheet 3
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Subchart A 

Sheet 1 contains the following blocks:  

 U (“MotL”): motor block for controlling a motor via control signals 

 Q (“CountOh”): operating time of the motor since the last reset 

The motor block is configured for different application options. An operating mode 
(local mode, automatic mode, manual mode and out of order) is selected via 
interconnections (CFC, SFC). For controlling the motor, the “Start” reconnection of 
the motor block is interconnected with the Start channel block (subchart “B”, sheet 
3). The feedback for starting the motor is interconnected with the “CountOh” count 
block and the FbkRunOut channel block (subchart “B”, sheet 3).  

 

Sheet 3 contains the following blocks: 

 Permit (“Intlk08”): switch-on enable for the motor (“1” = enable for 
opening/closing the motor from rest position) 

 Intlock (“Intlk08”): block for calculating a standardized interlock with optional 
display on the OS. 

 Protect (“Intlk08”): protective interlock, which after the active signal is going 
(“0”) requires a reset of the motor block 

 BypassAct (“Or04”): forming an OR output signal of the BypAct outputs of the 
interlock blocks (Permit, Intlock and Protect). When bypass is active (“1”) the 
motor block outputs a configurable message (“bypass active”).  

The outputs of the interlock blocks are interconnected with the motor block in sheet 
1. The permit interlock becomes active at an invalid process value of the channel 
block in subchart “B”. The protect interlock becomes active for messages of the 
Maint and StartLocal channelblocks (subchart “B”, sheet 2). 

Subchart B 

Sheet 1 contains the following blocks: 

 Sim (“SimDi”): simulation block (block description in the appendix) 

 FbkRun (“Pcs7DiIn”): channel block for recording a feedback signal during 
motor start 

 LowacFbkRun (“SwLowact”): configurable inversion of the signal (block 
description in the appendix) 

Simulation block “SimDi” is interconnected with all channel blocks in subchart “B”. 
The LowacFbkRun block is interconnected with motor block U. LowacFbkRun 
transfers the feedback for motor start from the FbkRun channel block. 

 

For activating the simulation at the respective block inputs of the simulation block 
(e.g. “Sim1Act0” and “Sim1Value” for channel driver FbkRun) value “1” is default. 

 

NOTE If no simulation is used, the real process value must be interconnected at input 
“PV_In” of channel block FbkRun (“Pcs7Diln”). The simulation is deactivated by 
entering the value “0” at simulation block “SimDi” at input “Sim1Act0p”. 

 

Sheet 2 contains the following blocks: 

 Maint (“Pcs7DiIn”): channel block for recording a maintenance request 
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 LowacMaint (“SwLowact”): configurable inversion of the signal (block 
description in the appendix)  

 Trip (“Pcs7DiIn”): channel block for recording a motor failure? 

 LowacTrip (“SwLowact”): configurable inversion of the signal (block description 
in the appendix) 

 StartLocal (“Pcs7DiIn”): channel block for reporting during local operation 
(starting a motor)  

 LowacStartLocal (“SwLowact”): configurable inversion of the signal (block 
description in the appendix) 

 StopLocal (“Pcs7DiIn”): channel block for reporting for local operation (starting 
a motor)  

 LowacStopLocal (“SwLowact”): configurable inversion of the signal (block 
description in the appendix) 

The LowacMaint, LowacTrip, LowacStartLocal and LowacStopLocal blocks are 
interconnected with motor block U. Additionally, the LowacMaint and 
LowacStopLocal blocks are interconnected with the Protect interlock block.  

For activating the simulation at the respective block inputs of the simulation block in 
sheet 1 (e.g. “Sim1Act0” and “Sim1Value” for channel driver FbkRun) the default 
value is “1”. 

 

NOTE If no simulation is used, the real process values must be interconnected at the 
“PV_In” inputs of the “Pcs7DiIn” channel blocks. The simulation is deactivated by 
entering the value “0” at simulation block “SimDi” at the appropriate input, for 
example, “Sim1Act0p” (for channel block Maint). 

 

Sheet 3 contains the following blocks: 

 Start (“Pcs7nDiOu”): Channel block for starting/stopping the motor 

 FbkRunOut (“Pcs7nDiOu”): channel block for the output of the feedback for the 
motor start 

 OosAct (“Or08”): formation of an OR output signal from output “OosAct” (field 
device in maintenance mode) of all channel blocks and transfer of the status to 
motor block U (subchart “A”, sheet 1). 

 CSF (“Or08”): formation of an OR output signal from output “Bad” (process 
value is invalid) of all channel blocks and transfer of the status to motor block U 
(subchart “A”, sheet 1). Additionally, the status is transferred to the Permit 
interlock block. 
 

The “PV_In” input of the Start channel block is interconnected with output “Start” of 
the motor block (subchart “A”, sheet 1). Additionally, the “PV_In” input of the 
FbkRunOut channel block is interconnected with output “FbkRunOut” of the motor 
block (subchart “A”, sheet 1).  

 

NOTE If no simulation is used, the “PV_Out” outputs must be interconnected with the 
real connections (e.g. motor starter) at the Start and FbkRunOut channel blocks. 
The simulation is deactivated by entering the value “0” at simulation block 
“SimDi” at inputs “Sim6Act0p” and “Sim7Act0p”. 
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4.5.2 Drive with standard telegram type support 

The process tag type is used for controlling a frequency-controlled drive which 
supports standard telegram types. The process tag type is based on the application 
example “Configuration of Frequency Converters with the APL Channel Block 
„FbDrive” under the following entry-ID: 64181993 and was expanded by additional 
blocks. 

 

NOTE The expansion in comparison with the application example “Configuration of 
Frequency Converters with the APL Channel Block „FbDrive” is decribed below.  

 

 

Examples for the motor process tag are: 

 Controlling a rotary feeder 

 Controlling a compressor 

The figure below shows the structure of a drive process tag. 

Figure 4-16 

Subchart „A“

Sheet 1

Sheet 2

Sheet 4

Sheet 5

Subchart „B“

Sheet 3 Sheet 6

Sheet 1

Sheet 2

 

 

Subchart A 

Sheet 1 contains the following blocks: 

 S (“MotSpdCL”): controllable reversible drive 

 On_Fbk (“Or04”): control of motor (forward/reverse) 

 S_ Fbk (“Or04”): feedback of active operation 

 Q (“CountOh”): operating time of the motor since the last reset 

 

Sheet 3 contains the following blocks: 

 Permit (“Intlk08”): switch-on enable for the drive (“1” = enable for 
opening/closing the drive from rest position) 

http://support.automation.siemens.com/WW/view/de/64181993
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 Intlock (“Intlk08”): block for calculating a standardized interlock with optional 
display on the OS. 

 Protect (“Intlk08”): protective interlock, which after the active signal is going 
(“0”) requires a reset of the drive block 

 BypassAct (“Or04”): forming an OR output signal of the BypAct outputs of the 
interlock blocks (Permit, Intlock and Protect). When bypass is active (“1”) the 
drive block outputs a configurable message (“bypass active”).  

 

The outputs of the interlock blocks are interconnected with the drive block in sheet 
1. 

 

Sheet 1 contains the following blocks: 

 FbDrive (“FbDrive”):  channel block for compact drives  

 Fbk_Rev (“And04”):  feedback of reverse operation 

 Fbk_Fwd (“And04”):  feedback of forward operation 

 AV (“AV”):  additional analog value 

 

Sheet 6 contains the following communication blocks for receiving and transfer of 
control commands (controller process tag): 

 from_CTRL (“ComStruOu”): the communication block contains a structure 
which transfers an external manipulated value and the operating mode 
(automatic mode with external manipulated value) to the valve block. 

 to_CTRL (“ComStruIn”): the communication block forms a structure from 
outputs of the channel blocks (“Process value invalid” message, “Field device 
in maintenance mode”, unit and scaling of the process value and readback 
process value). 

 

Subchart B 

Sheet 2 contains the following block: 

 Sim (“SimDi”): simulation block (block description in the appendix) 

Simulation block “SimDi” is interconnected with the technological block (drive 
block) in subchart “A”. 

 

NOTE If no simulation is used, the “Sim1ActOp” input of the simulation block must be 
deactivated and the required inputs of the “FbDrive” channel block to be 
interconnected. 
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5 Equipment Modules 
This chapter contains all relevant information on each equipment module including 
its specific properties. Structure and basic functionality of the used process tag 
types is described in chapter 4 “Control Module”. 

The following equipment modules are described below: 

 “Level-Control” filling level 

 “Ratio-Control” 

 “Split-Range-Pressure” control 

 “Split-Range-Temperature” control 

 Control of the pH value with a standard controller „pH-Control-Std“ 

 Control of the pH value with a multi-variable controller „pH-Control-MPC“ 

 “Temperature-Flow-Cascade” 

5.1 “Level-Control” filling level 

For filling level control, feedstock components are fed into a container via a feed 
pipe and the substance mixture is drained via a drain outlet. The controller reacts 
to deviations of the filling level (difference between inflow and discharge volume) 
and controls these either via reducing or increasing the inflow or drainage.  

The example below solves the filling level control via the drainage (drain outlet). 

5.1.1 Overview 

The structure is displayed in a P&I diagram below and all process tags and the 
simulation of the equipment module are described. 

P&I diagram  

The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols. 

Figure 5-1 

LIC

Inlet

Outlet

Level

YC

OutletValve
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Process tags 

The equipment module “Level-Control” consists of 3 interconnected process tags 
and one simulation chart. In the simulation chart the filling level of a container is 
simulated.  

The following table provides an overview of the process tags of the equipment 
module including the respective process tag types. 

 

Table 5-1 

Process tag  Process tag type Description 

LIC_Level “CTRL_Std” Filling level control of a container 

LI_Level “AMON__Std“ Measured value display for the filling level of a container  

YC_OutletValve “Val_An_Afb1” Control valve for the drain outlet 

 

In the following figure the entire structure, including all interconnections across all 
CFC charts, are represented in a simplified format. 

Figure 5-2 

Sim_Level

Scale

TempLevel

OUT

In1

LI_Level

I

PV

PV

PV_InUnit

Scale

LIC_Level

PV

Bad

PV_OutUnit

Sim

Sim1ValueOp

to_Valve

Out

from_Valve

In

YC_OutletValve

V

MV

from_CTRL

In

to_CTRL

Out

ScaleOut

OosAct

Sqrt

Out

CSF

OosLi

 

Controller process tag “LIC_Level” detects the filling level of the container 
(simulation chart “Sim_Level”) and controls it using the “YC_OutletValve” control 
valve. Process tag “LI_Level” shows the process value (filling level). Additionally, 
faults in the valve process tag set the controller process tag to manual mode and 
are displayed at both process tags. 
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5.1.2 Structure and configuration 

Simulation “Sim_Level” 

The filling level of the container is simulated in CFC chart “Sim_Level”. The graphic 
representation below shows the sequence of the simulation. 

Figure 5-3 

1 2 3 4

 

1. Calculating the flow rate (100 % opened valve corresponds to a drainage of 
500 l/s from the container) 

2. Permanent inflow into the container (100 l/s) 

3. Delaying the flow rate change (PT1 behavior with 5 seconds delay) 

4. Forming an integral value through integrating the flow rate change (each 
second) 

LIC_Level 

In the “LIC_Level” process tag the filling level of the container is recorded and 
transferred to the “LI_Level” process tag for measured value display. The setpoint 
is specified in this process tag. In order to control the filling level, control signals 
are transferred to the “YC_OutletValve” valve process tag via a communication 
block. 

The “LIC_Level” controller process tag was created from the “CTRL__Std” process 
tag type and expanded by two communication blocks (“to_Valve” and 
“from_Valve”). 

The following table shows the configuration of the instance from “CTRL__Std”. 

Table 5-2 

Block Connection Value Usage 

C NegGain.Value 1 Activating the negative gain, since the 
control is used for the drain outlet 

C Gain.Value 2.0 Controller gain  

C TI.Value 300.0 Controller delay 

C SP_InHiLim 10000.0 Maximal value of the internal setpoint 

Intlock InvIn02 1 Inverting the hardware error signal of 
the valve process tag 

Intlock InvIn03 1 Inverting the “Out of service” signal of 
the valve process tag 

ComStruIn   Inserted as “to_Valve”, for transfer of 
control signals to the valve process tag 

to_Valve Out  Interconnecting to the valve (control) 
(YC_OutletValve\from_CTRL.In) 

to_Valve ReStru1  Interconnecting the manipulated value 
to the valve 
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Block Connection Value Usage 

(LIC_Level\C.MV) 

to_Valve   Inserted as “from_Valve” to receive 
status information of the valve process 
tag 

ComStruOut   Interconnecting to the valve (status) 

from_Valve In  (YC_OutletValve\to_CTRL.Out) 

from_Valve Int1  Interconnecting the unit of the 
manipulated value 
(LIC_Level\MV.PV_InUnit) 

from_Valve BoStru1  Interconnecting the hardware error 
from the valve to the interlock block 

from_Valve BoStru2  Interconnecting the “Out of service” 
signal from the valve to the interlock 
block 

(LIC_Level\Intlock.In02) 

Sim Sim1ActOp.Value 1 Activating the simulation of the 
container filling level 

Sim Sim1ValueOp  Interconnecting to the simulated filling 
level 

Sim Sim2ActOp.Value 1 (Sim_Level\TempLevel.Out) 

Sim Sim2ValueOp  Activating the simulation of the 
manipulated value 

PV Scale 10000.0 Maximum value of the process value 

PV PV_InUnit 1038 Unit of the process value (L) 

PV Bad  Interconnecting the hardware error 
from the channel block to the process 
tag for the process value display  

PV PV_OutUnit  (LI_Level\I.CSF) 

PV ScaleOut  Interconnecting the unit from the 
process value to the process tag for 
the process value display  

PV OosAct  (LI_Level\PV.PV_InUnit) 

Sqrt Out  Interconnecting the process value to 
the display block  

(LIC_Level\I.PV) 

 

LI_Level 

In the “LI_Level” process tag, the measured value of the channel block of the 
“LIC_Level” process tag is displayed. Limit values (alarm, warning) are not set in 
the operator control and monitoring block (MonAnL), since these are defined 
specifically for each process. 

The following table shows the configuration of the instance from “AMON__Std”. 

Table 5-3 

Block  Connection Value Usage 

I PV  New interconnection to the process 
value of the controller process tag 

(LIC_Level\Sqrt.Out) 

I OosLi  New interconnection to the “Out of 
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Block  Connection Value Usage 

service” signal of the channel block of 
the controller process tag 

(LIC_Level\PV.OosAct) 

I CSF  New interconnection to the “Bad” 
signal of the channel block of the 
controller process tag 

(LIC_Level\PV.Bad) 

PV Scale  Interconnecting the scaling of the 
manipulated value 
(LIC_Level\PV.ScaleOut) 

PV PV_InUnit  Interconnecting the unit of the 
process value  

(LIC_Level\PV.PV_OutUnit) 

 

YC_OutletValve 

The “YC_OutletValve” process tag controls the flow volume (opens the drain outlet 
of the container). The process tag contains communication blocks for data 
exchange (control signals and control commands) with the controller process tag. 

Valve block “V” receives an external manipulated value (via a communication 
block) from the controller process tag. Both channel blocks in subchart “B” (Rbk 
and MV) receive the same value in a simulation environment (manipulated value of 
the valve block (subchart “A”, sheet 1)) via the preceding simulation block. 

The following table shows the configuration of the instance from “Val_An_Afb1”. 

Table 5-4 

Block Connection Value Usage 

V MV  Interconnecting to the simulation 

(Sim_Level\Scale.In1) 

V ER_AH_En 0 Switching off the alarm message for maximal 
valve opening 

V (invisible) 0 Switching off the alarm message for minimal 
valve opening 

from_CTRL In  Interconnection to the controller 

(LIC_Level\to_Valve.Out) 

to_CTRL Out  Interconnection to the controller 

(LIC_Level\from_Valve.In) 

Sim Sim1ActOp.Value 1 Activating the simulation of the readback value 

Sim Sim1ValueOp  Interconnecting with the simulation of the 
readback value from the valve 

(YC_OutletValve\V.MV) 

Sim Sim2ActOp.Value 1 Activating the simulation of the manipulated 
value 

Sim Sim2ValueOp  Interconnecting with the simulation of the 
manipulated value from the valve 

(YC_OutletValve\V.MV) 

Rbk PV_OutUnit  Interconnecting the unit of the manipulated 
value of the valve 
(YC_OutletValve\to_CTRL.Int1) 
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5.1.3 Commissioning, operation and instance-specific adjustments 

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module” 

Commissioning  

Please wait 3 minutes after the start of the CPU (in the initial state) until the 
container reaches the maximum filling level. 

For commissioning, please follow the instructions below: 

Table 5-5 

No. Action 

1.  Click on the block icon of the “LIC_Level” controller. The respective faceplate is 
opened. 

 

2.  Change the operating mode of the controller. In the faceplate you click on the 
“…” button next to the mode switch (“Mode”) and in the faceplate extension you 
click on the “Automatic” button and adopt the settings with “OK”. 

3.  For changing the setpoint value you click on the “Setpoint” input field and enter 
the setpoint value in the faceplate expansion. Acknowledge the input with 
“ENTER” and adopt the new value with “OK”. 
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Operation 

The following instruction describes the operation of the equipment module “Level 
Control”. 

In the following scenario, the filling level is reduced from 10000 L auf 2000 L. 

Table 5-6 

No. Action 

1.  Click on the block icon of the “LIC_Level” controller and click into the “Setpoint” 
input field. 

2.  In the faceplate expansion you enter the new setpoint of 2000. Then 
acknowledge the input with the “Enter” key and click on the “OK” button. 

 
Note: 

Instead of the internal setpoint you can also set using an external setpoint value 
in this step. 

 

Evaluation 

In order to illustrate the principle of operation of the filling level control, the 
controller was configured so the setpoint value is reached quicker. Due to this 
configuration, the filling level slightly overshoots during controlling. 

Figure 5-4 

 

 

2

1
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Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices.  

The following table contains the parameters to be set specifically for each process. 

Table 5-7 

Process tag Block Connection Usage 

LI_Level I 

Subchart “A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

LI_Level I 

Subchart “A” 

PV_WH_En  Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

LI_Level I 

Subchart “A” 

PV_WL_En  Warning for falling below the limit value, 

if PV ≥ PV_WL_Lim 

LI_Level I 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

LIC_Level C 

Subchart “A” 

Gain Proportional gain 

LIC_Level C 

Subchart “A” 

TD Derivative time (rate time) in [s] 

LIC_Level C 

Subchart “A” 

TI Integral time (reset time) in [s] 

LIC_Level C 

Subchart “A” 

SP_InHiLim Limit value (high) of the internal 

LIC_Level C 

Subchart “A” 

SP_InLoLim Limit value (low) of the internal 

setpoint value 

LIC_Level C 

Subchart “A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

LIC_Level C 

Subchart “A” 

PV_WH_En  Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

LIC_Level C 

Subchart “A” 

PV_TH_En Warning for falling below the limit value, 

if PV ≥ PV_TH_Lim 

LIC_Level C 

Subchart “A” 

PV_TL_En Tolerance for falling below the limit 

value, if PV ≤ PV_TL_Lim 

LIC_Level C 

Subchart “A” 

PV_WL_En  Warning for falling below the limit value, 

if PV ≥ PV_WL_Lim 

LIC_Level C 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

LIC_Level C 

Subchart “A” 

ER_AH_En 
(invisible) 

Alarm for exceeded error signal,  

if ER ≥ ER_AH_Lim 

LIC_Level C 

Subchart “A” 

ER_AL_En 

(invisible) 

Alarm for fallen short of error signal,  

if ER ≥ ER_AL_Lim 

LIC_Level PV 

Subchart “A” 

Scale Scaling the measured value (e.g. 
container filling level of max. 10000) 
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Process tag Block Connection Usage 

LIC_Level PV 

Subchart “A” 

PV_InUnit Unit of the scaled measured value (e.g. 
“1038” filling level in liters) 

YC_OutletValve V 

Subchart “A” 

MV_HiLim 
MV_LoLim 

Upper and lower limit of the manipulated 
value 

YC_OutletValve MV 

Subchart “A” 

Scale Scaling the manipulated variable 
(manipulated value from the valve block) 

YC_OutletValve Subchart “A” PV_InUnit Unit of the scaled manipulated variable 

 

NOTE For commissioning the “LIC_Level” controller the “PID-Tuner” program is 
available. Chapter 6.3 “Configuration of the PID controllers” describes the 
procedure for optimizing the controller. 

 

 

The following table contains an overview of parameters to be interconnected with 
process devices. 

Table 5-8 

Process Tag Block Connection Usage 

LIC_Level PV 

Subchart “B” 

PV_In Recording the container filling level 

YC_OutletValve Rbk 

Subchart “B” 

PV_In Manipulated variable feedback 

YC_OutletValve MV 

Subchart “B” 

PV_Out or 

PV_ChnST  

Output of the manipulated variable or 
output of the manipulated variable 
including signal status of the output 
signal 

 

NOTE In the object properties of the message-capable blocks you can configure 
instance-specific messages. An instruction for the procedure is available in the 
configuration manuals “Process Control System PCS 7 Operator Station (V7.1)” 
under the following entry ID: 36194551 and “SIMATIC Process Control System 
PCS 7 Operator Station (V8.0)” under the entry ID: 57270173. 

 

 

5.1.4 Different requirements regarding the filling level control in industrial 
processes  

Depending on the task to be fulfilled by a container or tank in an industrial process 
plant, the objectives of filling level control are of different natures: 

1. The filling level shall be kept at a specified setpoint as exactly as possible, e.g. 
in a reactor or in the sump of a distillation column. This is required, if the filling 
level has an effect on chemical reactions or separation processes, i.e. it is 
significant for the process. Variations in the inflow (feed) are compensated via 
the outlet. 

2. A container (e.g. a tank) is used as a buffer, so as to keep the inflow and drain 
as constant as possible. In this case, filling level control is not based on a fixed 

http://support.automation.siemens.com/WW/view/en/36194551
http://support.automation.siemens.com/WW/view/en/57270173
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setpoint, but shall remain within the permissible limits. This type of task is 
referred to as "buffered level control". 

For the first type of task we recommend the use of a standard structure with a PID 
tuner, whereby most filling level control operations are integral action processes 
(using a manipulated value). In some cases a P-controller (without I-action) is 
sufficient, as it harmonizes better with the dynamics of the integrated process, 
although it shows persistent control deviations in case of feed disturbances. If the 
valve curve does not show a linear profile, we recommend the use of a cascade 
structure with a master controller for the filling level and a slave controller for the 
outlet (precondition: flow rate measurement at the outlet).  

 

The second type of task (buffered level control) requires a different behavior which 
applies to the majority of applications in practice. In this case, variations in the 
inflow (feed) are compensated by means of the tank volume. 

This can be realized in two different ways: Instead of continuously measuring the 
filling level and adjusting it to a defined setpoint, the minimum and maximum limits 
are monitored with the help of binary (e.g. capacitive) level switches. This solution 
is not based on a continuous control system, but uses an event-discrete control 
system, i.e. the inflow or outflow are shut-off via a binary signal from a level switch.  

The second solution is based on a controller which is purposely set to a slower 
speed. In the course of configuration, the maximum admissible deviation Δhmax of 
the filling level from the setpoint (most often 50% of the tank height) and the 
maximum erratic inflow disturbances dmax to be expected are defined. With regard 
to persistent control errors, the gain of the P controller must be set to a value larger 
than Gain=dmax/Δhmax . A PI controller can also be configured, so that the maximum 
filling level adjustment in case of erratic disturbances is smaller than dmax. The 
Dachema seminar on "Process control systems – from the basics to advanced 
control applications" (see /2/ in section 8.1 “Further literature”) recommends to use 
the following formulas: 

GainEff=0.7358dmax/Δhmax 

Ti= 5.4366/Ki *Δhmax/ dmax 

 

Note The physical controller gain corresponds to [MV_Unit/PV_Unit]. In the case of 
normalization (NormPV ≠ NormMV), the gain must be recalculated according to 
the following formula: 

Gain = GainEff * (NormPV.High - NormPV.Low)/(NormMV.High - NormMV.Low) 

 

 

The integration constant Ki of the control loop in the unit [PV_Unit/s] can be 
determined with the PID tuner. The integration constant is available under "Gain" in 
the "Process parameter" area. 
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Figure 5-5: PID tuner for integral process 
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5.2 Ratio-Control 

With ratio control, feedstock components or various gases are fed into a container 
in a fixed mixing ratio via inlet pipes.  

Ratio control consists of a controller for the main component (master controller) 
and one each controller for each further additional component (slave controller).  

The example below describes the control for an inflow consisting of two 
components. 

5.2.1 Overview 

The structure is displayed in a P&I diagram below and all process tags and the 
simulation of the equipment module are described. 

P&I diagram 

The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols. 

Figure 5-6 

Outlet

YC

MainComp

FIC

MainComp

YC

Comp_1

FFIC

Comp_1

1st inlet

2nd inlet

SP

MV
Legende

MV = Manipulated variable

SP = Active setPoint

 

Process tags 

The equipment module “Ratio-Control” consists of 6 interconnected process tags 
and one simulation chart. The inflow total (of the components) is formed and 
displayed in the simulation chart.  

The following table provides an overview of the process tags of the equipment 
module including the respective process tag types. 
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Table 5-9 

Process tag Process tag type Description 

FIC_MainComp “CTRL_RatioMain” Flow control of the main component 

FFIC_Comp_1 “CTRL_RatioComp” Flow control of the main additional component 

FI_MainComp “AMON_Flow” Flow rate display of the main component 

FI_Comp_1 “AMON_Flow” Flow rate display of the additional component 

YC_MainComp “Val_An_Afb” Control valve for the main component 

YC_Comp_1 “Val_An_Afb1” Control valve for the additional component 

 

In the following figure the entire structure, including all interconnections across all 
CFC charts, are represented in a simplified format. 

Figure 5-7 
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Controller process tag “FIC_MainComp” detects the flow rate of the main 
component and controls it using the “YC_MainComp” control valve. The 
“FI_MainComp” process tag indicates the process value (flow rate) and the status 
values of the “FIC_MainComp” process tag. 

Additionally, “FIC_MainComp” transfers the own setpoint value to process tag 
“FFIC_Comp_1”. “FIC_MainComp” is subsequently the master controller for 
“FFIC_Comp_1”. 

Controller process tag “FFIC_Comp_1” detects the flow rate of the additional 
component and controls it using the “YC_Comp_1” control valve. The “FI_Comp_1” 
process tag uses the process value (flow rate) and the status values of the 
“FIC_Comp_1” process tag. 

The setpoint value contains “FFIC_Comp_1” from the “FIC_MainComp” process 
tag, so “FFIC_Comp_1” is the slave controller. 

Master controller “FIC_MainComp” receives information about hardware state and 
operating state (“Out of service”) from the respective process tag “YC_MainComp” 
and slave controller “FFIC_Comp_1”. Furthermore, the slave controller transfers 
additional information, whether the cascade was separated or whether the slave 
controller follows the master controller as intended. As soon as a hardware error or 
the operating state “Out of service” occurs, or the cascade was separated for other 
reasons, the “Interlock“ is triggered and master and slave controller go to tracking 
mode. 

5.2.2 Structure and configuration 

Simulation „Sim_CompFlow“ 

In CFC chart “Sim_CompFlow” the flow rate of the main component and the 
additional components are simulated and the entire flow volume is calculated. 
Additionally, the flow volume is indicated on the basis of process tag type 
“AMON_Flow”. 

The graphic representation below shows the sequence of the simulation. 

Figure 5-8 

1 2 5

3 4

 

1. Calculating the flow rate for the main component (100 % opened valve 
corresponds to an inflow of 2000 l/h) 

2. Delaying the flow rate change (PT1 behavior with 5 seconds delay) 

3. Calculating the flow rate for the additional component (100 % opened valve 
corresponds to an inflow of 500 l/h) 
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4. Delaying the flow rate change (PT1 behavior with 2 seconds delay) 

5. Determining the entire flow volume (addition) 

Inputs “In1” of the selected blocks 1 and 3 receive their manipulated values from 
the “I” valve blocks of the “YC_MainComp” and “YC_Comp_1” process tags. 
Outputs “Out” of the selected blocks 2 and 4 are interconnected with the process 
tag for process value display and the controller process tags of the respective 
component. 

FIC_MainComp 

Process tag “FIC_MainComp” records the flow rate of the main component and 
transfers it to the “FI_MainComp” process tag for measured value display. In order 
to control the flow rate, control signals are transferred to the “YC_MainComp” 
process tag via a communication block. 

The setpoint value is transferred to the controller process tag(s) of the additional 
component(s). Due to using the setpoint value instead of the manipulated value, 
the controller structure does not correspond to a typical cascade control. 

 

NOTE In communication block “to_Slave” the process value and the manipulated value 
are transferred in addition to the setpoint value. The control result depends on 
the reaction times of the main component and the additional component. In the 
application example the reaction times of main component and additional 
component are very similar, therefore, the setpoint value is used. 

 

The following table shows the configuration of the instance from 
“CTRL_RatioMain”. 

Table 5-10 

Block Connection Value Usage 

C Gain.Value 5.0e-2 Controller gain 

(proportional gain) 

C TI.Value 4.1 Controller gain 

(integral time) 

C SP_InHiLim 2000.0 Maximal value of the internal setpoint 

to_Valve Out  Interconnection to the valve (controlling) 

(YC_MainComp\from_CTRL.In) 

from_Valve In  Interconnecting to the valve (status) 

(YC_MainComp\to_CTRL.Out) 

to_Slave Out  Interconnection to the slaves (controlling) 

(FFIC_Comp_1\from_Master.In) 

from_Slave_1 In  Interconnection to the slaves (controlling) 

(FFIC_Comp_1\from_Master.In) 

Sim Sim1ValueOp  Interconnecting to the simulated process value 

(Sim_CompFlow\Lag_MainComp.Out) 

PV PV_OutUnit  Interconnecting the unit from the process value 
to the process tag for the process value display  

(FI_MainComp\PV.PV_InUnit) 

PV ScaleOut  Interconnecting the scaling from the process 
value to the process tag for the process value 
display  

(FI_MainComp\PV.Scale) 
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Block Connection Value Usage 

PV OosAct  Interconnecting the “Out of service” signal from 
the process tag for the process value display  

(LI_MainComp\I.OosLi) 

PV Bad  Interconnecting the hardware error from the 
channel block to the display block 

(FI_MainComp\I.CSF) 

Sqrt Out  Interconnecting the process value to the display 
block  

(FI_MainComp\I.PV) 

 

FFIC_Comp_1 

Process tag “FIC_Comp_1” records the flow rate of the additional component and 
transfers it to the “FI_Comp_1” process tag for measured value display. In order to 
control the flow rate, control signals are transferred to the “YC_Comp_1” process 
tag via a communication block. 

In automatic mode, the “FFIC_Comp_1” process tag uses the setpoint value from 
master controller “FIC_MainComp”, which is converted, i.e. multiplied with a 
defined ratio factor, to a setpoint value for the added component using a ratio 
block. 

The following table shows the configuration of the instance from 
“CTRL_RatioComp”. 

Table 5-11 

Block Connection Value Usage 

C Gain.Value 0.25 Controller gain 

C TI.Value 2.2 Controller delay 

C SP_InHiLim 500.0 Maximal value of the internal setpoint 

to_Valve Out  Interconnection to the valve (controlling) 

(YC_Comp_1\from_CTRL.In) 

from_Valve In  Interconnecting to the valve (status) 

(YC_Comp_1\to_CTRL.Out) 

to_Master Out  Interconnection to the master 

(FIC_MainComp\from_Slave_1.In) 

from_Master In  Interconnection to the master (controlling) 

(FIC_MainComp\to_Slave_1.Out) 

Sim Sim1ValueOp  Interconnecting to the simulated process value 

(Sim_CompFlow\Lag_Comp_1.Out) 

PV PV_OutUnit  Interconnecting the unit from the process 
value to the process tag for the process value 
display  

(FI_Comp_1\PV.PV_InUnit) 

PV ScaleOut  Interconnecting the scaling from the process 
value to the process tag for the process value 
display  

(FI_Comp_1\PV.Scale) 

PV OosAct  Interconnecting the “Out of service” signal 
from the process tag for the process value 
display  

(LI_Comp_1\I.OosLi) 
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Block Connection Value Usage 

PV Bad  Interconnecting the hardware error from the 
channel block to the display block 

(FI_Comp_1\I.CSF) 

Sqrt Out  Interconnecting the process value to the 
display block  

(FI_ Comp_1\I.PV) 

FI_MainComp 

In the “LI_MainComp” process tag the measured value of the channel block of the 
“LIC_MainComp” process tag is displayed. Limit values (alarm, warning) are not 
set in the operator control and monitoring block (MonAnL), since these are defined 
specifically for each process. 

The following table shows the configuration of the instance from “AMON__Flow”. 

Table 5-12 

Block Connection Value Usage 

I PV  New interconnection to the process value of the controller 
process tag 

(FIC_MainComp\Sqrt.Out) 

I OosLi  New interconnection to the “Out of service” signal of the 
channel block of the controller process tag 

(FIC_MainComp \PV.OosAct) 

I CSF  New interconnection to the “Bad” signal of the channel 
block of the controller process tag 

(FIC_MainComp\PV.Bad) 

PV Scale  Interconnection to the scaling of the process value 

(FIC_MainComp\PV.ScaleOut) 

PV PV_InUnit  Interconnection to the unit of the process value 

(FIC_MainComp\PV.PV_OutUnit) 

 

FI_Comp_1 

In the “LI_Comp_1” process tag the measured value of the channel block of the 
“LIC_Comp_1” process tag is displayed. Limit values (alarm, warning) are not set 
in the operator control and monitoring block (MonAnL), since these are defined 
specifically for each process. 

The following table shows the configuration of the instance from “AMON__Flow”. 

Table 5-13 

Block Connection Value Usage 

I PV  New interconnection to the process value of the 
controller process tag 

(FFIC_Comp_1\Sqrt.Out) 

I OosLi  New interconnection to the “Out of service” signal of the 
channel block of the controller process tag 

(FFIC_Comp_1\PV.OosAct) 

I CSF  New interconnection to the “Bad” signal of the channel 
block of the controller process tag 

(FFIC_Comp_1\PV.Bad) 

PV Scale  Interconnection to the scaling of the process value 
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Block Connection Value Usage 

(FFIC_Comp_1\PV.ScaleOut) 

PV PV_InUnit  Interconnection to the unit of the process value 

(FFIC_Comp_1\PV.PV_OutUnit) 

 

YC_MainComp 

Valve process tag “YC_MainComp” controls the flow rate of the main component. 
The process tag contains communication blocks for data exchange (control signals 
and control commands) with the controller process tag. 

Valve block “V” receives an external manipulated value (via a communication 
block) from the controller process tag. Both channel blocks in subchart “B” (Rbk 
and MV) receive the same value as the process value (manipulated value of the 
valve block (subchart “A”, sheet 1)) via the preceding simulation block. 

The following table shows the configuration of the instance from “Val_An_Afb1”. 

Table 5-14 

Block Connection Value Usage 

V MV  Interconnecting to the simulation 
(Sim_CompFlow\Scale_MainComp.In1) 

from_CTRL In  Interconnection to the controller 
(controlling) 

(FIC_MainComp\to_Valve.Out) 

to_CTRL Int1  Interconnection deleted 

(YC_MainComp\Rbk.PV_OutUnit) 

to_CTRL Scale1  Interconnection deleted 

(YC_MainComp\Rbk.ScaleOut) 

to_CTRL Out  Interconnection to the controller 
(status) 

(FIC_MainComp\from_Valve.In) 

Sim Sim1ActOp.Value 1 Activating the simulation of the 
readback value 

Sim Sim1ValueOp  Interconnecting with the simulation of 
the readback value from the valve 

(YC_MainComp\V.MV) 

Sim Sim2ActOp.Value 1 Activating the simulation of the 
manipulated value 

Sim Sim2ValueOp  Interconnecting with the simulation of 
the manipulated value from the valve 

(YC_MainValve\V.MV) 

MV PV_OutUnit  Interconnecting the unit of the 
manipulated value of the valve 
(YC_MainComp\to_CTRL.Int1) 
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YC_Comp_1 

Valve process tag “YC_Comp_1” controls the flow rate of the additional 
component. The process tag contains communication blocks for data exchange 
(control signals and control commands) with the controller process tag. 

Valve block “V” receives an external manipulated value (via a communication 
block) from the controller process tag. Both channel blocks in subchart “B” (Rbk 
and MV) receive the same value (manipulated value of the valve block (subchart 
“A”, sheet 1)) via the preceding simulation block. 

The following table shows the configuration of the instance from “Val_An_Afb1”. 

Table 5-15 

Block Connection Value Usage 

V MV  Interconnecting to the simulation 
(Sim_CompFlow\Scale_Comp_1.In1) 

from_CTRL In  Interconnection to the controller 
(controlling) 

to_CTRL Int1  Interconnection deleted 

(YC_Comp_1\Rbk.PV_OutUnit) 

to_CTRL Scale1  Interconnection deleted 

(YC_Comp_1\Rbk.ScaleOut) 

to_CTRL Out  Interconnection to the controller (status) 

(FFIC_Comp_1\from_Valve.In) 

Sim Sim1ActOp.Value 1 Activating the simulation of the readback 
value 

Sim Sim1ValueOp  Interconnecting with the simulation of the 
readback value from the valve 

(YC_Comp_1\V.MV) 

Sim Sim2ActOp.Value 1 Activating the simulation of the 
manipulated value 

Sim Sim2ValueOp  Interconnecting with the simulation of the 
manipulated value from the valve 

(YC_Comp_1\V.MV) 

MV PV_OutUnit  Interconnecting the unit of the 
manipulated value of the valve 
(YC_Comp_1\to_CTRL.Int1) 
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5.2.3 Commissioning, operation and instance-specific adjustments  

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 

Commissioning  

After starting the CPU (in the initial state) both controllers and the valve for the 
main component are in manual mode. The valve for the additional component is in 
automatic mode.  

Due to the manual controller mode for additional component “FFIC_Comp_1” the 
controller for main component “FIC_MainComp” is locked (Interlock function). 
Therefore, the automatic mode of the main controller and the external setpoint 
value cannot be activated. 

For commissioning, please follow the instructions below: 

 

Table 5-16 

No. Action 

1.  Click on the block icon for ratio block “FFIC_Comp_1/Ratio” to set the ratio 
between additional and main component. 

 

2.  Click on the “Ratio” input field and enter the ratio 0.25 in the faceplate extension. 
Acknowledge the input with the “ENTER” key and click on the “OK” button. 

3.  Click on the block icon of the “FFIC_Comp_1/C” controller. The respective 
faceplate is opened. 
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No. Action 

4.  Change the operating mode of the controller. In the faceplate you click on the 
“…” button next to the “Mode” switch, and in the faceplate extension you click on 
the “Automatic” button and adopt the settings with “OK”. The setpoint is 
automatically specified from external. 

Note: 

Fur further additional components repeat steps 1 4 for each component. 

5.  Click on the block icon of the controller for main component “FIC_MainComp”. 
The respective faceplate is opened. 

 

6.  Change the operating mode of the controller. In the faceplate you click on the 
“…” button next to the mode switch (“Mode”) and in the faceplate extension you 
click on the “Automatic” button and adopt the settings with “OK”. 

7.  For changing the setpoint value you click on the “Setpoint” input field and enter a 
setpoint value of 1000 l/h in the faceplate expansion. Acknowledge the input with 
the “ENTER” key and click on the “OK” button. 

Note: 

Instead of the internal setpoint you can also set using an external setpoint value 
in this step. 

 

NOTE At the “Ratio” block the most current actual value of the ratio is displayed, which 
is used for controlling the slave controllers. 
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Operation 

The following instruction describes the operation of the equipment module “Ratio 
Control”. After the startup and the adjustment of values, the flow rate of the main 
component is 1000 l/h and the additional component 250 l/h (the ratio between 
additional and main component is 0.25). 

In the scenario below, the flow rate of the main component is increased from 1000 
l/h to 1500 l/h. 

 

Table 5-17 

No. Action 

1.  Click on the block icon of the “FIC_MainComp” controller and click into the 
“Setpoint” input field. 

2.  In the faceplate expansion you enter the new setpoint of 1500 l/h. Then 
acknowledge the input with the “Enter” key and click on the “OK” button. 

3.  Wait approximately 50 seconds and then click on the “Start/Stop” symbol of the 
OnlineTrendControl 

4.  In the toolbar of the OnlineTrendControl you click on the “ruler” icon and reduce 
the ruler to the smallest value with the largest deviation, as displayed in the 
evaluation below. 

 

Evaluation 

The “OnlineTrendControl” embedded in the process image is set to maximum 
value range. After a ratio change the value range of the additional component 
automatically adjusts. 

Figure 5-9 

 

Due to the different reaction times of the controller, the ratio is temporarily 29% 
(0.29). In comparison to the set ratio value of 25% (0.25) a short-term deviation of 
4% occurs before the correct ratio is reached in the steady-state. 
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The controller design for slave controller “FFIC_Comp_1” can in this case not be 
improved by means of PID controller optimization, since the objective of the 
controller design is optimal tracking of the additional component. 

 

NOTE The online help offers further information and configuration notes on process tag 
type “RatioControl”. The process tag type is available in the “PCS 7 Advanced 
Process Library”. 

 

 

The reaction time from OnlineTrendControl leads to the following considerations for 
the controller design, in order to adjust the transient response of master and slave 
control loop as much as possible: 

 The relatively large deviation at the start of the control indicates an exceedingly 
high gain of the slave controller, i.e. the actual value of the slave controller 
increases faster than the actual value of the master controller. 

 The relatively slow reaching of the final value of the setpoint step-change 
indicates an exceedingly large integral time of the master controller, i.e. the 
master controller settles slower than the slave controller. 

A change in controller gain of slave controller “FFIC_Comp_1” from 0.25 to 0.1 
and, at the same time, a change in the integral time of master controller 
“FIC_MainComp” from 4.1 to 2 yields the following result for the same setpoint 
step-change. 

Figure 5-10 

 

Due to the different reaction times of the controller, the ratio is 26.7% (0.29) after 
optimization. In comparison to the set ratio value of 25% (0.25) a short-term 
deviation of 1.7% occurs. 



5 Equipment Modules 5 Equipment Modules 

5.2 Ratio-Control 5.2 Ratio-Control 
 

Equipment Modules 
Entry-ID: 53843373,    V2.2,    04/2014   68 
 

C
o
p

y
ri

g
h

t 


 S
ie

m
e

n
s
 A

G
 2

0
1

4
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Process adjustment 

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices.  

The following table contains the parameters to be set specifically for each process. 

Table 5-18 

Process tag Block Connection Usage 

FI_MainComp / 

FI_Comp_1 

I 

Subchart 
“A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

FI_MainComp / 

FI_Comp_1 

I 

Subchart 
“A” 

PV_WH_En  Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

FI_MainComp / 

FI_Comp_1 

I 

Subchart 
“A” 

PV_WL_En  Warning for falling below the limit 

value, if PV ≥ PV_WL_Lim 

FI_MainComp / 

FI_Comp_1 

I 

Subchart 
“A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

Gain Proportional gain 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

TD Derivative time (rate time) in [s] 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

TI Integral time (reset time) in [s] 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

SP_InHiLim Limit value (high) of the internal 

setpoint value 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

SP_InLoLim Limit value (low) of the internal 

setpoint value 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

PV_WH_En  Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

PV_TH_En Warning for falling below the limit 

value, if PV ≥ PV_TH_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

PV_TL_En Tolerance for falling below the limit 

value, if PV ≤ PV_TL_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

PV_WL_En  Warning for falling below the limit 

value, if PV ≥ PV_WL_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 

PV_AL_En Alarm for falling below the limit value,  
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Process tag Block Connection Usage 

“A” if PV ≥ PV_AL_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

ER_AH_En 

(invisible) 

Alarm for exceeded error signal,  

if ER ≥ ER_AH_Lim 

FIC_MainComp / 
FFIC_Comp_1 

C 

Subchart 
“A” 

ER_AL_En 

(invisible) 

Alarm for fallen short of error signal,  

if ER ≥ ER_AL_Lim 

FIC_MainComp / 
FFIC_Comp_1 

PV 

Subchart 
“B” 

Scale Scaling the measured value (e.g. 
flow range of max. 500) 

FIC_MainComp / 
FFIC_Comp_1 

PV 

Subchart 
“B” 

PV_InUnit Unit of the scaled measured value 
(e.g. “1353” flow rate in L/h) 

FFIC_Comp_1 Ratio 

Subchart 
“A” 

OutHiLim Upper limit value for the output value 

FFIC_Comp_1 Ratio 

Subchart 
“A” 

OutLoLim Lower limit value for the output value 

FFIC_Comp_1 Ratio 

Subchart 
“A” 

RatHiLim Upper ratio limit 

FFIC_Comp_1 Ratio 

Subchart 
“A” 

RatLoLim Lower ratio limit  

YC_MainComp / 

YC_Comp_1 

V 

Subchart 
“A” 

MV_HiLim Upper and lower limit of the 
manipulated value 

YC_MainComp / 

YC_Comp_1 

MV 

Subchart 
“B” 

MV_LoLim Scaling the manipulated variable 
(manipulated value from the valve 
block) 

YC_MainComp / 

YC_Comp_1 

MV 

Subchart 
“B” 

Scale Unit of the scaled manipulated 
variable 

 

NOTE For commissioning the “LIC_Level” controller the “PID-Tuner” program is 
available. Chapter 6.3 “Configuration of the PID controllers” describes the 
procedure for optimizing the controller. If during optimization a considerably 
different transient response should occur, you may try to adjust and adapt the 
parameters of both control loops manually. The stability of the transient response 
of both control module loops has the highest priority. A short term deviation of 
the ratio for setpoint step-changes may result. 
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The following table contains an overview of parameters to be interconnected with 
process devices. 

Table 5-19 

Process tag Block Connection Usage 

FIC_MainComp PV 

Subchart 
“B” 

PV_In Flow rate of the main component 

FFIC_Comp_1 PV 

Subchart 
“B” 

PV_In Flow rate of the additional component 

YC_MainComp Rbk 

Subchart 
“B” 

PV_In Manipulated variable feedback 

YC_MainComp MV 

Subchart 
“B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or output 
of the manipulated variable including signal 
status of the output signal 

YC_Comp_1 Rbk 

Subchart 
“B” 

PV_In Manipulated variable feedback 

YC_Comp_1 MV 

Subchart 
“B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or output 
of the manipulated variable including signal 
status of the output signal 

 

NOTE In the object properties of the message-capable blocks you can configure 
instance-specific messages. An instruction for the procedure is available in the 
configuration manuals “Process Control System PCS 7 Operator Station (V7.1)” 
under the following entry ID: 36194551 and “SIMATIC Process Control System 
PCS 7 Operator Station (V8.0)” under the entry ID: 57270173. 

 

 

http://support.automation.siemens.com/WW/view/en/36194551
http://support.automation.siemens.com/WW/view/en/57270173
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5.2.4 Expanding by a further component 

General information 

The “Ratio-Control” equipment module is designed for usage of one main 
component and 2 additional components. The number of additional components is 
limited by the interlock block or its number of interlock inputs respectively. 

 

NOTE You can expand the “Ratio-Control” equipment module by more than 2 additional 
substances using the following options. 

1. Combine the signals of the communication blocks (from_Slave) with OR blocks. This 
interconnects 1 valve and 7 additional components with an interlock block. 
Disadvantage:  
inaccurate error display, i.e. no differentiation between errors in cascade control, “Out 
of service” signal of the controller block, and “Bad” status of the controller channel 
blocks. 

2. Duplicate the existing interlock block and combine both outputs of the interlock blocks 
(“Out”) with an OR block. For interconnecting (“Out” output) the OR blockyou use the 
interconnection (“Out” output) of the existing interlock block. You can call up the 
faceplate of the first interlock block from the faceplate of the controller. The faceplate 
of the second interlock block is opened via its block symbol in the process image. 

3. Replace the existing interlock block containing 8 input signals (“Intlk08”) by an 
interlock block containing 16 input signals (“Intlk16”). Adopt all interconnections of the 
previous interlock block. 

 

Prerequisites 

If various additional components are measured in different units, the conversion 
factor in the ratio block also handles the unit conversion. 

 

NOTE For different units the further unit of measure must be configured at the 
additional component and the setpoint value converted, e.g. with a multiplier 
block.  

Additionally, clear labeling is recommended for a joint display of the trend curve. 

 

 

If different manipulated ranges are required for sub-control loops of a ratio control, 
the respective interconnections must be deleted and configured for the respective 
sub-control loop. 

 

NOTE Instructions on configuration and parameter settings are available in the function 
manuals “SIMATIC Process Control System PCS 7, PCS 7 Advanced Process 
Library V7.1 SP5” at entry ID: 48034370 and “SIMATIC Process Control System 
PCS 7 PCS 7 Advanced Process Library V8.0” at entry ID: 57265842. 

 

 

  

http://support.automation.siemens.com/WW/view/en/48034370
http://support.automation.siemens.com/WW/view/en/57265842
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Description 

To expand the equipment module by one further additional component, please 
proceed according to the following instruction: 

1. Copy process tags “FI_Comp_1”, “FFIC_Comp_1” and “YC_Comp_1” all at the 
same time. Paste the copied process tags back into the same hierarchy folder. 
Rename the process tags accordingly (the process tags are referred to as 
“FI_Comp_2”, “FFIC_Comp_2” and “YC_Comp_2” below). 

 

NOTE When copying the process tags at the same time (select process tag and then 
clock on “Edit > Copy” in the menu bar) the connections between the selected 
process tags remain. 

 

 

2. Open the “FIC_MainProduct” process tag and duplicate the “from_Slave_1“ 
block in subchart “A” sheet 6. 

 

NOTE The “to_Slave” block is not duplicated, since all slave controllers receive the 
same data from the master controller. 

 

 

3. Open process tag “FFIC_Comp_2” and perform the following interconnections: 

 

Table 5-20 

Block Connection Usage 

to_Master Out Interconnection to the master 

(FIC_MainComp\from_Slave_2.In) 

from_Master In Interconnection to the master (controlling) 

(FIC_MainComp\to_Slave_1.Out) 

 

4. Open process tag “FFIC_MainComp” and perform the following 
interconnections: 

 

Table 5-21 

Block Connection Usage 

from_Slave_2 BoStruct1 Interconnection to the interlock block 

(Interlock.In06) 

from_Slave_2 BoStruct2 Interconnection to the interlock block 

(Interlock.In07) 

from_Slave_2 BoStruct3 Interconnection to the interlock block 

(Interlock.In08) 
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5. The simulation model is designed for two additional components. Please 
perform the following interconnections in order to connect the second 
additional component with the simulation. Open process tag “FFIC_Comp_2” 
and perform the following interconnections in subchart “B” sheet 1: 
 

Table 5-22 

Block  Connection Usage 

Sim Sim1ValueOp Interconnecting to the simulation chart 

(Sim_CompFlow/Lag_Comp_2.Out) 

 

6. Open process tag “YC_Comp_2” and perform the following interconnections in 
subchart “A” sheet 1: 

 

Table 5-23 

Block Connection Usage 

V MV Interconnecting to the simulation chart 

(Sim_CompFlow/Scale_Comp_2.In1) 

 

NOTE Expanding the “Ratio-Control” equipment module by further additional 
components requires compilation and download of blocks and charts, as well as 
OS compilation. 
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5.3 “Split-Range-Pressure” control 

Pressure control is typically a fast control. The container pressure is increased by 
feeding inert gas (e.g. nitrogen) via an inlet pipe. When opening the outlet valve, 
the gas mixture is released and the container pressure reduced. The controller 
reacts to a pressure change and controls it either by opening the inlet or the outlet 
valve.  

The example below solves the container pressure control by adding pressure and 
venting. 

5.3.1 Overview 

The structure is displayed in a P&I diagram below and all process tags and the 
simulation of the equipment module are described. 

P&I diagram 

The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols. 

Figure 5-11 

YC

Out

YC
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Process tags 

The equipment module “Split-Range-Pressure” consists of 4 interconnected 
process tags and one simulation chart. In the simulation chart a container pressure 
and the impact of feeding inert gas as well as venting are simulated.  

The following table provides an overview of the process tags of the equipment 
module including the respective process tag types. 

Table 5-24 

Process 
tag 

Process tag type Description 

PIC_Split “CTRL_Splitrange” Controller for split-range control with a manipulated 
variable and two actuators 

PI_Tank “AMON__Std“ Measured value display of the container pressure 

YC_In “Val_An_Afb1” Manipulated variable for feeding inert gasses 

YC_Out “Val_An_Afb1” Control valve for venting  

 

In the following figure the entire structure, including all interconnections across all 
CFC charts, are represented in a simplified format. 

Figure 5-12 
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The “PIC_Split” process tag uses the simulated container pressure from simulation 
chart “Sim_PresLevel” and generates the setpoint specification for the split-range 
controller. The PID controller transfers the control commands via communication 
blocks “to_Val_An1” and “to_Val_An2” to the “YC_In” and “YC_Out” control valves. 
Additionally, the controller process tag receives status information from the channel 
drivers of the valve process tag via the “from_Val_An1” and “from_Val_An2” 
communication blocks. 

5.3.2 Structure and configuration 

Simulation “Sim_PresLevel” 

 In CFC chart “Sim_PresLevel” the pressure change in the container is simulated 
by inerting or venting. 

The graphic representation below shows the sequence of the simulation. 

Figure 5-13 

1 2 3
4

 

1. Calculating the pressure change based on the proportionality factor (100% 
valve opening corresponds to 0.1 bar pressure change) 

2. Reducing the pressure by 0.01 bar, e.g. through pressure loss in the container 

3. Delaying the pressure change 

4. Forming an integral value through integrating the pressure change (each 
second) 

PIC_Split 

In the “PIC_Split” process tag the container pressure is recorded and transferred to 
the “PI_Tank” process tag for measured value display. The setpoint is specified in 
this process tag (“PIC_Split”). In order to control the container pressure, control 
signals are transferred to the “YC_In”  and “YC_Out” control valves via 
communication blocks. 

The following table shows the configuration of the instance from 
“CTRL_Splitrange”. 

Table 5-25 

Block Connection Value Usage 

C NegGain.Value 1 Reversing the response behavior for the 
valve (valve 1 opens for negative instead 
of positive error signal) 

C Gain.Value 8.0 Controller gain 

C TI.Value 75.0 Controller delay 

C SP_InHiLim 10.0 Maximal value of the internal setpoint 

C ManLoLim -100.0 Limit value (low) of the manual value 

C CPI_In  Interconnection for opening the 
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Block Connection Value Usage 

ConPerMon faceplate from the controller 
faceplate 

(PIC_Split\CPM.CPI) 

C RefStdDevIn  Interconnection for opening the 
ConPerMon faceplate from the controller 
faceplate (PIC_Split\CPM.RefStdDev) 

CPM RefVariance 0.0  

Connector SP_IntLi.Value 1 Using the internal setpoint value as start 
value 

Connector SP_Ext.Value 5.0 External setpoint 

Connector ModLiOp.Value 1 Activating the selection the operating 
mode via the block 

Connector AutModLi.Value 1 Activating the automatic mode 

MV_Trk In1.Value 0.0 Forced manipulated value for the controller 

Intlock InvIn02 1 Inverting the hardware error signal of 
channel block “PV” 

Intlock Inv02  Interconnection to channel block “PV” 

(PIC_Split\PV.Bad) 

Intlock InvIn03 1 Inverting the “Out of service” signal of 
channel block “PV” 

Intlock Inv03  Interconnection to channel block “PV” 

(PIC_Split\PV.OosAct) 

from_Val_An1 In  Status of the valve for added pressure 

(YC_In\to_CTRL.Out) 

from_Val_An2 In  Status of the valve for venting 

(YC_Out\to_CTRL.Out) 

to_Val_An1 Out  Control commands of the valve for added 
pressure 

(YC_In\from_CTRL.In) 

to_Val_An2 Out  Control commands of the valve for venting 

(YC_Out\from_CTRL.In) 

Sim Sim1ActOp.Value  Activating the simulation of the controlled 
variable 

Sim Sim1ValueOp  Interconnection to the simulated process 
value 

(Sim_PresLevel\PresLevel.Out) 

PV Bad  Interconnecting the hardware error from 
the channel block to the process tag for 
the process value display  

(PI_Tank\I.CSF) 

PV PV_OutUnit  Interconnecting the unit from the process 
value to the process tag for the process 
value display  

(PI_Tank\PV.PV_InUnit) 

PV ScaleOut  Interconnecting the scaling from the 
process value to the process tag for the 
process value display  

(PI_Tank\PV.Scale) 

PV OosAct  Interconnecting the “Out of service” signal 
from the process tag for the process value 
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Block Connection Value Usage 

display  

(PI_Tank\I.OosLi) 

Sqrt Out  Interconnecting the process value to the 
display block  

(PI_Tank\I.PV) 

 

PI_Tank 

In the “PI_Tank” process tag the measured value of the channel block of the 
“PIC_Split” process tag is displayed. Limit values (alarm, warning) are not set in the 
operator control and monitoring block (MonAnL), since these are defined 
specifically for each process.  

The following table shows the configuration of the instance from “AMON__Std”. 

 

Table 5-26 

Block Connection Value Usage 

I PV  New interconnection to the process value 
of the controller process tag 

(PIC_Split\Sqrt.Out) 

I OosLi  New interconnection to the “Out of service” 
signal of the channel block of the controller 
process tag 

(PIC_Split\PV.OosAct) 

I CSF  New interconnection to the “Bad” signal of 
the channel block of the controller process 
tag 

(PIC_Split\PV.Bad) 

PV Scale  Interconnecting the scaling of the 
manipulated value  

(PIC_Split\PV.ScaleOut) 

PV PV_InUnit  Interconnecting the unit of the process 
value  

(PIC_Split\PV.PV_OutUnit) 
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YC_In and YC_Out 

The valve process tags have been designed specifically for the application in a 
split-range control. Each valve process tag contains communication blocks for data 
exchange (control signals and control commands) with the controller process tag.  

The “V” valve blocks receive one manipulated value each (via communication 
blocks) from the controller process tag. Both channel blocks in subchart “B” (Rbk 
and MV) receive the same value (manipulated value of the valve block (subchart 
“A”, sheet 1)) via the preceding simulation block. 

The following table shows the configuration of the instance from “Val_An_Afb1”. 

 

Table 5-27 

Block Connection Value Usage 

V 

(YC_In) 

(YC_Out) 

MV  Interconnection for the 
simulation 

(Sim_SplitLevel\In.In1) 

(Sim_SplitLevel\Out.In1) 

V NoFbkOpen 1 Feedback “Valve open” 
deactivated 

V NoFbkClose 1 Feedback “Valve closed” 
deactivated 

from_CTRL 

(YC_In) 

(YC_Out) 

In  Interconnection to the 
controller 

(PIC_Split\to_Val_An1.Out) 
(PIC_Split\to_Val_An2.Out) 

to_CTRL 

(YC_In) 

(YC_Out) 

Out  Interconnection to the 
controller 

(PIC_Split\from_Val_An1.In) 
(PIC_Split\from_Val_An2.In) 

Sim Sim1ActOp.Value 1 Activating the simulation of 
the readback value 

Sim Sim2ActOp.Value 1 Activating the simulation of 
the manipulated value 

Sim Sim1ValueOp  Simulation of the readback 
value from the valve 

Sim Sim2ValueOp  (Interconnected with V.MV) 
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5.3.3 Commissioning, operation and instance-specific adjustments 

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 

Commissioning 

For commissioning, please follow the instructions below: 

Table 5-28 

No. Action 

1.  Click on the block icon of the “PIC_Split” controller. The respective faceplate is 
opened. 

 

2.  Click on the “Setpoint” input field and enter value “1” into the input field of the 
faceplate expansion. Then acknowledge the input with the “Enter” key and click 
on the “OK” button. 

Note: 

Instead of the internal setpoint you can also set using an external setpoint value 
in this step. 
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Operation 

The following instruction describes the operation of the equipment module “Split-
Range-Pressure”. After startup the setpoint value is 1 bar. To balance the pressure 
loss of the container, the valve for venting must be 10 % open. 

In the following scenario the setpoint value is increased from 1°bar to 3°bar. 

Table 5-29 

No. Action 

1.  Click on the block icon of the “PIC_Split” controller. The respective faceplate is 
opened. 

2.  Click on the “Setpoint” input field and enter value “3” into the input field of the 
faceplate expansion. Then acknowledge the input with the “Enter” key and click 
on the “OK” button. 

2

1

 

3.  Then close the faceplate and observe the curve plotter for approx. 2 minutes, 
until the setpoint has been reached. 
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Evaluation 

Figure 5-14 

1 2

3

 

1. After the setpoint jump the manipulated value is set to 100 which opens the 
pressure feed valve 

2. After the process value exceeds the setpoint, the pressure feed valve is closed 
and the venting valve is opened 

3. After reaching the setpoint, the pressure feed valve is approx. 10% open, 
which compensates the pressure loss of the container 

Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices.  

The following table contains the parameters to be set specifically for each process. 

Table 5-30 

Process 
tag 

Block  Connection Usage 

PI_Tank I 

Subchart “A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

PI_Tank I 

Subchart “A” 

PV_WH_En Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

PI_Tank I 

Subchart “A” 

PV_WL_En Warning for falling below the limit value, if 

PV ≥ PV_WL_Lim 

PI_Tank I 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

PIC_Split C 

Subchart “A” 

Gain Proportional gain 

PIC_Split C 

Subchart “A” 

TD Derivative time (rate time) in [s] 

PIC_Split  C 

Subchart “A” 

TI Integral time (reset time) in [s] 

PIC_Split C 

Subchart “A” 

SP_InHiLim Limit value (high) of the internal 

setpoint value 

PIC_Split C SP_InLoLim Limit value (low) of the internal 
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Process 
tag 

Block  Connection Usage 

Subchart “A” setpoint value 

PIC_Split  C 

Subchart “A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

PIC_Split C 

Subchart “A” 

PV_WH_En  Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

PIC_Split C 

Subchart “A” 

PV_TH_En 

(invisible) 

Warning for falling below the limit value, if 

PV ≥ PV_TH_Lim 

PIC_Split C 

Subchart “A” 

PV_TL_En 

(invisible) 

Tolerance for falling below the limit value, 

if PV ≤ PV_TL_Lim 

PIC_Split C 

Subchart “A” 

PV_WL_En  Warning for falling below the limit value, if 

PV ≥ PV_WL_Lim 

PIC_Split C 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

PIC_Split C 

Subchart “A” 

ER_AH_En 

(invisible) 

Alarm for exceeded error signal,  

if ER ≥ ER_AH_Lim 

PIC_Split C 

Subchart “A” 

ER_AL_En 

(invisible) 

Alarm for fallen short of error signal,  

if ER ≥ ER_AL_Lim 

PIC_Split Split-range 

Subchart “A” 

InScale Limit rage for the input signal 

(e.g. from -100 to +100) 

PIC_Split Split-range 

Subchart “A” 

NeutPos Neutral position 

PIC_Split Split-range 

Subchart “A” 

DeadBand Dead band range 

PIC_Split PV 

Subchart “B” 

Scale Scaling the measured value (e.g. pressure 
of max. 10) 

PIC_Split PV 

Subchart “B” 

PV_InUnit Unit of the scaled measured value (e.g. 
“1137” pressure in bar) 

YC_In / 

YC_Out 

V 

Subchart “A” 

MV_HiLim 

MV_LoLim 

Upper and lower limit of the manipulated 
value 

YC_In / 

YC_Out 

MV 

Subchart “B” 

Scale Scaling the manipulated variable 
(manipulated value from the valve block) 

YC_In / 

YC_Out 

MV 

Subchart “B” 

PV_InUnit Unit of the scaled manipulated variable 
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NOTE For commissioning the “PIC_Split” controller the “PID-Tuner” program is 
available. Chapter 6.3 “Configuration of the PID controllers” describes the 
procedure for optimizing the controller. The experiment for data recording for the 
“PID-Tuner” is initially performed in an operating range in which only positive 
manipulated variables occur. Afterwards, a comparable experiment is made in an 
operating range, where only negative manipulated variables occur.  

If both partially controlled sections for venting and inerting yield clearly different 
values for the process gain, this must be compensated by a varied increase in 
both branches of the split-range characteristic curve.  

The online help offers further information and configuration notes on process tag 
type “SplitrangeControl”. The process tag type is available in the “PCS 7 
Advanced Process Library”. 

 

 

The following table contains an overview of parameters to be interconnected with 
process devices. 

Table 5-31 

Process 
tag 

Block Connection Usage 

PIC_Split PV 

Subchart “B” 

PV_In Inside container pressure 

YC_In Rbk 

Subchart “B” 

PV_In Manipulated variable feedback 

YC_In MV 

Subchart “B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or 
output of the manipulated variable 
including signal status of the output signal 

YC_Out Rbk 

Subchart “B” 

PV_In Manipulated variable feedback 

YC_Out MV 

Subchart “B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or 
output of the manipulated variable 
including signal status of the output signal 

 

NOTE In the object properties of the message-capable blocks you can configure 
instance-specific messages. An instruction for the procedure is available in the 
configuration manuals “Process Control System PCS 7 Operator Station (V7.1)” 
under the following entry ID: 36194551 and “SIMATIC Process Control System 
PCS 7 Operator Station (V8.0)” under the entry ID: 57270173. 

 

 

http://support.automation.siemens.com/WW/view/en/36194551
http://support.automation.siemens.com/WW/view/en/57270173
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5.4 “Split-Range-Temperature” control 

Temperature control is a slow speed control where the temperatures in the 
container change slowly. To reach a specified temperature inside the container, 
either heating steam or cooling water are fed into a heat exchanger or a vessel 
shell. Due to the separation with heat-permeable walls, both methods are referred 
to as indirect heat/cold transfer. 

For the heat exchanger, the container contents are continuously fed back into the 
container through the heat exchanger via a pipe, until a predefined temperature is 
reached. The principle of operation for temperature control via the vessel shell is 
equal to that of the heat exchanger. For temperature control via the vessel shell the 
container contents are mixed using an agitator. 

 

NOTE The “Split-Range-Temperature” equipment module can be employed for 
processes where temperature control is intended via the container vessel shell or 
via an external heat exchanger. 

 

In the following example, the temperature control is solved by using a heat 
exchanger. 

5.4.1 Overview 

The structure is displayed in a P&I diagram below and all process tags and the 
simulation of the equipment module are described. 

P&I diagram 

The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols. This is a cascade control with 
split-range function at the slave controller. 

Figure 5-15 
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Process tags 

The equipment module “Split-Range-Temperature” consists of 7 interconnected 
process tags and one simulation chart. In the simulation chart an internal container 
temperature (component mixture), temperature of a heat exchanger and the impact 
through temperature changes (heating steam and cooling water) is simulated.  

The following table provides an overview of the process tags of the equipment 
module including the respective process tag types. 

 

Table 5-32 

Process tag  Process tag type Description 

TIC_Split “CTRL_Splitrange” Slave controller for split-range control 
with a manipulated variable and two 
actuators 

TIC_Temp “CTRL_Std” Master controller for controlling the 
temperature 

TI_Tank “AMON__Std” Measured value display of the internal 
container temperature (product) 

TI_HeatExchanger “AMON__Flow” Measured value display of the 
temperature of the heat exchanger 

YC_Heat “Val_An_Afb1” Control valve for the first manipulated 
variable 

YC_Cool “Val_An_Afb1” Control valve for the second 
manipulated variable 

NS_PumpMixture “MOT_1sp_1fb_1cm__Std” Pump (e.g. stream pump) for 
continuous circulation of the container 
content 

 

NOTE The “NS_PumpMixture” process tag is interconnected in the SFC (“Sequential 
Functional Chart”). An interconnection with other process tags in the “Split-
Range-Temperature” equipment module is not required. 
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In the following figure the entire structure, including all interconnections across all 
CFC charts, are represented in a simplified format. 

 

Figure 5-16 
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The “TIC_Temp” process tag uses the simulated container temperature from 
simulation chart “Sim_TempLevel” and generates the setpoint specification for the 
split-range controller. This configures the desired temperature curve in the 
“TIC_Temp” process tag. The “TI_Tank” process tag indicates the process value 
and the status values of the “TIC_Temp” process tag. 

 

The “TIC_Split” process tag receives the specified setpoint from the master 
controller and controls the simulated temperature of a heat exchanger, which 
transfers heat to the inside of the container. The “TI_HeatExchanger” process tag 
indicates the process value and the status values of the “TIC_Split” process tag.  

The split-range control is handled via the “TIC_Split” controller process tag. The 
PID controller transfers the control commands via communication blocks 
“to_Val_An1” and “to_Val_An2” to the “YC_Heat” and “YC_Cool” control valves. 
Additionally, the controller process tag receives status information from the channel 
drivers of the valve process tag via the “from_Val_An1” and “from_Val_An2” 
communication blocks. 

5.4.2 Structure and configuration 

“Sim_TempLevel” simulation 

A temperature change through heating steam or cooling water on the heat 
exchanger as well as the inside container temperature are simulated in the 
“Sim_TempLevel” CFC chart. 

The graphic representation below shows the sequence of the simulation. 

 

Figure 5-17 

1 2

3

 

1. Reducing the manipulated variable for the simulation, which enables an 
amplified valve opening representation for heating valves and cooling valves in 
the trend plotter. 

2. Calculating the temperature of a heat exchanger. The temperature change 
depends on the valve opening for both valves (bipolar signal is distributed 
between the heating steam and the cooling water valve) and is processed after 
running a delay block. 

3. Inside container temperature changing in relation to the heat exchanger. The 
temperature inside the container is 40% lower than in the heat exchanger 
(factor 0.6) and is calculated after running two delay elements. The output 
signal (container temperature) comes with a slight signal noise. 
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NOTE The simulation behavior does not correspond to a real process and is used for 
displaying the functionality and principle of operation of the equipment module 
“Split Range Temperature”. The “SIMU_AI” shows integrated behavior with an 
equally strong heating and cooling effect. For real heat exchangers a 
temperature loss and different behavior during heating (e.g. steam) and cooling 
(e.g. river water) must be expected. 

 

TIC_Temp 

In the “TIC_Temp” process tag the inside container pressure (product temperature) 
is recorded and transferred to the “TI_Temp” process tag for measured value 
display. The setpoint is specified in the “TIC_Temp” process tag, which transfers 
the setpoint value to the slave controller (“TIC_Split” process tag) as external 
setpoint value. This makes the “TIC_Temp” process tag the master controller of the 
cascade control. 

The “TIC_Temp” process tag is an instance of process tag type “CTRL__Std” and 
contains two additional communication blocks (“to_Slave” and “from_Slave_1”). 

The following table shows the configuration of the instance from “CTRL__Std”. 

Table 5-33 

Block Connection Value Usage 

C Gain.Value 1.5 Controller gain  

C TI.Value 7.054 Controller delay 

C TD.Value 1.855 Controller derivative time 

Intlock InvIn02 1  

Intlock InvIn03 1  

Intlock InvIn04 1  

ComStruIn   Inserted as “to_Slave”, for controlling the 
slave controller 

to_Slave ReStru1  Interconnecting the manipulated value as 
external setpoint to the slave controller 

(TIC_Temp\C.MV) 

to_Slave BoStru2  Interconnecting the “Bad” signal of the 
channel blocks of “TIC_Temp” to the slave 
controller 

(TIC_Temp\CSF.Out) 

to_Slave Int1 

(switch to visible) 

 Interconnecting the “PV_OutUnit” to the 
slave controller 

(TIC_Temp\MV.PV_OutUnit) 

to_Slave Int2 

(switch to visible) 

 Interconnecting the “PV_OutUnit” to the 
slave controller 

(TIC_Temp\PV.PV_OutUnit) 

to_Slave Scale1 

(switch to visible) 

 Interconnecting the “PV_OutUnit” to the 
slave controller 

(TIC_Temp\PV.ScaleOut) 

to_Slave Out  Interconnection to the slave controller 

(TIC_Split\from_Master.In) 

ComStruOut   Inserted as “from_Slave_1” for receiving 
the slave controller status 

from_Slave_1 In  Interconnection to the slave controller 
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Block Connection Value Usage 

(TIC_Split\to_Master.Out) 

from_Slave_1 BoStru1  Interconnecting the cascade interruption 
from the slave controller 

(TIC_Temp\Intlock.In02) 

from_Slave_1 BoStru2  Interconnecting the hardware error from 
the slave controller 

(TIC_Temp\Intlock.In03) 

from_Slave_1 BoStru3  Interconnecting the “Out of service” signal 
from the slave controller 

(TIC_Temp\Intlock.In04) 

from_Slave_1 Int1  Interconnecting the unit of measure of the 
setpoint value from the slave controller 

(TIC_Temp\MV.PV_InUnit) 

from_Slave_1 Scale1  Interconnecting the scaling of the setpoint 
value from the slave controller 

(TIC_Temp\MV.Scale) 

Sim Sim1ValueOp  Interconnecting to the simulation chart 
(Sim_TempLevel\TempLevel.Out) 

Sim Sim1ActOp.Value 1  

Sim Sim2ActOp.Value 1  

PV PV_Out  Interconnecting the process value to the 
measured value display 

(PI_Tank\I.PV) 

PV ScaleOut  Interconnecting the process value scaling 
to the measured value display 

(TI_Tank\PV.Scale) 

PV Bad  Interconnecting the “Bad” status for the 
measured value display 

(TI_Tank\I.CSF) 

PV OosAct  Interconnection from the “Out of service” 
signal to the process value display  

(TI_Tank\I.OosLi) 

PV PV_InUnit 1001 Unit of the process value in degree 
Centigrade 

 

TIC_Split 

In the “TIC_Split” process tag the temperature of the heat exchanger is recorded 
and transferred to the “TI_HeatExchanger” process tag for measured value display. 
The “TIC_Split” process tag controls both control values “YC_Heat” and “YC_Cool” 
via communication blocks. The setpoint specification receives the “TIC_Split” 
process tag from the “TIC_Temp” process tag. “TIC_Split” is the slave controller of 
the cascade control. The manipulated value is transferred by the “TIC_Temp” 
process tag as external setpoint value and is used as simulation value. 

“TIC_Split” is an instance from process tag type “CTRL__Splitrange” and contains 
two additional communication blocks (“to_Master” and “from_Master”). In order for 
the controller and the valves to use the same manipulated valuable unit (%), the 
interconnection from_Master.Int1 and C.MV_Unit was deleted. 
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The following table shows the configuration of the instance from CTRL_Splitrange”. 

Table 5-34 

Block Connection Value Usage 

C Gain.Value 3.5 Controller gain 

C NormMV.High 

NormMV.Low 

100 

-100 

Manipulated value area 

C DeadBand 0.2 Width of the dead band 

C ManLoLim 

(invisible) 

-100.0 Lower limit for manual operation 

C CPI_In  Interconnection for opening the 
ConPerMon faceplate from the faceplate 
(TIC_Split\CPM.CPI) 

C RefStdDevIn  Interconnection for opening the 
ConPerMon faceplate from the faceplate 

C MV_OpScale.Hig
h 

MV_OpScale.Lo
w 

100 

-100 

(TIC_Split\CPM.RefStdDev) 

CPM RefVariance 0.0  

Connector SP_LiOp.Value 1 Setpoint value via interconnection as start 
value 

Connector SP_ExtLi.Value 1 Using the external setpoint as start value 

Connector SP_Ext.Value  (TIC_Split\from_Master.ReStru1) 

Connector AutModLi.Value 1 Activating the automatic mode 

Splitrange Out1  Interconnection for the cooling simulation 

(Sim_TempLevel\ 

HeatExchanger.SP_11) 

Splitrange Out2  Interconnection for the heating simulation 

(Sim_TempLevel\ 

HeatExchanger.SP_1) 

Splitrange Out1Act  Interconnection for the cooling simulation 

(Sim_TempLevel\ 

HeatExchanger.OPEN_11) 

Splitrange Out2Act  Interconnection for the heating simulation 

(Sim_TempLevel\ 

HeatExchanger.OPEN_1) 

from_Val_An1 In  Status of the valve for heating steam 

(YC_Heat\to_CTRL.Out) 

from_Val_An2 In  Status of the valve for cooling water 
(YC_Cool\to_CTRL.Out) 

to_Val_An1 Out  Control commands of the valve for heating 
steam 

(YC_Heat\from_CTRL.In) 

to_Val_An2 Out  Control commands of the valve for cooling 
water 

(YC_Cool\from_CTRL.In) 

ComStruIn   Reinserted as “to_Master”, for transferring 
control signals 

to_Master BoStru1  (TIC_Split\C.CascaCut) 
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Block Connection Value Usage 

to_Master BoStru2  (TIC_Split\CSF.Out) 

to_Master BoStru3  (TIC_Split\OosAct.Out) 

to_Master Int1  (TIC_Split\PV.PV_OutUnit) 

to_Master Scale1  (TIC_Split\PV.ScaleOut) 

to_Master Out  (TIC_Temp\from_Slave_1.In) 

ComStruOut   Reinserted as “from_Master”, for receiving 
control commands 

from_Master In  (TIC_Temp\to_Slave.Out) 

from_Master ReStru1  (TIC_Split\Connector.SP_Ext) 

from_Master BoStru2  (TIC_Split\Intlock.In03) 

from_Master Int2 

(switch to visible) 

 Interconnecting the “PV_OutUnit” from the 
channel block of the master controller 

from_Master Scale1 

(switch to visible) 

 (TIC_Split\PV.PV_InUnit) 

Sim Sim1ActOp.Valu
e 

1 Activating the simulation of the controlled 
variable 

Sim Sim1ValueOp  (Sim_TempLevel\HeatExchanger.V) 

PV PV_Out  Interconnection from the process value to 
the measured value display 

(TI_HeatExchanger\I.PV) 

PV PV_OutUnit  Interconnecting the process value unit to 
the measured value display 

(TI_HeatExchanger\PV.PV_InUnit) 

PV ScaleOut  Interconnecting the process value scaling 
to the measured value display 

(TI_HeatExchanger\PV.Scale) 

PV Bad  Interconnecting the “Bad” status for the 
measured value display 

(TI_HeatExchanger\I.CSF) 

PV OosAct  Interconnection from the “Out of service” 
signal to the process value display  

(TI_HeatExchanger\I.OosLi) 

PV Scale  Measured value scaling 

TI_Tank 

In the “TI_Tank” process tag the measured value of the channel block of the 
“TIC_Temp” process tag is displayed. Limit values (alarm, warning) are not set in 
the operator control and monitoring block (MonAnL), since these are defined 
specifically for each process.  

The following table shows the configuration of the instance from “AMON__Std”. 

Table 5-35 

Block Connection Value Usage 

I PV  New interconnection to the channel block of the 
controller process tag 

(TIC_Temp\PV.PV_Out) 

I OosLi  New interconnection to the “Out of service” 
signal of the channel block of the controller 
process tag 
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Block Connection Value Usage 

(TIC_Temp\PV.OosAct) 

I CSF  New interconnection to the “Bad” signal of the 
channel block of the controller process tag 

(TIC_Temp\PV.Bad) 

PV Scale  Interconnection to the scaling of the process 
value 

(TIC_Temp\PV.ScaleOut) 

PV PV_InUnit  Interconnection to the unit of the process value 

(TIC_Temp\PV.PV_OutUnit) 

 

TI_HeatExchanger 

In the “TI_HeatExchanger” process tag the measured value of the channel block of 
the “TIC_Split” process tag is displayed. Limit values (alarm, warning) are not set in 
the operator control and monitoring block (MonAnL), since these are defined 
specifically for each process.  

The following table shows the configuration of the instance from “AMON__Flow”. 

Table 5-36 

Block Connection Value Usage 

I PV  New interconnection to the channel block of the controller 
process tag 

(TIC_Split\PV.PV_Out) 

I OosLi  New interconnection to the “Out of service” signal of the 
channel block of the controller process tag 

(TIC_ Split\PV.OosAct) 

I CSF  New interconnection to the “Bad” signal of the channel 
block of the controller process tag 

(TIC_Split\PV.Bad) 

PV Scale  Interconnection to the scaling of the process value 

(TIC_ Split\PV.ScaleOut) 

PV PV_InUnit  Interconnecting the unit of the process value  

(TIC_ Split\PV.PV_OutUnit) 

 

YC_Heat and YC_Cool 

The valve process tags have been designed specifically for the application in a 
split-range control. Each process tag contains communication blocks for data 
exchange (control signals and control commands) with the controller process tag.  

Valve block “V” receives an external manipulated value (via a communication 
block) from the controller process tag. Both channel blocks in subchart “B” (Rbk 
and MV) receive the same value as the process value (manipulated value of the 
valve block (subchart “A”, sheet 1)) via the preceding simulation block. 

The following table shows the configuration of the instance from “Val_An_Afb1”. 

Table 5-37 

Block Connection Value Usage 

V NoFbkOpen 1 Feedback “Valve open” 
deactivated 
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Block Connection Value Usage 

V NoFbkClose 1 Feedback “Valve closed” 
deactivated 

from_CTRL 

(YC_Heat) 

(YC_Cool) 

In  Interconnection to the 
controller 

(TIC_Split\to_Val_An1.Out) 

(TIC_Split\to_Val_An2.Out) 

to_CTRL 

(YC_Heat) 

(YC_Cool) 

Out  Interconnection to the 
controller 

(TIC_Split\from_Val_An1.In) 

(TIC_Split\from_Val_An2.In) 

Sim Sim1ActOp.Value 1 Activating the simulation of 
the readback value 

Sim Sim2ActOp.Value 1 Activating the simulation of 
the manipulated value 

Sim Sim1ValueOp  Simulation of the readback 
value from the valve 

(Interconnected with V.MV) 

Sim Sim2ValueOp  Simulation of the 
manipulated value from the 
valve 

(Interconnected with V.MV) 

 

NS_PumpMixture 

The Motor process tag has been designed for universal application and is 
controlled via an SFC interconnection or by an operator. In the equipment module 
the operator starts the pump during startup. 

The following table shows the configuration of the instance from 
“MOT_1sp_1fb_1cm__Std”. 

Table 5-38 

    

Sim Sim1ValueOp  Interconnection to 
motor block  

(U\Start.Out) 

Sim Sim6ValueOp  Interconnection to 
motor block  

(U\Start.Out) 

Sim Sim7ActOp 1 Simulation of the 
feedback for starting 
the motor (local 
message) 
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5.4.3 Commissioning, operation and instance-specific adjustments  

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 

Commissioning 

For commissioning, please follow the instructions below: 

Table 5-39 

No. Action 

1.  Click on the block icon of the “TIC_Split” controller. The respective faceplate is 
opened. 

 

2.  Change the operating mode of the controller. In the faceplate you click on the 
“…” button next to the mode switch (“Mode”) and in the faceplate extension you 
click on the “Automatic” button and adopt the settings with “OK”. 

Note: 

The interlock of master controller “TIC_Temp” is cancelled. 

3.  Perform steps 1 to 2 for master controller “TIC_Temp”. 

4.  For changing the setpoint value you click on the “Setpoint” input field and enter 
the setpoint value “30” in the faceplate expansion. Acknowledge the input with 
“ENTER” and adopt the new value with “OK”. 

Note: 

The input of a setpoint value is only performed in the faceplate of the 
“TIC_Temp” controller. 

5.  Click on the block icon of the “NS_PumpMixture” pump. The respective faceplate 
is opened. 

 

6.  For starting the motor in the faceplate you click on the “…” button next to 
Command and in the faceplate extension you click on the “Start” button and 
adopt the settings with “OK”. 
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Operation 

The following instruction describes the operation of the equipment module “Split-
Range-Temperature”. After the CPU start (in the initial state) and commissioning 
the setpoint value is 30°C and the temperature remains on 30°C with little 
fluctuations.  

In the following scenario the setpoint value is increased from 30°C to 3°C. 

 

Table 5-40 

No. Action 

1.  Click on the block icon of the “TIC_Temp” controller. The respective faceplate is 
opened. 

2.  Click on the “Setpoint” input field and enter value “40” into the input field of the 
faceplate expansion. Then acknowledge the input with the “Enter” key and click 
on the “OK” button. 

2

1

 

3.  Close the faceplate and observe the curve plotter for approx. 1 minute, until the 
setpoint has been reached. 
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Evaluation 

Figure 5-18 

1

TIC_Temp TIC_Split

 

After setpoint value change SP 1 the master controller calculates a manipulated 
variable MV 1 and forwards it to the slave controller in the cascade. This 
manipulated variable is represented as setpoint SP 2 for the slave controller in the 
trend diagram.  
 

The slave controller calculates the manipulated variable MV 2 from the setpoint 
value trend SP 2. MV 2 affects the heating and cooling valves and yields the 
temperature trend PV 2 of the heat exchanger.  

Temperature PV 1 in the container follows the temperature of the heat exchanger 
PV 2 with some delay. 

 

Legend 

 

 

The setpoint value (SP 1) causes noise in the MV 2 manipulated variable. The 
oscillation of the MV 2 manipulated variable around the neutral position is due to 
the simulation. At the real process this alternating behavior of heating and 
cooling needs to be avoided. 

 

 

 
1 
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Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices.  

The following table contains the parameters to be set specifically for each process. 

Table 5-41 

Process tag Block Connection Usage 

TI_Tank / 

TI_HeatExchanger 

I 

Subchart “A” 

PV_AH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

TI_Tank/ 

TI_HeatExchanger 

I 

Subchart “A” 

PV_WH_En Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

TI_Tank/ 

TI_HeatExchanger 

I 

Subchart “A” 

PV_WL_En  Warning for falling below the limit 
value,  

if PV ≥ PV_AL_Lim 

TI_Tank/ 

TI_HeatExchanger 

I 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

TIC_Temp /’ 
TIC_Split 

C 

Subchart “A” 

Gain Proportional gain 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

TD Derivative time (rate time) in [s] 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

TI Integral time (reset time) in [s] 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

SP_InHiLim Limit value (high) of the internal 

setpoint value 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

SP_InLoLim Limit value (low) of the internal 

setpoint value 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_WH_En Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_TH_En Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_TL_En Warning for falling below the limit 

value, if PV ≥ PV_TH_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_TL_En Tolerance for falling below the limit 

value, if PV ≤ PV_TL_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_WL_En  Warning for falling below the limit 

value, if PV ≥ PV_WL_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

PV_AL_En Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

TIC_Temp /  
TIC_Split 

C 

Subchart “A” 

ER_AH_En 

(invisible) 

Alarm for exceeded error signal,  

if ER ≥ ER_AH_Lim 

TIC_Temp /  

TIC_Split 

C 

Subchart “A” 

ER_AL_En 

(invisible) 

Alarm for fallen short of error signal,  

if ER ≥ ER_AL_Lim 

TIC_Temp  PV Scale Scaling the measured value (e.g. 
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Process tag Block Connection Usage 

Subchart “B” temperature of max. 100) 

TIC_Temp PV 

Subchart “B” 

PV_InUnit Unit of the scaled measured value 
(e.g. “1001” for degree Centigrade) 

TIC_Temp MV 

Subchart “B” 

PV_InUnit Unit of the scaled measured value 
(e.g. “1342” for percent) 

TIC_Split C 

Subchart “A” 

NormMV Manipulated value range (MV) for 
normalization 

of the proportional gain (GAIN) 

TIC_Split Splitrange 

Subchart “A” 

InScale Limit rage for the input signal 

(e.g. from -100 to +100) 

TIC_Split Splitrange 

Subchart “A” 

NeutPos Neutral position 

TIC_Split Splitrange 

Subchart “A” 

DeadBand Dead band range 

YC_Heat / 

YC_Cool 

V 

Subchart “A” 

MV_HiLim 

MV_LoLim 

Upper and lower limit of the 
manipulated value 

YC_Heat / 

YC_Cool 

MV 

Subchart “B” 

Scale Scaling the manipulated variable 
(manipulated value from the valve 
block) 

YC_Heat / 

YC_Cool 

MV 

Subchart “B” 

PV_InUnit Unit of the scaled manipulated variable 

 

NOTE For commissioning the “TIC_Split” controller the “PID-Tuner” program is 
available to you. Chapter 6.3 “Configuration of the PID controllers” describes the 
procedure for optimizing the controller. The experiment for data recording for the 
“PID-Tuner” is initially performed in an operating range in which only positive 
manipulated variables occur. Afterwards, a comparable experiment is made in an 
operating range, where only negative manipulated variables occur.  

If both partially controlled sections for heating and cooling yield clearly different 
values for the process gain, this must be compensated by a varied increase in 
both branches of the split-range characteristic curve.  

After the slave controller, including the split-range, has been fully started up and 
tested, the “TIC_Temp” master controller is adjusted using the “PID Tuner” 
program. 

The online help offers further information and configuration notes on process tag 
type “CascadeControl”. The process tag type is available in the “PCS 7 
Advanced Process Library”. 

 

 

The following table contains an overview of parameters to be interconnected with 
process devices. 

Table 5-42 

Process tag Block Connection Value 

TIC_Temp PV 

Subchart 
“B” 

PV_In Inside container temperature 

(component mixture) 
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Process tag Block Connection Value 

TIC_Split PV 

Subchart 
“B” 

PV_In Temperature in the heat exchanger 

YC_Heat Rbk 

Subchart 
“B” 

PV_In Manipulated variable feedback 

YC_Heat MV 

Subchart 
“B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or 
output of the manipulated variable 
including signal status of the output 
signal 

YC_Cool Rbk 

Subchart 
“B” 

PV_In Manipulated variable feedback 

YC_Cool MV 

Subchart 
“B” 

PV_Out or 

PV_ChnST 

Output of the manipulated variable or 
output of the manipulated variable 
including signal status of the output 
signal 

NS_PumpMixture FbkRun 

Subchart 
“B” 

PV_In Feedback signal when starting a motor 

NS_PumpMixture Maint 

Subchart 
“B” 

PV_In Motor maintenance request 

NS_PumpMixture Trip 

Subchart 
“B” 

PV_In Motor error message 

NS_PumpMixture StartLocal 

Subchart 
“B” 

PV_In Local operation (starting a motor) 

NS_PumpMixture StopLocal 

Subchart 
“B”“ 

PV_In Local operation (stopping a motor) 

NS_PumpMixture Start 

Subchart 
“B” 

PV_Out  Starting / stopping a motor 

NS_PumpMixture FbkRunOut 

Subchart 
“B” 

PV_Out  Feedback for starting the motor 

 

NOTE In the object properties of the message-capable blocks you can configure 
instance-specific messages. An instruction for the procedure is available in the 
configuration manuals “Process Control System PCS 7 Operator Station (V7.1)” 
under the following entry ID: 36194551 and “SIMATIC Process Control System 
PCS 7 Operator Station (V8.0)” under the entry ID: 57270173 

 

 

http://support.automation.siemens.com/WW/view/en/36194551
http://support.automation.siemens.com/WW/view/en/57270173
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5.5 Control of the pH value with a standard controller 

The equipment module "pH-Control-Std" is used to regulate the pH value of a 
product. This is effected by adding a neutralizing agent to the product during the 
continuous plant process until the desired pH value is reached. 

Due to the highly nonlinear titration curve this means that, depending on the 
operating point, the control loop gain may be subject to extreme variations. Only in 
applications in which the pH value shall be kept constant within a very narrow 
range, and if the disturbing influences are limited, the pH value can be regulated 
with a preconfigured PID controller. The specialty of the equipment module 
presented here is the transformation of the pH setpoint and the pH process value 
into concentration differences, so as to achieve a linearization of the control loop 
characteristic. This transformation is based on a titration curve which describes the 
behavior of the chemical reaction of the given process at least by approximation. 

In the case of complex applications with long dead times (because of the 
measuring dead time of the pH probe, the time required for mixing and the reaction 
time of the neutralizer) and the requirement of dynamic disturbance compensation 
based on the pH value in the inflow (feed), we recommend to compensate these 
influences with the help of a multi-variable controller.  

5.5.1 Overview 

The following section describes the structure in the P&I scheme including all 
process tags and simulation of the equipment module. 

P&I diagram 

The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols.  

Figure 5-19 

QI

pH_Tank

YC

NeutSubst

QIC

pH_Control_Std

Neutralizing agent
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Process tags 

The equipment module "pH-Control-Std" consists of 3 interconnected process tags 
and a simulation chart. The simulation chart is used to calculate the pH setpoint on 
the basis of the concentration difference between component and neutralizer. 

The setpoint (pH value) is defined in an OpAnL block. The controller receives the 
converted pH values (setpoint and actual value) in the form of a concentration 
difference for regulation.  

The table below provides an overview of the process tags for the equipment 
module including the associated process tag types. 

Table 5-43 

Process tag Process tag type Description 

QIC_pH_Control_Std "CTRL_Std4Valve" Standard PID controller with one manipulated variable 

QI_pH_Tank "AMON__Std" Display of the measured pH value of the product  

YC_NeutrSubst "Val_An_Afb1" Control valve for the neutralizer 

 

In the following figure the entire structure, including all interconnections across all 
CFC charts, are represented in a simplified format. 

Figure 5-20 

Sim_pH

ph_Std

ph_Std

pH

Neutr_MV

QI_pH_Tank

Sim

Sim1Value

PV

PV_InUnit

Scale

QIC_pH_Control_Std

PV

PV_OutUnit

Sim

Sim1ValueOp

to_Valve

Out

from_Valve

In

YC_NeutrSubst

V

MV

from_CTRL

In

to_CTRL

Out

ScaleOut

Sqrt

Out

 

 

The controller process tag "QIC_pH_Control_Std" captures the pH value in the 
tank (product) and – depending on the concentration differences between pH 
setpoint and actual pH value – it adds the required amount of neutralizer via the 
control valve "YC_NeutrSubst". Since the controller process tag is used to display 
the concentration difference, the pH value is displayed with the help of a display 
process tag. If the valve process tag shows an error, the controller process tag will 
change over to manual mode and display will be realized in both process tags. 
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5.5.2 Structure and configuration 

Simulation "Sim_pH" 

The CFC chart "pH_Std" is used for calculation of the pH value. The figure below 
shows how the simulation block is configured. 

Figure 5-21 

 

The block inputs include notional parameters for the buffer parameter "Alfa" and 
the amplitude range "Ampl_pH" to be covered. In addition, fixed values for the pH 
value and the feed rate are defined. 

There is no dead time defined for the pH simulation value (simulation process). 

 

Note For further information please refer to the block description in chapter 10.6 
"Block description "SimpHTitr. 

 

QIC_pH_Control_Std 

This process tag is used to pick up the product’s pH value in the tank during a 
continuous production process and to transfer this value to the process tag 
"QI_pH_Tank" in the measured value display. In this process tag, the setpoint is 
defined in an OpAnl block. Setpoint and actual value are converted into 
concentration differences and then transmitted to the controller. 

 

Note The titration curve for a specific chemical process must be configured with the 
help of the PID tuner before the PID controller is set. For further information on 
how to convert the pH value into a concentration difference please refer to the 
block description in chapter 10.5 "Block description "pHTitrBlock. 

 

The pH value is regulated by transmitting control signals to the valve process tag 
"YC_NeutrSubst". 

 

Note If the component feed rate is expected to be subject to large differences, we 
recommend to realize disturbance compensation through linear conversion of the 
manipulated value using the block "pHTitrBlock". This block is described in 
chapter 10.5 "Block description "pHTitrBlock. 
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The controller process tag "QIC_pH_Control_Std" is an instance of the process tag 
type "CTRL_Std4Valve". 

The table below shows how the instance of "CTRL_Std4Valve" is configured. 

Table 5-44 

Block Connection Value Usage 

C NegGain.Value 0 

Positive controller gain, since the control 
operation is used to increase the pH 
value 

C Gain.Value 6 Controller gain  

C NormPV 
10000 
-10000 

Minimum and maximum value of the 
concentration difference. 

C TI.Value 2 Controller delay 

C SP_InHiLim 10000 Maximum value of the internal setpoint 

C SP_InLoLim -10000 Minimum value of the internal setpoint 

C SP_Ext  

Previous interconnection deleted. New 
interconnection to the conversion block 
(pHTitrConvert.SP_Out) 

C PV  

Previous interconnection deleted. New 
interconnection to the conversion block 
(pHTitrConvert.CV_Out) 

C PV_OpScale 
10000 
-10000 

Previous interconnection to the channel 
block deleted. 
Minimum and maximum value of the 
concentration difference. 

C PV_Unit 1399 

Previous interconnection to the channel 
block deleted.  
Unit of the concentration difference in 
mol/L 

pHTitrBlock   
Newly added as "pHTitrConvert" for the 
conversion of pH values  

pHTitrConvert Alfa 35000 Buffer parameter 

pHTitrConvert Ampl_pH 5.0 Amplitude range to be processed 

pHTitrConvert CV_Out  
Interconnection to the controller block 
(C.PV) 

pHTitrConvert SP_Out  
Interconnection to the controller block 
(C.SP_Ext) 

Connector SP_LiOp 1 1 = Setpoint specification via CFC/SFC 

Connector SP_ExtLi 1 
1 = External setpoint specification via 
CFC/SFC 

Connector SP_ExtOut  

Previous interconnection deleted. New 
interconnection to the conversion block 
(pHTitrConvert.SP) 

OpAnL   
Newly added as "pH_SP" for setpoint 
entry by the operator  

pH_SP SP_IntLi 1 
1 = Internal setpoint via specification 
CFC/SFC 

pH_SP SP_Int 7 Internal setpoint  

pH_SP SP_HiLim 7.5 Maximum setpoint 

pH_SP SP_LoLim 6.5 Minimum setpoint 

pH_SP SP_Unit 1422 Setpoint unit as pH value  
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Block Connection Value Usage 

pH_SP SP_Out  
Interconnection to the connector block 
(Connector.SP_Ext) 

Intlock InvIn02 1 
Inversion of the hardware error signal 
from the valve process tag  

to_Valve Out  
Interconnection to the valve process tag 
(YC_NeutrSubst\from_CTRL.In) 

from_Valve In  
Interconnection from the valve process 
tag (YC_NeutrSubst\to_CTRL.Out) 

Sim Sim1ActOp.Value 1 
Simulation value of the pH value if set to 
"1" active 

Sim Sim1ValueOp  

Interconnection to the pH value in the 
simulation chart 
(Sim_pH\pH_Std.pH) 

PV 
Scale.High 
Scale.Low 

12.0 
2.0 Maximum and minimum process value  

PV PV_InUnit 1422 Unit of the process value (pH) 

PV Bad  
Interconnection to the interlock block 
(Intlock.In01) 

PV PV_OutUnit  
Interconnection to the display process 
tag (QI_pH_Tank \PV.PV_InUnit) 

PV ScaleOut  
Interconnection to the display process 
tag (QI_pH_Tank \PV.Scale) 

Sqrt Out  

Interconnection to the display process 
tag (QI_pH_Tank \Sim.Sim1ValueOp) 
and the conversion block  
(pHTitrConvert.CV) 

 

QI_pH_Tank 

The "QI_pH_Tank"process tag is used to display the channel block measuring 
value of the controller process tag "QIC_pH_Control_Std". No limit values (alarm, 
warning) are set in the operator control and monitoring block, since these are 
defined specifically for each process.  

The table below shows the configuration of the instance of "AMON__Std". 

Table 5-45 

Block Connection Value Usage 

Sim Sim1ActOp 1 Active simulation value 

Sim Sim1ValueOp  

New interconnection to the process 
value of the controller process tag  
(QIC_pH_Control_Std\Sqrt.Out) 

PV Scale  

Interconnection to the scaling of the 
process value  
(QIC_pH_Control_Std \PV.ScaleOut) 

PV PV_InUnit  

Interconnection to the unit of the process 
value  
(QIC_pH_Control_Std \PV.PV_OutUnit) 
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Note The messages for hardware error and device in maintenance mode (CSF) 
(OosLi) of the controller process tag are not displayed separately. If these 
messages are required, interconnect them additionally with the interlock block of 
the controller process tag. 

 

YC_NeutrSubst 

The valve process tag "YC_NeutrSubst" is used to control the flow rate of the 
neutralizing agent. This process tag contains the communication blocks for data 
exchange (control signals and control commands) with the controller process tag. 

The valve block "V" receives an external manipulated value from the controller 
process tag (via a communication block). In a simulation environment, both 
channel blocks in subchart "B" (Rbk and MV) receive the same value (manipulated 
value of the valve block (subchart "A", sheet 1)) via the preceding simulation block. 

The table below shows the configuration of the instance from "Val_An_Afb1". 

Table 5-46 

Block Connection Value Usage 

V MV  
Interconnection to the simulation 
(Sim_pH\phSimu.FV_IN_2) 

V 

ER_AH_En 

(hidden) 0 
Deactivation of the alarm message for 
maximum valve opening  

V 

ER_AL_En 

(hidden) 0 
Deactivation of the alarm message for 
minimum valve opening  

from_CTRL In  
Interconnection to the controller  
(QIC_pH_Control_Std\to_Valve.Out) 

to_CTRL Out  
Interconnection to the controller  
(QIC_pH_Control_Std\from_Valve.In) 

Sim Sim1ActOp.Value 1 
Activates simulation of the readback 
value  

Sim Sim1ValueOp  

Interconnected with the simulation of the 
readback value from the valve  
(YC_NeutrSubst\V.MV) 

Sim Sim2ActOp.Value 1 
Activates simulation of the manipulated 
value 

Sim Sim2ValueOp  

Interconnection with the simulation of 
the manipulated value from the valve  
(YC_NeutrSubst \V.MV) 

5.5.3 Commissioning, operation and instance-specific adjustments 

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 
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Commissioning 

For commissioning, proceed as follows: 

Table 5-47 

No. Action 

1.  Click the block icon of the controller "QIC_pH_Control_Std" to open the 
associated faceplate. 

 

2.  Change the operating mode of the controller. In the faceplate, click the "…" 
button next to the "Mode" switch and in the expanded faceplate, click the 
"Automatic" button. Then confirm your settings with "OK". 

3.  The controller uses the pH value predefined in the OpAnL block icon as external 
setpoint. The default value of this setpoint (neutral zone) is set to "7" pH which is 
taken as a basis for the quantity of neutralizer to be added (for regulation). 

Operation 

The following instruction describes how the equipment module "pH-Control-Std" is 
operated. After start-up of the CPU (in initial status) and commissioning, the 
setpoint is set to 7 pH.  

In the following scenario, the pH value (setpoint) shall be reduced from 7 pH to 
6.5 pH. 

Table 5-48 

No. Action 

1.  Click the block icon of the OpAnL block (right to the controller block) to open the 
associated faceplate. 
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No. Action 

2.  Click the input field "Setpoint" and enter the value "6.5" in the input field of the 
expanded faceplate. Then press the "ENTER" key to confirm settings and click 
the "OK" button. 

2

1

 

3.  Close the faceplate and watch the curve plotter for approx. 1 minute until the 
setpoint is reached. 

Evaluation 

Figure 5-22 

 

 

The controller has been optimized so as to reach the setpoint without overshoots. 
After the setpoint change, the controller adds the neutralizer with a slight delay.  

 

Note The controller is set to an operating point of ± 0.5 pH around the neutral zone of 
7 pH. If the operating point deviates from this value, the controller may need to 
be optimized anew.  
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Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices.  

The table below lists all parameters to be set specifically for the relevant process. 

Table 5-49 

Process tag Block Connection Usage 

QI_pH_Tank 

I 

Subchart "A" PV_AH_En 
Upper limit violation alarm,   
if PV ≥ PV_AH_Lim  

QI_pH_Tank  

I 

Subchart "A" PV_WH_En  
Upper limit violation warning,   
if PV ≥ PV_WH_Lim 

QI_pH_Tank  

I 

Subchart "A" PV_WL_En  
Lower limit violation warning,   
if PV ≤ PV_WL_Lim 

QI_pH_Tank  

I 

Subchart "A" PV_AL_En 
Lower limit violation alarm,   
if PV ≤ PV_AL_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" Gain Proportional gain 

QIC_pH_Control_Std 

C 

Subchart "A" TD Derivative action time in [s] 

QIC_pH_Control_Std 

C 

Subchart "A" TI Integral action time in [s] 

QIC_pH_Control_Std 

C 

Subchart "A" SP_InHiLim 
Limit value (high) of the internal 
setpoint  

QIC_pH_Control_Std 

C 

Subchart "A" SP_InLoLim 
Limit value (low) of the  
internal setpoint  

QIC_pH_Control_Std 

C 

Subchart "A" PV_AH_En 
Upper limit violation alarm, if PV ≥ 
PV_AH_Lim  

QIC_pH_Control_Std 

C 

Subchart "A" PV_WH_En  
Upper limit violation warning, if 
PV ≥ PV_WH_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" PV_TH_En 
Tolerance for upper limit 
exceedance, if PV ≥ PV_TH_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" PV_TL_En 
Tolerance for lower limit 
exceedance, if PV ≤ PV_TL_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" PV_WL_En  
Warning of lower limit 
exceedance, if PV ≤ PV_WL_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" PV_AL_En 
Alarm for lower limit exceedance,  
if PV ≤ PV_AL_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" 

ER_AH_En 

(hidden) 
Alarm for upper control deviation 
exceedance, if ER ≥ ER_AH_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" 

ER_AL_En 

(hidden) 
Alarm for lower control deviation 
exceedance, if ER ≤ ER_AL_Lim 

QIC_pH_Control_Std 

C 

Subchart "A" ER_AH_Lim 
Limit for upper control deviation 
exceedance 

QIC_pH_Control_Std 

C 

Subchart "A" ER_AL_Lim 
Limit for lower control deviation 
exceedance 
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Process tag Block Connection Usage 

QIC_pH_Control_Std 

C 

Subchart "A" PV_OpScale 

Scaling of the process value 
within the display range 
(operator) 

QIC_pH_Control_Std 

pHTitrConvert 

Subchart "A" Alfa Buffer parameter 

QIC_pH_Control_Std 

pHTitrConvert 

Subchart "A" Ampl_pH Amplitude range to be processed 

QIC_pH_Control_Std 

PV 

Subchart "B" Scale 
Scaling of the measuring value 
(e. g. temperature of max. 100) 

QIC_pH_Control_Std 

PV 

Subchart "B" PV_InUnit 

Unit of the scaled measuring 
value (e. g. "1001" for degrees 
Celsius) 

YC_NeutrSubst 

V 

Subchart "A" 

MV_HiLim 

MV_LoLim 
Upper and lower limit of the 
manipulated value  

YC_NeutrSubst 

MV 

Subchart "B" Scale 

Scaling of the manipulated 
variable (manipulated value from 
the valve block) 

YC_NeutrSubst 

MV 

Subchart "B" PV_InUnit 
Unit of the scaled manipulated 
variable  

 

Note For the commissioning of the "QIC_pH_Control_Std" controller, a "PID tuner" 
program is available. The procedure for controller optimization is described in 
chapter 6.3 “Configuration of the PID controllers”. The data recording experiment 
for the "PID tuner" is initially performed in an operating range where only positive 
manipulated variables occur. Optimization of the pH value controller was 
performed due to concentration differences with different manipulated values 
(MV) at a constant infeed amount (component). 

 

The table below provides an overview of all parameters to be interconnected with 
process devices. 

Table 5-50 

Process tag Block Connection Usage 

QIC_pH_Control_Std 

PV 

Subchart "B" PV_In pH value in the tank  

YC_NeutrSubst 

Rbk 

Subchart "B" PV_In Manipulated variable feedback 

YC_NeutrSubst 

MV 

Subchart "B" 

PV_Out or 

PV_ChnST 

Output of the manipulated 
value with or without signal 
status  

 

Note In the object properties of the message-capable blocks you can configure 
instance-specific messages. Instructions on how to proceed are available in the 
configuration manuals "Process Control System PCS 7 Operator Station (V7.1)" 
under the entry ID: 36194551 and "SIMATIC Process Control System PCS 7 
Operator Station (V8.0)" under the entry ID: 57270173. 

 

http://support.automation.siemens.com/WW/view/de/36194551
http://support.automation.siemens.com/WW/view/de/57270173
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5.6 Control of the pH value with a multi-variable controller 

Control of the pH value with the help of the multi-variable controller "pH-Control-
MPC" is used for the same control task but fulfills some special requirements 
regarding the highly nonlinear titration curve, whereby the pH value is regulated 
with a standard controller, supplemented by the targeted compensation of dead 
times in the control loop (because of the measured dead time of the pH probe, the 
time required for mixing and the reaction time of the neutralizer), as well as a 
model-based compensation of measurable disturbances resulting from variations in 
the pH value of the infeed material. 

In the following example, regulation of a product’s pH value by adding a 
neutralizing agent is supplemented by considering not only the pH value of the 
product, but also the process value and inflow volume (feed) of the component. 

This example is intended for a continuous process in which the pH value and the 
inflow volume (feed) of the component can be modified. 

5.6.1 Overview 

The P&I diagram below shows the structure and describes all process tags and the 
simulation of equipment modules. 

P&I diagram 

The following P&I diagram includes symbols for all components relevant to 
operation, such as aggregates, tanks, etc., using a multi-variable control system. 

Figure 5-23 
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Process tags 

The equipment module "pH-Control-MPC" consists of 4 interconnected process 
tags and one simulation chart. In the simulation chart, the pH value and the inflow 
volume of component and neutralizer (manipulated value of the valve) are used to 
determine the product’s pH value.  

The pH values of the component and the pH setpoint, as well as the inflow volume 
(feed) can be adjusted by the operator in the OS with the help of the OpAnL blocks 
added to the simulation chart and the controller process tag.  

The controller uses pH values (setpoint and actual value of the product and actual 
value of the component) which have been converted into concentration differences. 
Furthermore, the feed rate of component influences the amount of neutralizer to be 
added, since the maximum manipulated value changes in relation to the factor of 
actual and maximum inflow volume of the component.  

 

Note For further information on the calculation of manipulated values and scaling, 
please refer to the description of blocks in chapter 10.5 "Block description 
"pHTitrBlock. 

 

The following values are specified in the OpAnL blocks and can be adjusted in the 
visualization display: 

 pH setpoint (product) 

 pH value of the component 

 inflow volume (feed) of the component 

For easier handling, not all specified values have been allocated to a display 
process tag. 

The table below provides an overview of the process tags and equipment modules 
including the associated process tag types. 

Table 5-51 

Process tag Process tag type Description 

QIC_pH_Control_MPC "CTRL_MPC4Valve" Multi-variable controller with one manipulated value 
and acquisition of the pH value of the product 

QI_pH_Product "AMON__Std" Measured value display of the product’s pH value 

FI_Feed "AMON_Flow" Display of the component’s flow rate  

YC_Neutralizer "Val_An_Afb1" Control valve for the neutralizer  
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The following P&I diagram represents all components relevant for the operation, 
such as aggregates, containers, etc. as symbols.  

Figure 5-24 
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The controller process tag "QIC_pH_Control_MPC" records the pH value of the 
component and the pH value of the outflowing product in the form of concentration 
differences. Depending on the pH difference (setpoint and actual value of the 
product), the required amount of neutralizing agent will be added to the tank via the 
control valve "YC_Neutralizer". If an error occurs in the valve process tag, the 
controller process tag changes over to manual mode and the error will be displayed 
at both process tags.  
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5.6.2 Structure and configuration 

Simulation "Sim_pH_MPC" 

The CFC chart "Sim_pH_MPC" is used to calculate the pH value. Sheet "1" 
additionally includes OpAnL blocks to specify the feed rate and the pH value of the 
component which are interconnected with the simulation block. 

The figure below shows the parameter configuration of the simulation block. 

Figure 5-25 

 

The block inputs include notional parameters for the buffer parameter "Alfa" 
and the amplitude range "Ampl_pH" to be passed. In addition, fixed values for 
the pH value and the feed rate of the component as used in the OpAnL blocks 
are used for calculation. 

For the pH simulation value (simulation process) a dead time of 10 seconds, a 
neutralizer infeed delay of 10 seconds and a gain factor of 3 are set by default. 
 

Note For further information please refer to the block description in chapter 10.6 
"Block description "SimpHTitr. 

 

QIC_pH_Control_MPC 

This process tag is used to pick up the product’s pH value in the tank during a 
continuous production process and to transfer this value to the process tag 
"QI_pH_Product" in the measured value display. In this process tag, the setpoint is 
defined in an OpAnl block. Setpoint and actual value are converted into 
concentration differences and then transmitted to the controller.  

 

Note The titration curve for a specific chemical process must be configured before 
setting the MPC with the help of the MPC configurator. 

For further information on the conversion of the pH value into a concentration 
difference, please refer to the block description in chapter 10.5 "Block description 
"pHTitrBlock. 

 

The multi-variable controller (MPC) transmits control signals to the valve process 
tags "YC_Neutralizer".  

The table below shows how the instance of "CTRL_MPC4Valve" is configured. 
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Table 5-52 

Block Connection Value Usage 

MPC PreFilt1 0.0 
Time constant [s] of the setpoint filter for the 
setpoint SP1 (settling time of CV channel). 

MPC CV1  

Previous interconnection deleted. New 
interconnection to the conversion block 
(TitrConverting.CV_Out) 

MPC DV1  

Previous interconnection deleted. New 
interconnection to the conversion block 
(TitrConverting.DV_Out) 

MPC SP1  

Previous interconnection deleted. New 
interconnection to the conversion block 
(TitrConverting.SP_Out) 

MPC 
SP1HiLim 
(hidden) 500 

Upper limit for the setpoint of the 
concentration difference  

MPC 
SP1LoLim 
(hidden) -500 

Lower limit for the setpoint of the 
concentration difference  

MPC MV1HiLim  
New interconnection to the conversion block 
(TitrConverting.MVHiLim) 

MPC CV1_Unit 1399 Unit of control variable 1 (process value) 

MPC DB_No 53 Data block with controller data  

MPC MV1  

Previous interconnection deleted. New 
interconnection to the conversion block 
(TitrConverting.MV) 

pH_SP PV_In  

Interconnection to the channel block of the 
pH value display process tag  
(QI_pH_Product\PV.PV_Out) 

pHTitrBlock   
Newly added as "TitrConverting" for the 
conversion of pH values 

TitrConverting CV  
New interconnection to the channel block  
(PV.PV_Out) 

TitrConverting DV  
New interconnection to the ConnMPC block 
(ConnMPC.DV1Out) 

TitrConverting SP  
New interconnection to the ConnMPC block 
(ConnMPC.SP1Out) 

TitrConverting Alfa 35000 Buffer parameter 

TitrConverting Ampl_pH 5.0 Amplitude range to be processed 

TitrConverting MV  
New interconnection of the controller block 
(MPC.MV1) 

TitrConverting Feed_PV_Out  

New interconnection of the linearized 
measuring value of the display process tag 
(FI_Feed\Sqrt.Out) 

TitrConverting Feed_Scale  

New interconnection of the channel block of 
the display process tag 
(FI_Feed\PV.ScaleOut) 

TitrConverting CV_Out  
Interconnection to the controller block 
(MPC.CV1) 

TitrConverting DV_Out  
Interconnection to the controller block 
(MPC.DV1) 

TitrConverting SP_Out  
Interconnection to the controller block 
(MPC.SP1) 

TitrConverting MVHiLim  Interconnection to the controller block 
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Block Connection Value Usage 

(MPC.MV1HiLim) 

TitrConverting MV_Valve  
Interconnection to the communication block 
(to_Valve.ReStru1) 

ConnMPC SP1  

Interconnection to the OpAnL block for 
setpoint specification 
(pH_SP.SP_Out ) 

ConnMPC DV1  

Interconnection of the OpAnL block to the pH 
value specification of the component  
(Sim_pH_MPC\pH_Feed.SP_Out ) 

ConnMPC DV_On 1 
1 = Activation of disturbance variable 
compensation 

to_Valve Out  
Interconnection to the valve process tag 
(YC_Neutralizer\from_CTRL.In) 

from_Valve In  
Interconnection to the valve process tag 
(YC_Neutralizer\to_CTRL.Out) 

Sim Sim1Act0p 1 
Simulation value (pH value of the product) 
active at "1"  

Sim Sim1ValueOp  
Interconnection to the pH simulation value 
(Sim_pH_MPC\pH_MPC.pH ) 

PV 
Scale.High 
Scale.Low 

12 
2 Scaling of the process value 

PV PV_InUnit 1422 Unit of the process value in pH 

PV PV_Out  

Interconnection of the measured value with 
the display process tag 
(QI_pH_Product\Sim.Sim1ValueOp) 

PV PV_OutUnit  

Interconnection of the unit with the display 
process tag 
(QI_pH_Product\PV.PV_InUnit) 

PV ScaleOut  

Interconnection of the scaling with the display 
process tag 
(QI_pH_Product\PV.Scale) 

 

NOTE With the help of the MPC configurator, the multi-variable controller was optimized 
for an operating point between 7.5 and 6.5 pH and saved in the data block DB 
53. The relevant influencing variables were a component feed rate of 3000 L/s 
with pH4 and the neutralizer with pH12. 

For trend recording, the manipulated value was excited by using the block 
"AutoExci" and, additionally, a disturbance variable change (±10%) was 
performed. 

 

 

FI_Feed 

The process tag "FI_Feed" is used to pick up and display the flow rate of the 
component and to monitor its limit values. The channel block of the display process 
tag receives its measured value from the OpAnL block of the simulation chart. 

The table below shows how the instance of "AMON_Flow" is configured.  
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Table 5-53 

Block Connection Value Usage 

Sim Sim1Act0p 1 Simulation of the process value 

Sim Sim1ValueOp  
Interconnection to the pH simulation value 
(Sim_pH_MPC\Feed_Flow.SP_Out) 

PV Scale 
5000.0 
0.0 Scaling of the process value 

PV PV_InUnit 1038 Unit of the process value in liters 

PV PV_OutUnit  

Interconnection to the simulation chart   
(Sim_pH_MPC\Feed_Flow.SP_Unit) 
(Sim_pH_MPC\Feed_Flow.PV_Unit) 

PV ScaleOut  
Interconnection to the controller process tag  
(QIC_pH_Control_MPC\TitrConverting.Feed_Scale) 

Sqrt Out  

Interconnection to the controller process tag  
(QIC_pH_Control_MPC\ 
TitrConverting.Feed_PV_Out) 

 

QI_pH_Product 

The process tag "QI_pH_Product" is used to display the pH value of the product. 
The pH value is picked up in the controller process tag but displayed in the form of 
a concentration difference in this process tag. The channel block of the display 
process tag includes the process value, the unit of the measured value and the 
scaling of the channel block of the multi-variable controller.  

The table below shows how the instance of "AMON__Std" is configured. 

Table 5-54 

Block Connection Value Usage 

Sim Sim1Act0p 1 Simulation of the process value 

Sim Sim1ValueOp  

Interconnection to the pH value in the 
controller process tag 
(QIC_pH_Control_MPC\PV.PV_Out ) 

PV PV_OutUnit  

Interconnection to the simulation chart   
(Sim_pH_MPC\pH_Feed.SP_Unit) 
(Sim_pH_MPC\pH_Feed.PV_Unit) 

 

YC_Neutralizer 

The process tag "YC_Neutralizer" is used to pick up and to determine the flow rate 
of the neutralizing agent (readback). The manipulated value is transmitted from the 
multi-variable process tag via communication blocks. 

The table below shows how the instance of "Val_An_Afb1" is configured. 

Table 5-55 

Block Connection Value Usage 

V MV  
Interconnection to the pH simulation 
(Sim_pH_MPC\pH_MPC.Neutr_MV) 

V 

ER_AH_En 

(hidden) 0 
Deactivation of the alarm message for 
maximum valve opening  

V 

ER_AL_En 

(hidden) 0 
Deactivation of the alarm message for 
minimum valve opening  
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Block Connection Value Usage 

Sim Sim1Act0p 1 Simulation of the process value 

Sim Sim1ValueOp  
Interconnection to the manipulated value 
(YC_Neutralizer\V.MV ) 

Sim Sim2Act0p 1 Simulation of the process value 

Sim Sim2ValueOp  
Interconnection to the manipulated value 
(YC_Neutralizer\V.MV ) 

from_CTRL In  

Interconnection to the multi-variable 
controller 
(QIC_pH_Control_MPC\to_Valve.Out ) 

to_CTRL Out  

Control signals from the multi-variable 
controller  
(QIC_pH_Control_MPC\from_Valve.In ) 

 

5.6.3 Commissioning, operation and instance-specific adjustments 

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 

Commissioning 

For commissioning, proceed as follows: 

Table 5-56 

No. Action 

1.  Click the block icon of the controller "QIC_pH_Control_MPC" to open the 
associated faceplate. 

 

2.  Change the operating mode of the first controller. In the faceplate, click the "…" 
button next to the mode switch ("Mode"), click the "Automatic" button in the 
expanded faceplate and then confirm your settings with "OK". 

3.  The controller uses the predefined pH value of the OpAnL block icon as an 
external setpoint. The default value of this setpoint (neutral zone) is set to "7" pH 
which is the basis for the quantity of neutralizing agent to be added (for 
regulation). 

Operation 

The following instruction describes the operation of the equipment module "pH-
Control-MPC". After start-up of the CPU (in initial status) and commissioning, the 
actual value shows pH7. The whole adjustment process takes approx. 14 minutes. 
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In the following scenario, the disturbance variable shall be changed. The pH value 
of the component shall be increased from pH 4 to pH 4.5. 

Table 5-57 

No. Action 

1.  Click the block icon for the operator control block "pH_Feed"to open the 
associated faceplate. 

2.  Click the "Setpoint" input field and enter the value "5.2" in the input field of the 
expanded faceplate. Then press the "ENTER" key to confirm settings and click 
the "OK" button. 

2

1

 

3.  Close the faceplate and watch the curve plotter for approx. 10 minutes until the 
setpoint is reached. 

Evaluation 

Figure 5-26 

1 2

2

 

 

1. The controller has been optimized so that the setpoint will slowly and precisely 
be reached. The controller recognizes the change in the disturbance variable 
and changes the manipulated value accordingly before the process reacts to 
the disturbing influence (specified dead time in the simulation block). The 
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disturbance variable takes effect on the actual value without delay (time delay 
elements). 

4. In this example, the pH value of the component was changed by pH 0.5 with 
an effect on the product of approx. pH 1.  

Despite the early recognition of the disturbance variable, the controller takes 
approx. 8 minutes for compensation and control. This period will also be required 
for regulation, if the pH value of the component changes more significantly.  

Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices. 

The table below lists all parameters to be set specifically for the relevant process. 

Table 5-58 

Process tag Block Connection Usage 

QI_pH_Product I 

Subchart "A" PV_AH_En 

Upper limit violation alarm,  
if PV ≥ PV_AH_Lim  

QI_pH_Product I 

Subchart "A" PV_WH_En  

Upper limit violation warning,  
if PV ≥ PV_WH_Lim 

QI_pH_Product I 

Subchart "A" PV_WL_En  

Lower limit violation warning, 
if PV ≤ PV_WL_Lim 

QI_pH_Product I 

Subchart "A" PV_AL_En 

Lower limit violation alarm, 
if PV ≤ PV_AL_Lim 

QIC_pH_Control_MPC ConnMPC 

Subchart "A" SP1 

Setpoint specification to be 
interconnected with the SFC 

QIC_pH_Control_MPC 

ConnMPC 

Subchart "A" DV1 

Disturbance variable to be 
interconnected with the 
component channel driver (pH 
value) 

QIC_pH_Control_MPC ConnMPC 

Subchart "A" DV1 

Activate disturbance variable 
usage "1"  

QIC_pH_Control_MPC ConnMPC 

Subchart "A" 

ModLiOp 
AutModLi 
ManModLi 

Operating mode of the 
controller to be interconnected 
with the SFC 

QIC_pH_Control_MPC SP10ptHiLim 

Subchart "A" 
In2 

Upper limit for setpoint 
optimization (pos. value)  

 

QIC_pH_Control_MPC SP10ptLoLim 

Subchart "A" In2 

Lower limit for setpoint 
optimization (neg. value) 

QIC_pH_Control_Std PV 

Subchart "B" Scale 

Scaling of measured value 
(e.g. max. 15, min 2) 

QIC_pH_Control_Std PV 

Subchart "B" PV_InUnit 

Unit of the scaled measured 
value (e.g. "1422" for pH) 

YC_Neutralizer V 

Subchart "A" 

MV_HiLim 

MV_LoLim 

Upper and lower limit of the 
manipulated variable  

YC_Neutralizer 
MV 

Subchart "B" Scale 

Scaling of the manipulated 
variable (manipulated value of 
the valve block ) 

YC_Neutralizer MV 

Subchart "B" PV_InUnit 

Unit of the scaled manipulated 
value 
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Process tag Block Connection Usage 

FI_Feed I 

Subchart "A" PV_AH_En 

Upper limit violation alarm,  
if PV ≥ PV_AH_Lim  

FI_Feed I 

Subchart "A" PV_WH_En  

Upper limit violation warning, 
if PV ≥ PV_WH_Lim 

FI_Feed I 

Subchart "A" PV_WL_En  

Lower limit violation warning, 
if PV ≤ PV_WL_Lim 

FI_Feed I 

Subchart "A" PV_AL_En 

Lower limit violation alarm,  
if PV ≤ PV_AL_Lim 

 

Note Commissioning of the "QIC_pH_Control_MPC" controller can be performed 
using the program "MPC-Configurator". A description on how to proceed is 
available in the Simatic Manager online help. 

 

The table below includes an overview of all parameters to be interconnected with 
process devices, including the associated process tags. 

Table 5-59 

Process tag Block Connection Usage 

QIC_pH_Control_Std 

PV 

Subchart 
"B" PV_In pH value of the product 

YC_Neutralizer 

Rbk 

Subchart 
"B" PV_In Manipulated variable feedback 

YC_Neutralizer 

MV 

Subchart 
"B" 

PV_Out or 

PV_ChnST 

Output of the manipulated 
value with or without signal 
status 

FI_Feed 

PV 

Subchart 
"B" PV_In 

Inflow volume (feed)   

of the product  

 

Note In the object properties of the message-capable blocks you can configure 
instance-specific messages. Instructions on how to proceed are available in the 
configuration manuals "Process Control System PCS 7 Operator Station (V7.1)" 
under the entry ID: 36194551 and "SIMATIC Process Control System PCS 7 
Operator Station (V8.0)" under the entry ID: 57270173. 

 

 

5.7 Temperature-Flow-Cascade 

Temperature control with a cascade on a flow controller for a service medium (e. g. 
heating steam, cooling water or fuel) is used for applications where variations 
within the auxiliary control loop (of the flow controller) have to be balanced, or other 
inconvenient features of the manipulated variable (e. g. non-linear valve curve) of 
the slave controller have to be compensated and therefore do not become visible 
to the master controller. Temperature-Flow-Cascade controls are used e.g. for heat 
excahngers, reactors, or burners. 

http://support.automation.siemens.com/WW/view/de/36194551
http://support.automation.siemens.com/WW/view/de/57270173
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For the heat exchanger, the container contents or a component are continuously 
pumped through the exchange heater via a pipe. In the process, the component is 
heated or cooled to a defined temperature by the heat transfer of the service 
medium. 

The same regulative concept is applied for the bruner, i.e. the tempertaure is 
controlled via the flow volume of the fuel. 

 

Note The technical function „Temperature-Flow-Cascade“ can be employed for all 
industrial applications where a flow is used to control the temperature.  

 

In the following example, the temperature control of a heat exchanger which is 

heated by a heating medium is observed. Heat exchangers can also be used to 

cool a substance flow. The flow of a cooling medium is then controlled instead of a 

heating medium. The generic name for heating or cooling medium is service 

medium. Wether the intented purpose is heating or cooling does not affect the 

control structure for heat exchangers. Merely the sign of the controlled section of 

the master controller is altered.  

5.7.1 Overview 

The P&I diagram below shows the structure and describes all process tags and the 
simulation of equipment modules. 

 

P&I diagramm 

The following P&I diagram includes symbols for all components relevant to 
operation, such as aggregates, tanks, etc., using a multi-variable control system. 

Figure 5-27 

YC

ServMedium

TIC

Temperature

FIC

ServMedium

Heating medium

Feed

Outlet

 

Process tag 

The equipment module "Temperature-Flow-Cascade" consists of 3 interconnected 
process tags and one simulation chart. In the simulation chart the feed temperature 
is simulated.  

The table below provides an overview of the process tags and equipment modules 
including the associated process tag types. 
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Table 5-60 

Process tag Process tag type Description 

TIC_Temperature „CTRL_Std4Valve“ 
Master controller for 
controlling the temperature 

FIC_ServMedium „CTRL_Std4Valve“ 
Slave controller for 
controlling the flow 

YC_ServMedium „Val_An_Afb1“ 
Control valve for the heating 
medium 

 

The following P&I diagram represents all components relevant for the operation as 
symbols. 

Figure 5-28 

TIC_Temperature

FIC_ServMedium

YC_ServMedium

from_CTRL

to_CTRL

Out

In

from_Val_An1

to_Val_An1

Out

In

Sim_Temperature

Lag_Heat_Slave

In

Noise_Master

Out

Sim

Sim1ValueOp

Sim

Sim1ValueOp

from_Slave_1

to_Slave

Out

In

from_Master

to_Master

Out

In

Gain_Slave

Out

V

MV

 

 

The “TIC_Temperature” process tag uses the simulated feed temperature from 
simulation chart “Sim_Temperature” and generates the setpoint specification for 
the slave controller. This configures the desired temperature curve in the 
“TIC_Temperature” process tag.  

The “FIC_ServMedium” process tag receives the specified setpoint from the master 
controller and controls the flow volume to the heat exchanger. The PID controller 
transfers the control commands via communication blocks “to_Val_An1” to the 
“YC_ServMedium” control valve. Additionally, the controller process tag receives 
status information from the channel drivers of the valve process tag via the 
“from_Val_An1” communication blocks. 
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5.7.2 Structure and configuration 

Simulation "Sim_Temperature" 

A temperature change through heating steam on the heat exchanger is simulated 
in the “Sim_Temperature” CFC chart. 

The figure below shows the parameter configuration of the simulation block. 

 

1

42

3

5

 

1. If the valve is opened 100%, 5 t/h (factor 0.05) are output to the slave controller 
as actual flow value with a delay of 3 seconds. 

2. With a delay of 10 seconds (to simulate the heating of the heating capacity of 
the heat exchanger) a value 10 times as high as the value of the heating steam 
flow is transferred to the reference junction as actual value of the hot air 
temperature. 

3. Changing feed temperature which alteres between 20 °C and 21 °C every 90 
seconds to simulate a disturbance. 

4. Feed temperature for the master controller which alters depending on the heat 
exchanger. The output signal can be complemented with a slight signal noise. 

5. Substance temperature before being heated by the heat exchanger. 

 

Note The simulation behavior does not correspond to a real process and is used for 
displaying the functionality and principle of operation of the equipment module 
“Temperature-Flow-Cascade“. 
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TIC_Temperature 

In the “TIC-Temperature” process tag the feed temperature is recorded. The 
setpoint is specified in this process tag. The "TIC_Temperature" measurement 
point transfers the control variable as an external setpoint to the 
"FIC_ServMedium" slave controller. Thus, the "TIC_Temperature" measurement 
point is the master controller for cascading control. The "TIC_Temperature" 
measurement point is an instance from the measurement point type 
"CTRL_Std4Valve" and contains two additional communications modules 
("to_Slave" and "from_Slave").The valve connection blocks were deleted.  

Table 5-61 

Block Connection Value Usage 

C Gain.Value 1.0 Controller gain 

C TI.Value 7.3 Controller lag 

ComStruIn   
Inserted as “to_Slave”, for transfer of control 
signals to the slave controller 

to_Slave Out  
Interconnecting to the slave controller 
(FIC_ServMedium \from_Master.In) 

to_Slave ReStru1  
Interconnecting of the actual setpoint value 
(TIC_Temperature\C.SP) 

to_Slave ReStru2  
Interconnecting of the process value 
(TIC_Temperature\C.PV_Out) 

to _Slave ReStru3  

Interconnecting of the manipulated value as 
external setpoint value for the slave controller 
(TIC_Temperature\C.MV) 

to_Slave BoStru1  
Interconnecting from CascaCut to the slave 
controller (TIC_Temperature\C.CascaCut) 

to_Slave BoStru2  

Interconnecting the „Bad“-Signals of the channel 
blocks to the slave controller 
(TIC_Temperature\CSF.Out) 

ComStruOut   
Inserted as “from_Slave” to receive status 
information of the slave controller 

from_Slave In  
Interconeccting to the slave controller (Status) 
(FIC_ServMedium\to_Master.Out) 

from_Slave Int1  
Interconnecting the unit of the manipulated value 
(TIC_Temperature\C.MV_Unit) 

from_Slave BoStru1  

Interconnecting from  CascaCut to the slave 
controller 
(TIC_Temperature\Intlock.In02) 

from_Slave BoStru2  

Interconnecting the „Bad“-Signals from the slave 
controller 

(TIC_Temperature\Intlock.In03) 

from_Slave BoStru3  

Interconnecting the „Out of Service“signal from 
the slave controller 
(TIC_Temperature\Intlock.In04) 

from_Slave Scale1  

Maximum value of the manipulated value 
(TIC_Temperature\C.MV_OpScale) 
(TIC_Temperature\C.NormMV) 

Sim 
Sim1ActOp.
Value 1 Activating the simulation  

Sim 
Sim1Value
Op  

Interconnecting tot he simulated process value 
(Sim_Temperature\Noise_Maste.Out) 
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Block Connection Value Usage 

PV Scale 200.0 Maximum value of the process value 

PV PV_InUnit 1001 Scalling oft he process value in degree Celcius  

 

FIC_ServMedium 

The flow rate of the heating steam is recorded at the "FIC_ServMedium" 
measurement point. The setpoint value specification for the flow rate is 
implemented through the master controller. The "FIC_ServMedium" measurement 
point transfers the control variable to the valve measurement point 
"YC_ServMedium". "FIC_ServMedium" is the slave controller for the cascading 
control. "FIC_ServMedium" is an instance of the measurement point type 
“CTRL_Std4Valve” and contains two communications modules ("to_Master" and 
"from_Master"). 

Table 5-62 

Block Connection Value Usage 

C Gain.Value 2.8 Controller gain 

C TI.Value 1.7 Controller lag 

Intlock InvIn03 1  

Intlock Invln05 1  

Intlock Invln06 1  

ComStruIn   
Entered as "to_Master" for transmitting control 
signals to the master controller 

to_Master Out  
Interconnecting tot he master controller 
(TIC_Temperature\from_Slave.In) 

to_Master ReStru1  
Interconnecting oft he actual setpoint value 
(FIC_ServMedium\C.SP) 

to_Master ReStru2  
Interconnecting oft he process value 
(FIC_ServMedium\C.PV_Out) 

to_Master BoStru1  

Intervonnecting from CascaCut oft he slave 
controller 

(FIC_ServMedium\Intlock.In02) 

to_Master BoStru2  

Interconnecting the „Bad“-Signals des channel 
blocks of „FIC_Inflow” for the master controller  
(FIC_ServMedium\CSF.Out) 

to_Master BoStru3  

Interconnecting the „Out of Service“-Signals to 
the master controller 
(FIC_ServMedium\C.OosAct) 

to_Master Int1  

Scalling the manipulated value 

(FIC_ServMedium\PV.PV_OutUnit) 

to_Master Int2  

Scalling the process value 

(FIC_ServMedium\C.MVUnitOut) 

to_Master Scale1  

Maximum vavuel oft he process value 

(FIC_ServMedium\PV.ScaleOut) 

ComStruOut   
Entered as "from_Master" to receive status 
information of the master controller 

from_Master In  

Interconnecting tot he master controller 
(Status) 
(TIC_Temperature\to_Slave.Out) 

from_Master ReStru3  Interconnecting from  CascaCut of the slave 
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Block Connection Value Usage 

controller 
(FIC_ServMedium\Connector.SP_Ext) 

from_Master BoStru2  

Interconnecting the „Bad“-Signals oft he 
channel block from „TIC_Temperature” from 
the master controller 
(FIC_ServMedium\Intlock.In05) 

to_Valve Out  

Interconnecting to valve 

(YC_ServMedium\from_CTRL.In) 

from_Valve In  

Interconnecting to valve (Status) 

(YC_ServMedium\to_CTRL.Out) 

Sim Sim1ActOp.Value 1 Activating the simulation  

Sim Sim1ValueOp  
Interconnecting tot he simulated process value 
(Sim_Temperature\Gain_Slave.Out) 

PV Scale 10.0 Maximum value oft he process value 

PV PV_InUnit 1328 Scalling the process value (t/h) 

 

YC_ServMedium 

The valve measurement point "YC_ServMedium" controls the flow volume 
(opening of the feed input) of the heating steam to the heat exchanger. The 
measurement point contains communications modules for data exchange (control 
signals and control commands) with the controller measurement point. 

The valve module "V" contains an external control variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive 
the same value (control variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The following table shows the configuration of the instance from "Val_An_Afb1". 

Table 5-63 

Block Connection Value Usage 

V MV  

Interconnecting to the simulation 

(Sim_Temperature\Lag_Heat_Slave.In) 

V 

ER_AH_En 

(unsichtbar) 0 
Switching off the alarm message for maximal 
valve opening 

V 

ER_AL_En 

(unsichtbar) 0 

Switching off the alarm message for minimal 
valve opening 

from_CTRL In  

Interconnection to the controller 

(FIC_ServMedium\to_Valve.Out) 

to_CTRL Out  

Interconnection to the controller 

(FIC_ServMedium\from_Valve.In) 

Sim Sim1ActOp.Value 1 
Activating the simulation of the readback 
value 

Sim Sim1ValueOp  

Interconnecting with the simulation of the 
readback value from the valve 

(YC_ServMedium\V.MV) 

Sim Sim2ActOp.Value 1 Activating the simulation of the manipulated 

Sim Sim2ValueOp  Interconnecting with the simulation of the 
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Block Connection Value Usage 

manipulated value from the valve 

(YC_ServMedium\V.MV) 

 

5.7.3 Commissioning, operation and instance-specific adjustments 

Commissioning and operation requires a downloaded user program in automation 
system (AS) or S7-PLCSIM, and an activated OS (WinCC Runtime). Instructions 
for downloading the user program and activating the OS are available in chapter 7 
“Starting the Equipment Module”. 

Commissioning 

For commissioning, proceed as follows: 

Table 5-64 

No. Action 

1.  Click the block icon of the controller "FIC_ServMedium/C" to open the associated 
faceplate. 

 

2.  Change the operating mode of the first controller. In the faceplate, click the "…" 
button next to the mode switch ("Mode"), click the "Automatic" button in the 
expanded faceplate and then confirm your settings with "OK". The setpoint is 
automatically specified from external. 

Note: 

The interlock of master controller is cancelled. 

3.  Click the block icon of the master controller "FIC_ServMedium/C" to open the 
associated faceplate. 

 

4.  In the faceplate you click on the “…” button next to the mode switch (“Mode”) and 
in the faceplate extension you click on the “Automatic” button and adopt the 
settings with “OK”. 
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Operation 

The following instruction describes the operation of the equipment module 
"Temperature-Flow-Cascade“. After start-up of the CPU (in initial status) and 
commissioning, the feed temperature stays unchanged. 

In the following scenario, the temperature will be raised about 4°C. 

Table 5-65 

No. Action 

1.  Click the block icon for the operator control block " TIC_Temperature "to open the 
associated faceplate. 

2.  Click the "Setpoint" input field and enter the value "24" in the input field of the 
expanded faceplate. Then press the "ENTER" key to confirm settings and click 
the "OK" button. 

 

2

1

 

3.  Close the faceplate and watch the curve plotter for approx. 2 minutes until the 
setpoint is reached. 

Evaluation 

Figure 5-29 

1

2

 

1. The temperature of the added medium changes every 90 seconds causing the 
master controller to react to this change continually and regulate the 
temperature to its setpoint value of 21°C. 
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2. After recognizing the temperature change, the master controller transmits a 
new setpoint value to the slave controller. The slave controller reacts directly to 
this change by setting a new manipulated value (brown trend graph) and 
adjusting the process value (blue trend graph) to the setpoint value (orange 
trend graph). 
 

The slave controller (flow of the heating medium in t/h) has been configurated so 
as to regulate exactly without overshoots. 
 

Instance-specific adjustments  

The following tables contain the relevant parameters which must either be set or 
interconnected. Chapter 6.2 “Process connection” describes the procedure for 
connecting process devices. 

The table below lists all parameters to be set specifically for the relevant process. 

Table 5-66 

Process tag Block Connection Usage 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ Gain 

Proportional gain 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ TD 

Derivative time (rate time) in [s] 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ TI 

Integral time (reset time) in [s] 

TIC_Temperature / C 

Subchart „A“ SP_InHiLim 

Limit value (high) of the internal 

TIC_Temperature / C 

Subchart „A“ SP_InLoLim 

Limit value (low) of the internal 

setpoint value 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_AH_En 

Alarm for exceeded limit value,  

if PV ≥ PV_AH_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_WH_En  

Warning for exceeded limit value,  

if PV ≥ PV_WH_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_TH_En 

Tolerance for falling below the limit 

value, if PV ≤ PV_TL_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_TL_En 

Tolerance for falling below the limit 

value, if PV ≤ PV_TL_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_WL_En  

Warning for falling below the limit 

value, if PV ≥ PV_WL_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ PV_AL_En 

Alarm for falling below the limit value,  

if PV ≥ PV_AL_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ 

ER_AH_En 

(invisible) 

Alarm for exceeded error signal,  

if ER ≥ ER_AH_Lim 

TIC_Temperature / 
FIC_ServMedium 

C 

Subchart „A“ 

ER_AL_En 

(invisible) 

Alarm for fallen short of error signal,  

if ER ≥ ER_AL_Lim 

TIC_Temperature /  PV 

Subchart „B“ Scale 

Scaling the measured value (e.g.. the 
feed temperature till 150°C) 

TIC_Temperature / PV PV_InUnit Unit of the scaled manipulated 
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Process tag Block Connection Usage 

FIC_ServMedium Subchart „B“ variable 

(e.g. „1001“ for degree celcius) 

YC_ServMedium 

V 

Subchart „A“ 

MV_HiLim 

MV_LoLim 

Upper and lower limit of the 
manipulated value 

YC_ServMedium 

MV 

Subchart „B“ Scale 

Scaling the manipulated variable 
(manipulated value from the valve 
block) 

YC_ServMedium 

MV 

Subchart „B“ PV_InUnit 

Unit of the scaled manipulated 
variable 

 

Note Commissioning of the controller can be performed using the program " PID-
Tuner ". A description on how to proceed is available in chapter 6.3 
“Configuration of the PID controllers. Please observe the sequence of the 
optimization, first the flow controller and second the temperature controller.  

 

The table below includes an overview of all parameters to be interconnected with 
process devices, including the associated process tags. 

Table 5-67 

Process tag Block Connection Usage 

TIC_Temperature / 
FIC_ServMedium 

PV 

Subchart 
„B“ PV_In pH value of the product 

YC_ServMedium 

Rbk 

Subchart 
„B“ PV_In Manipulated variable feedback 

YC_ServMedium 

MV 

Subchart 
„B“ 

PV_Out 
oder 

PV_ChnST 

Output of the manipulated 
value with or without signal 
status 

 

Note In the object properties of the message-capable blocks you can configure 
instance-specific messages. Instructions on how to proceed are available in the 
configuration manuals "Process Control System PCS 7 Operator Station (V7.1)" 
under the entry ID: 36194551 and "SIMATIC Process Control System PCS 7 
Operator Station (V8.0)" under the entry ID: 57270173. 

 

 

 

http://support.automation.siemens.com/WW/view/en/36194551
http://support.automation.siemens.com/WW/view/en/57270173
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6 Configuration and Settings 

6.1 Integration of equipment modules 

Preparation 

The following instructions contain the integration of an equipment module into a 
PCS 7 project in which the following steps have been completed: 

 Adjusting HW Config 

 Configuring the communication between AS and OS (NetPro) 

 Settings at the hierarchy folders 

 Using a standardized master data library 

 

Table 6-1 

No. Action 

1.  Copy the “53843373_EquipmentModules_PCS7V713.zip” file onto the 
configuration computer and then open the SIMATIC Manager. 

2.  Click “File > Retrieve” in the menu bar and select the 
“53843373_EquipmentModules_PCS7V713.zip” file. Then confirm by clicking 
“Open”. 

3.  Select the folder in which the project is saved and acknowledge with “OK”. 

The project is extracted. 

4.  In the “Retrieve” dialog you click the “OK” button and then click “Yes” in the 
dialog to open the project. 

5.  Go to “Plant View”. 

6.  Parallel you open the project in which the template is to be integrated. 
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Integration of an equipment module 

The following instruction describes how you can integrate the “Level-Control” 
equipment module, including the required process tag types, into your project. The 
interconnection of each individual signal and the settings of each individual 
parameter are not described here. It is illustrated how you can integrate the 
simulation into your project and how you can effectively interconnect the copied 
equipment module to your process. 

The opened equipment module and the opened target project in the Plant view are 
a prerequisite. 

Table 6-2 

No. Action 

1.  In the Plant view of the equipment modules in the master data library you select 
all folders in “Process tag types” and click on “Edit > Copy”. 

2.  Go to the target project. 

In the Plant view of the master data library you select the folder for “Process tag 
types” and then click on “Edit > Paste” in the menu bar. 

 
Note: 

All charts of the equipment module and the simulation are copied. 

3.  In the Plant view of the equipment module in the AS project you select the 
hierarchy folder “EquipmentModules > Level-Control” and click on “Edit> Copy”. 

4.  Go to the target project. 

In the AS project you select the hierarchy folder to which the equipment module 
is added and then click “Edit > Paste” in the menu bar. 

Note: 

All charts of the equipment module and the simulation are copied. 

5.  In the target project you select the AS project and in the menu bar you click on 
“Options > Plant View > Update in the Multiproject”. 

The dialog for exporting the Plant hierarchy appears. 

6.  Acknowledge the dialog with “OK” and also confirm the following dialog with 
“OK”. The plant hierarchy is adjusted in the OS project of the target project. 

7.  Compile and download the AS project and then compile the OS project. 
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Adjusting the parameters of an equipment module  

The following instruction describes the steps for adjusting the parameters of an 
equipment module. For the operability of the simulation no settings need to be 
made. 

The opened target project is a prerequisite. 

 

Table 6-3 

No. Action 

1.  Go to the process object view and click on the “Parameters” tab. 

2.  In the dropdown menu you select the “Filter by column” entry and enter the chart 
name, for example LIC_Level, into the “Display” input field. 

Note: 

The button with the double arrow pointing down, next to the deactivated input 
field “Filter general” opens a second filter. With this filter you can, for example, 
filter for a “Block” named “PV” in the column and make adjustments. 

 

3.  Click into the “Value” column of the block connection you wish to change, and 
enter the new value. Acknowledge the entry with “ENTER”. 
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Interconnecting an equipment module 

The opened target project is a prerequisite. 

Table 6-4 

No. Action 

1.  Open the “Signals” tab in the process object view. 

2.  Right-click the “Signal” column of the signal you wish to interconnect, and select 
the “Insert signal” command. 

 
Note: 

The interconnected signals can be viewed in this column. 

3.  In the dialog you open the folder structure and subsequently click on “Inputs” or 
“Outputs”. 

4.  In the Details view you select the signal you wish to interconnect and click on the 
“Apply” button. 

 
Note: 

If you wish to interconnect several signals, then click on a further signal in the 
process object view and repeat step 2 to 4. 

5.  Click on the “Close” button to close the dialog. 
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Integrating a color palette into the OS 

The process images of the equipment modules use colors from the global color 
palette. In the target project the colors of the palette must also exist, otherwise the 
colors of the color palette are represented as black. 

The colors for cooling water (blue, position 10), steam (red, position 11), medium 
(violet, position 12), added pressure/venting (bright-blue, position 13), text frame 
(gray, position 15) and frame font: (gray, position 16) are defined in the project 
palette. 

The target project needs to be opened. 

Table 6-5 

No. Action 

1.  Go to the component view and open the tree view of the OS project. 

2.  Open the OS project. 

3.  Click the OS name with the right mouse button and select “Properties” from the 
context menu. 

4.  In the “Properties” you select the “User Interface and Design” tab and then click 
the “Edit” button in the “Central Color Palette” area. 

 

5.  In the Color selection dialog you click on the “Import palette” icon. 

 

6.  In the file selection dialog you select “UnitTemplates.xml” from the 
<Projektpfad>\ChColumn\ChColu_2\wincproj\OS\GraCS \DistillColumn.xml> path 
and acknowledge with “Open”. 

Note: 

The equipment module uses colors 10 to 16 of the project palette in the process 
images. If you are already using these positions, cancel the import of the color 
palette and change the colors in the process image. 

7.  In the message you click “Yes”, in order to overwrite the existing color palette 
and then close the color selection dialog and the project properties dialog with 
“OK”. 
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6.2 Process connection 

The following instruction describes an option for interconnecting the process 
devices using the example of “Level-Control” and shows which of  the configuration 
of the blocks is required. 

 

NOTE Commissioning requires a Loop check including written proof. Loop checks are 
used to check the trends for controller or control signals.  

One option of Loop checks is: 

A signal is specified on the hardware side and the signal value is checked on the 
software side (channel driver in the ES or faceplate in the OS). Checking and 
documentation verifies the interconnection in the software and the wiring up to 
the process device. 

 

Interconnecting the process device 

In order to interconnect a process device with the process tags requires parallel 
operation of simulation and real process. The target project needs to be open. 

Table 6-6 

No. Action 

1.  Open the CFC chart “LIC_Level” In subchart “B” you make the following 
changes: 

In channel block “PV” at input parameter “PV_In” you perform an interconnection 
with a process device (e.g. filling level measuring transmitter). 

Note: 

Channel block “MV” in the second sheet is not interconnected, since the control 
of the manipulated variable occurs through the valve process tag. Deactivation of 
the simulation causes an error at the “Bad” output of channel block “MV” and 
subsequently the interlocking of the controller. 

2.  Open the CFC chart “LIC_Level”. In subchart “B” you make the following 
changes: 

In channel block “PV” at input parameter “PV_In” you perform an interconnection 
with a process device (e.g. filling level measuring transmitter). 

Note: 

The additional interconnection is used for comparing the process value (filling 
level measuring transmitter) with the simulation value. 

3.  Open the CFC chart “YC_OutletValve”. In subchart “B” you make the following 
changes: 

In channel block “Rbk” at input parameter “PV_In” you perform an 
interconnection with a process device (e.g. feedback signal from manipulated 
variable). 

4.  Compile and download the blocks and charts. 

 

NOTE At channel blocks “Pcs7AnIn” and “Pcs7AnOu” it is specified via the “Mode” input 
parameter in which form the process value (raw value) is present and to be 
processed. 
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The following procedure illustrates an option for the startup process. Compare the 
local process behavior with the process behavior of the equipment module and 
adjust, if necessary, the simulation and the configuration of the equipment module. 

 

CAUTION Move the simulation into a process-oriented and stable state in order to 
prevent unexpected process jumps when changing from simulation to the 
real process connection. Typically, all controllers should be in manual 
mode when switching from simulation to real measured values. Due to the 
adjustment of the setpoint to the actual value during manual mode a 
subsequent bumpless switchover from manual to automatic mode can be 
performed. 

 

 

Table 6-7 

No. Action 

1.  Open CFC chart “LIC_Level” and “LI_Level”. Activate the test mode for the “PV” 
channel blocks (subchart “B”, sheet 1) so the connections become visible. 

 

2.  Adopt the configuration of the “Mode” input parameter from the “PV” channel 
driver of the “LIC_Level” controller process tag to channel driver “PV” of the 
“LI_Level” measured value display for the process tag. 

 
Note: 

The process value of the process device is output correctly at the channel driver 
output (equal mode for processing the process value (raw value), as configured 
in the controller process tag). 

3.  Adjust the simulation value to the process value by specifying a new setpoint 
value in the OS. Wait until the specified setpoint value has been reached. 
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No. Action 

4.  Deactivate the simulation by specifying the value “0” at simulation block “Sim” at 
input “Sim1Act0p”. 

1

2

 
Note: 

If the simulation value deviates from the process value, the controller tries to 
compensate, which leads to an undesired change of the manipulated value. 

5.  Open the CFC chart “YC_OutletValve” and activate the test mode. 

6.  Deactivate the simulation by specifying the value “0” at simulation block “Sim” 
(subchart “B”, sheet 1) at input “Sim1Act0p”.  

Note: 

Using an operator control block in the controller process tag and interconnecting 
with the simulation blocks of controller process tag and valve process tag 
enables deactivating the simulation in one step. 

 

NOTE The universal tool SIMATIC PDM (Process Device Manager) for configuration, 
settings, commissioning, diagnosis and maintenance can be used for monitoring 
the process value of a process device. 
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6.3 Configuration of the PID controllers 

For the configuration of the PID controllers the program “PID Tuner” is available. 
This program determines the optimal PID parameters for the connected controlled 
section. The following instruction describes the general procedure at the example 
of the PID controller in the CFC chart “LIC_Level”. 

 

NOTE A practical example for the operation is shown in the document “PID Control with 
Gain Scheduling and PID Tuning” 

 

Requirements 

 The controller is connected to the process or the simulation. 

 The automation program is compiled and downloaded. 

 

NOTICE An intervention in the plant process occurs through optimization. You have 
to be aware of the consequences this might have. 

Continuously monitor the process at the trend plotter during optimization. 

 

 

Selecting the amplitude of the trigger 

 Choose the jump height large enough to prompt a process response which 
clearly stands out from the measurement noise of the signals. 

 Choose the jump height small enough to ensure, that the process is not 
endangered and the product quality is not affected more than necessary. 

 For non-linear processes you perform the trigger at the operating point at 
which the controller shall work. Choose the jump height small enough to record 
the approximate linear response in the surroundings of this operating point. 

 

NOTE Coordinate all planned attempts (controller optimization) with the member of staff 
responsible for operation. 

 

 

Settings at the block 

The “PID Tuner” program is always executed on the Engineering Station (ES). 
Since the operator control and monitoring station (OS) and the ES normally do not 
run on the same computer, a coordination of the users is offered by the PCS 7 
system. The enable is given in the operator screen of the controller (View > 
Parameter). This enable gives the engineering system (PID Tuner) the right to 
actively interfere with the process. During optimization the respective operating 
options on the OS are blocked.  

To be able to use the “PID-Tuner” program, value “1” must be pending at the 
“OptimEn” input of the “PIDConL” block. If you wish to set this input in ES, execute 

http://support.automation.siemens.com/WW/view/en/38755162
http://support.automation.siemens.com/WW/view/en/38755162
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steps 1 to 5. If an enable on the OS was granted, start with step 1 of subchapter 
“Performing the controller optimization”. 

Table 6-8 

No. Action 

1.  Open the PCS 7 project in the Plant View. 

2.  Open the hierarchy folder of the AS project “EquipmentModules > Level-Control” 
and double-click on the “LIC_Level” chart.  

The CFC editor is opened 

3.  In the menu bar of the CFC Editors click “Debug > Test Mode” and acknowledge 
the “Register CPU for testing” dialog with “Yes”. 

4.  Double-click block “C” (subchart “A”, sheet 1) and click on the “Connections” tab. 

5.  Change the value of the “OptimEn” connection to value “1” and acknowledge with 
“OK”. Then close the block. 

 

Performing controller optimization 

The following instruction describes a controller optimization for a controlled section 
for filling level with integrating behavior. 

Table 6-9 

No. Action 

1.  In the menu bar of the CFC editors you click on “Edit > Optimize PID 
controller…”. 

The PID tuner opens. 

2.  In the curve plotter you click “Stop” to stop the recording and then clock the 
“Settings” button. 
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No. Action 

3.  For the 3 curves (setpoint, actual value, manipulated value) you specify suitable 
limits for the Y axis. 

4.  Adjust the “Recording cycle” and the “Length of the time axis” to the expected 
process behavior and acknowledge the input with “OK”. 

Note: 

The online help offers detailed information on controller optimization. In the 
bottom part of the PID tuner you click the “Help” button to open the online help. 

5.  In the bottom part of the PID tuner you click the “Start Controller Optimization”. 

6.  In step 1 for a filling level control you click the radio button “With integral action in 
the process” and then click on “Next”. For controlled sections for temperature 
please select "Without integral action in the process". 

 

7.  In the “Operating mode” group you select the “Automatic” checkbox if you 
already have an approximately stable controller. As a start point you enter the 
typical operating point of the controlled variable. Please note the warning in the 
bottom part of the dialog and then click on “Next”. 

8.  As “Step trigger, new setpoint:” you specify a setpoint value clearly above the 
typical operating point. Please note the warning in the bottom part of the dialog 
and then click on “Next”. 

The controller optimization is now started. 

9.  After completing the optimization in the “Process trigger” group you select the 
checkbox “Reset”. Please note the warning in the bottom part of the dialog and 
then click on “Next”. 

10.  In the “Controller design for” group you select the “Optimal control response” box 
and click “Next”. 

An additional window with the result of the identification is opened. 

11.  In the “Controller parameter” group you select the checkbox of the PI controller 
and click on “Next”. 

12.  In step 8 you click: “Simulate a control loop with the optimized parameters” and 
on “Next”. 

13.  Click the “New” button to accept the determined values. 

Please note the warning in the bottom part of the dialog and then click on “Finish” 
to complete the optimization. 
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7 Starting the Equipment Modules 

7.1 Preparation 

The following instruction describes the commissioning of the equipment module, in 
which the controller is simulated with the “S7-PLCSIM” program. If a real controller 
is used you must adjust the hardware settings in HW Config beforehand. 

 

Table 7-1 

No. Action 

1.  Copy the “53843373_EquipmentModules_PCS7V713.zip” file to any folder on the 
configuration computer and then open the SIMATIC Manager. 

2.  Click “File > Retrieve” in the menu bar and select the 
“53843373_EquipmentModules_PCS7V713.zip” file. Then confirm by clicking 
“Open”. 

3.  Select the folder in which the project is saved and acknowledge with “OK”. 

The project is retrieved. 

4.  Acknowledge the “Retrieve” dialog with “OK” and then click “Yes” in the dialog to 
open the project. 

5.  Right-click on “EquipmentModules_OS_Prj > ES01VM01 > WinCC Appl. > OS” 
and click on the menu command “Open object”. 

6.  Acknowledge the “The configured server is not available” dialog with “OK”. 

7.  In WinCC Explorer you open the properties of your computer and click the “Use 
Local Computer Name”. 

Acknowledge the “Change computer name” message with “OK”. 

 

8.  In the WinCC Explorer you click on “File > Exit” and in the following dialog you 
select “Close project and exit WinCC Explorer”.  

Acknowledge with "OK". 

9.  Open the WinCC Explorer again as described in step 5. 

10.  In the WinCC Explorer you right-click on “OS > Tag Management > SIMATIC S7 
PRO… > Industrial Ethernet” and select the menu command “System 
parameter”. 

Note: 

The dialog can be opened in the background and must then be clicked in the 
Windows toolbar. 

11.  In the “Unit” tab you check the set “Logical device name”. When using the “S7-
PLCSIM” the device name PLCSIM (ISO) is selected. Changing the device name 
requires a restart of the program. Open the WinCC Explorer again as described 
in step 5. 
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7.2 Commissioning 

The following instruction describes how the equipment module is set to initialization 
mode. 

Commissioning requires that the SIMATIC Manager has already been opened and 
the equipment module is selected in the components view. 

Start simulation (S7-PLCSIM) 

To start the simulation, proceed according to the instruction: 

 

Table 7-2 

No. Action 

1.  Select “Options > Simulate Modules” from the menu. 

The dialog window of “S7-PLCSIM” opens. 

2.  In the “Open project” dialog you select the “Open project from a file” option. 

3.  Select the “EquipmentModules.plc” file from the path <project 
path>\EquipmentModules\EM_AS\EquipmentModules.plc>. 

4.  Select “Execute > Key position switch > RUN-P” from the menu. 

5.  Go to the components view of the SIMATIC Manager and select 
“EquipmentModules_AS_Prj > AS01”. 

6.  In the menu bar you click on “PLC > Download” and acknowledge the 
“Download” with “Yes”. Acknowledge the “Stop Target Module” dialog with “OK” 
and subsequently the “Download” dialog with “Yes”. 
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Activating OS (WinCC Runtime) 

To activate the OS, proceed according to the following instruction: 

Table 7-3 

No. Action 

1.  Make a right mouse click on the OS and select the “Open Object” menu. 

 

2.  To activate the OS (WinCC Runtime), select “File > Activate” in the WinCC 
Explorer menu. 

3.  In the “System Login” dialog you log in with the user “Equipment” and the 
password “Modules” and acknowledge with “OK”. 

4.  In the picture section you select an equipment module (e.g. “Level-Control”), 
whose principle of operation you wish to know about. 
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8 Links & Literature 

8.1 Further literature 

The following list is by no means complete and only provides a selection of 
appropriate sources. 

 

Table 8-1 

 Topic Title 

/1/ Practice book for controlling with 
SIMATIC S7 and SIMATIC PCS7 
for process automation 

Regeln mit SIMATC (Controlling with 
SIMATIC) 

Müller, Jürgen / Pfeiffer, Bernd-Markus / 
Wieser, Roland   

Publicis Kommunikationsag   

ISBN 978-3895783401 

/2/ Design of standard controller Krämer, S. 
Auslegung von Standreglern in der 
verfahrenstechnischen Praxis. (Design of 
standard controller in process practice.) 
Dechema- Seminar „Prozessregelungen – von 
den Grundlagen zu Advanced Control“ (The 
Dachema seminar on "Process control 
systems – from the basics to advanced control 
applications") 
Sep. 2008 

 

8.2 Internet links 

The following list is by no means complete and only provides a selection of 
appropriate sources. 

 

Table 8-2  

 Topic Title / Link 

\1\ Siemens Industry Online Support http://support.automation.siemens.com 

\2\ Download page of this entry http://support.automation.siemens.com/WW/view
/en/53843373 

 

\3\ SIMATIC PCS 7 Overview – 
Landing Page 

http://support.automation.siemens.com/WW/view
/en/63481413 

\4\ Controller optimization with PID 
tuner 

http://support.automation.siemens.com/WW/view
/en/8031495 

\5\ Application for model-based 
predicative control 

http://support.automation.siemens.com/WW/view
/en/42200753 

\6\ Configuring a cascade control http://support.automation.siemens.com/WW/view
/en/43033319 

\7\ PCS 7 Unit Template "Stirred Tank 
Reactor" using the example of the 
Chemical Industry 

http://support.automation.siemens.com/WW/view
/en/60546560 

\8\ PCS 7 Unit Template "Fermenter" 
using the example of the Chemical 

http://support.automation.siemens.com/WW/view
/en/68098270 

http://support.automation.siemens.com/
http://support.automation.siemens.com/WW/view/en/53843373
http://support.automation.siemens.com/WW/view/en/53843373
http://support.automation.siemens.com/WW/view/en/63481413
http://support.automation.siemens.com/WW/view/en/63481413
http://support.automation.siemens.com/WW/view/en/8031495
http://support.automation.siemens.com/WW/view/en/8031495
http://support.automation.siemens.com/WW/view/en/42200753
http://support.automation.siemens.com/WW/view/en/42200753
http://support.automation.siemens.com/WW/view/en/43033319
http://support.automation.siemens.com/WW/view/en/43033319
http://support.automation.siemens.com/WW/view/en/60546560
http://support.automation.siemens.com/WW/view/en/60546560
http://support.automation.siemens.com/WW/view/en/68098270
http://support.automation.siemens.com/WW/view/en/68098270
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 Topic Title / Link 

Industry  

\9\ PCS 7 Unit Template " Distillation 
Column" using the example of the 
Chemical Industry 

http://support.automation.siemens.com/WW/view
/en/48418663 

 

\10\ PCS 7 Unit Template "Dryer" using 
the example of the Chemical 
Industry 

http://support.automation.siemens.com/WW/view
/en/74747848 

\11\ PCS 7 Unit Template 
"Polymerization Reactor" using the 
example of the Chemical Industry 

http://support.automation.siemens.com/WW/view
/en/84061788 

\12\ SIMATIC Process Control System 
PCS 7, PCS 7 Advanced Process 
Library V7.1 SP5 

http://support.automation.siemens.com/WW/view
/en/48034370 

\13\ How do you procure documentation 
for PCS 7 V8.0 (including the PCS 7 
V8.0 Manual Collection)? 

http://support.automation.siemens.com/WW/view
/en/59538371 

 

http://support.automation.siemens.com/WW/view/en/48418663
http://support.automation.siemens.com/WW/view/en/48418663
http://support.automation.siemens.com/WW/view/en/74747848
http://support.automation.siemens.com/WW/view/en/74747848
http://support.automation.siemens.com/WW/view/en/84061788
http://support.automation.siemens.com/WW/view/en/84061788
http://support.automation.siemens.com/WW/view/en/48034370
http://support.automation.siemens.com/WW/view/en/48034370
http://support.automation.siemens.com/WW/view/en/59538371
http://support.automation.siemens.com/WW/view/en/59538371
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9 History 
 

Table 9-1 

Version Date Changes 

V1.0 07.12.2011 First issue 

V1.1 22.04.2012 Valid for PCS 7 V7.1.3 and PCS 7 V8.0 

V1.2 04.06.2012 Corrections and notes in response to suggestions 

V2.0 12.06.2013 Expansion of the Val process tag type, new CTRL process 
tag types, additional equipment modules for pH value 
regulation. 

V2.1 25.10.2013 New process tag types (CTRL,AMON and MOT) for multi-
variable controls and drives integrated. Additional links 
added 

V2.2 17.04.2014 New equipment module “Temperature-Flow-Cascade” 
added 
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10 Appendix 

10.1 Block description “SwSqrt” 

Function description 

The square root function does not correct the non-linear signal band of a squared 
signal. The block has one operating mode without (mode 1) and one with low value 
suppression (mode 2). Simulation and substitution values are performed without 
change. 

The square root function is activated by changing the MODE input to 1 or 2. For 2 
the signals are suppressed under the LSUPLEVL (=LRANGE). 

Operating modes 

During the simulation (SimMode = 1) the status of the input signal is ignored. 

Table 10-1 

 MODUS Scale IN QUALITY OUT 

 <1 

>2 

all all all OUT = IN 

 all all all 16#48 

16#60 

OUT = IN 

 1 

or 

2 

Scale.Low < 
Scale.High 

all all OUT = IN 

 1 Scale.Low < 
Scale.High 

IN <= 
Scale.Low 

Oder 

IN < 0 

<> 16#48 

<> 16#60 

OUT = 
SQRT*1 

 1 Scale.Low < 
Scale.High 

IN > 0 <> 16#48 

<> 16#60 

OUT = 
SQRT*2 

 2 Scale.Low < 
Scale.High 

IN < 0 

or 

SUP* 

<> 16#48 

<> 16#60 

OUT =0 

 2 Scale.Low < 
Scale.High 

IN > LoSupLv <> 16#48 

<> 16#60 

OUT = 
SQRT*2 

 

 

 

 

 
100

..
..*

LowScaleHighScale
LoSupLvlLowScaleHighScaleINSUP




    HighScaleINSQRT .11*1 

  LowScaleLowScaleHighScaleINSQRT ...*2 
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Inputs 

Table 10-2 

Input Data type Default value Description 

Mode BOOL 0 MODE selection 

IN 

->Value 

->ST 

STRUCT 

->INT 

->Byte 

 

0 

16#0 

Input value 

Scale 

->High 

->Low 

STRUCT 

->REAL 

->REAL 

 

100.0 

0.0 

Measuring range of 
“IN“ 

LoSupLvl REAL 0.0 Degree of 
suppression for low 
values 

SimMode Bool 0 1=Ignore Sim/Subs, 
0=Pass IN value 
through, Value if 
IN.ST=48 or 60 

 

Outputs 

Table 10-3 

Output Data type Default value Description  

OUT 

->Value 

->ST 

STRUCT 

->INT 

->Byte 

 

0 

16#0 

Output value 
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10.2 Block description “SwLowact” 

Function description 

If the low active mode is activated then the input signals can be inverted on the 
output of the block “SwLowact”. 

Simulation and substitution values are performed without change. 

Operating modes 

During the simulation (SimMode = 1) the status of the input signal is ignored. Set 
the MODE-Input to 1 for using this option. 

Table 10-4 

Mode Input IN Default value OUT 

0 any any OUT=IN 

1 any 16#48 OUT=IN 

1 any 16#60 OUT=IN 

1 any Not 16#48, not 16#48 OUT=not(IN) 

 

Input and Output parameters 

Table 10-5 

Parameter Parameter 
type 

Description Data 
type 

Default 
values 

Mode IN MODE selection BOOL 0 

In IN Input value STRUCT 0 

SimMode IN 1=Ignore Sim/Subs,  

0=Input value is output value, if 
In.ST=48 or 60 

BOOL 0 

Out OUT Output value BOOL 0 
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10.3 Block description “SimAn” 

Function description 

The block represents the interface between an analog channel driver block of the 
Advanced Process Library (APL) and the operator station (OS). In the run 
sequence, the block is installed before the driver block. A maximum of 8 analog 
values are simulated with a block. 

Inputs 

Table 10-6 

Input 
(X = 1 … 8=) 

Data type Default 
value 

Description 
(X = 1 … 8=) 

SimXActOp-

>Value 

->ST 

STRUCT 

->BOOL 

->Byte 

 

0 

16#0 

Simulation ON/OFF 
for simulation value X 

SimXValueOp 

->Value 

->ST 

STRUCT 

->REAL 

->Byte 

 

0.0 

16#0 

Simulation value X 

ScaleX 

->High 

->Low 

STRUCT 

->REAL 

->REAL 

 

100.0 

0.0 

Measuring range of simulation value X 

OpEnSiOff BOOL 1 1=operator can switch off the simulation. 

OpEnSiOn BOOL 1 1=operator can switch on the simulation. 

OpEnSiValue BOOL 1 1=operator can enter the simulation value. 

BatchEn BOOL 0 1=Batch enable 

BatchID DWORD 16#0 Batch ID number 

BatchName STRING[32]  Batch name 

StepNo DWORD 16#0 Batch step number 

Occupied BOOL 0 1=occupied by a batch. 

SelFp1 ANY  Calling a batch as additional faceplate in 
the standard view 

SelFp2 ANY  Calling a batch as additional faceplate in 
the standard view 

Feature STRUCT  Connection for further functions 

Outputs 

Table 10-7 

Output 
(X = 1 … 8=) 

Data type Default 
value 

Description 
(X = 1…8) 

SimXActOut->Value 

->ST 

STRUCT 

->BOOL 

->Byte 

 

0 

16#0 

Simulation ON/OFF 

for simulation value X 

SimXValueOut 

->Value 

->ST 

STRUCT 

->REAL 

->Byte 

 

0.0 

16#0 

Simulation value X 
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10.4 Block description “SimDi” 

Function description 

The block represents the interface between an analog channel driver block of the 
Advanced Process Library (APL) and the operator station (OS). In the run 
sequence, the block is installed before the driver block. A maximum of 8 digital 
values can be simulated with one block. 

Inputs 

Table 10-8 

Input 
(X = 1…8) 

Data type Default 
value 

Descritpion 
(X = 1…8) 

SimXActOp-

>Value 

->ST 

STRUCT 

->BOOL 

->Byte 

 

0 

16#0 

Simulation ON/OFF 

for simulation value X 

SimXValueOp 

->Value 

->ST 

STRUCT 

->BOOL 

->Byte 

 

0.0 

16#0 

Simulation value X 

OpEnSiOff BOOL 1 1=operator can switch off the simulation. 

OpEnSiOn BOOL 1 1=operator can switch on the simulation. 

OpEnSiValue BOOL 1 1=operator can enter the simulation 
value. 

BatchEn BOOL 0 1=Batch enable 

BatchID DWORD 16#0 Batch ID number 

BatchName STRING[32]  Batch name 

StepNo DWORD 16#0 Batch step number 

Occupied BOOL 0 1=occupied by a batch. 

SelFp1 ANY  Calling a batch as additional faceplate in 
the standard view 

SelFp2 ANY  Calling a batch as additional faceplate in 
the standard view 

Feature STRUCT  Connection to further functions 

 

Outputs 

 

Table 10-9 

Output 
(X = 1 …8) 

Data type Default 
value 

Description 
(X = 1 …8) 

SimXActOut->Value 

->ST 

STRUCT 

->BOOL 

->Byte 

 

0 

16#0 

Simulation ON/OFF 

for simulation value X 

SimXValueOut 

->Value 

->ST 

STRUCT 

->REAL 

->Byte 

 

0.0 

16#0 

Simulation value X 
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10.5 Block description "pHTitrBlock" 

Function description 

This block is used for the conversion of pH values into concentration differences. 
This is effected by entering some process-specific characteristics of the titration 
curve in the form of parameters for the pH amplitude and buffer effect (α). The 
titration curve describes the correlation between the pH value and the 
concentration difference between H

+
 (or H3O

+
) ions (acid) and OH

-
 ions (lye) in the 

solution. For a given combination of chemicals, it can be determined experimentally 
by adding an acid or caustic solution (neutralizer) in small steps. After each small 
dose the solution is mixed and after a while, when the neutralization reaction has 
become effective, the new pH value is noted down. 

For the equipment modules for pH value regulation, the following trigonometric 
function is used as an approximation of the titration profile: 








 


610
arctan

2
7

cpH
pH

ampl



 

The pH values are then converted into concentration differences by inverting this 
characteristic profile: 

  6107
2

tan
1














 pH

pH
c

ampl




 

 

Note Conversion is performed in the following two blocks which are part of 
"pHTitrBlock" included in the master data library: 

 FB1025 "Titr_pH" for conversion from concentration difference 
 pH value 

 FB1026 "TitrDeltaC" for conversion from pH value  
concentration difference  
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Figure 10-1 – Titration curves for differently buffered solutions, pHampl=5 

 

In this titration curve diagram, the neutral zone is given at pH 7 with a maximum 
deflection (amplitude) of 5. The slope of the characteristic curve in the neutral point 
(parameter α) shows typical values between 3500 and 12000. 

 

NOTICE Precondition for use in a productive process environment is the knowledge 
of the titration curve parameters which must be entered in the block. These 
parameters include: 

 the amplitude range to be processed pHampl on the pH value scale 

 the buffer parameter α (alfa) as a measure for the slope of the curve 
in the neutral point 

 

 

Inputs 

Table 10-10 

Input 
 

Data type Description 
 

CV STRUCT 
->Real 
->Byte 

actual pH value 

-1 -0.8 -0.6 -0.4 -0.2 0 0.2 0.4 0.6 0.8 1

x 10
4

2

3

4

5

6

7

8

9

10

11

12

delta c

pH

 

 

alfa=3500

alfa=12000
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Input 
 

Data type Description 
 

DV STRUCT 
->Real 
->Byte 

pH value of the disturbance variable 

SP STRUCT 
->Real 
->Byte 

pH setpoint (e.g. defined by the OpAnL operator control 
block or SFC) 

Alfa STRUCT 
->Real 
->Byte 

Measure for the slope of the characteristic curve in the 
neutral point 

Ampl_pH STRUCT 
->Real 
->Byte 

The amplitude range to be covered 

MV STRUCT 
->Real 
->Byte 

Controller setpoint 

Feed_PV_Out STRUCT 
->Real 
->Byte 

Inflow (feed) of the component (disturbance variable) 

Feed_Scale STRUCT 
->Real 
->Real 

Feed scaling (ScaleOut) 

 

The inputs "CV", "DV" and "SP" are converted into concentration differences by 
means of the parameters "Alfa" and "Ampl_pH". 

Outputs 

Table 10-11 

Output 
 

Data type Description 
 

CV_Out STRUCT 
->Real 
->Byte 

Concentration difference of the actual pH value 

DV STRUCT 
->Real 
->Byte 

Concentration difference of the pH value of the 
disturbance variable 

SP STRUCT 
->Real 
->Byte 

Concentration difference of the pH setpoint 

MVHiLim STRUCT 
->Real 
->Byte 

Variable upper limit of the manipulated value MV in 
dependence of the component’s feed rate 
(MVHiLim =100/Feed_PV_Out/Feed_Scale.Max) 

MV_Valve STRUCT 
->Real 
->Byte 

Variable manipulated value (to the valve process tag) in 
dependence of the component’s feed rate 
(MV_Valve = Feed_PV_Out/Feed_Scale.Max * MV) 

 

Interconnection of the manipulated/disturbance variables’ inputs and outputs ("MV", 
"Feed_PV_Out", "Feed_Scale", "MVHiLim", "MV_Valve") is performed when the 
feed quantity shall be compensated by means of a disturbance variable. 
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NOTE The output variable of the controller (conceptually a "concentration") is multiplied 
with the (normalized) inflow quantity of the wastewater (component) in order to 
calculate a unit for the required amount of neutralizer. If the setpoint limitation in 
the controller were constant, the control range of the dosing valve would be fully 
utilized only at maximum wastewater throughput. This problem is solved by a 
dynamic interconnection of MV1HiLim in dependence of the inflow quantity 
(feed). 
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10.6 Block description "SimpHTitr" 

Function description 

This block is used to calculate a ph value on the basis of process-specific 
characteristics such as the titration curve of the process, inflow volumes (feed) and 
the pH value of the component and neutralizer. The titration curve describes the 
connection between the pH value and the concentration difference of the 
neutralizer added. 

Inputs 

Table 10-12 

Input 
 

Data 
type 

Description 
 

Feed_pH STRUCT 
->Real 
->Byte 

pH value of the component 

Alfa STRUCT 
->Real 
->Byte 

Measure for the slope of the characteristic curve in the 
neutral point 

Ampl_pH STRUCT 
->Real 
->Byte 

The amplitude range to be processed 

Neutr_MV STRUCT 
->Real 
->Byte 

Manipulated value of the controller for the neutralizer 

Neutr_Lag Real Delay of the manipulated value (neutralizer) 

Neutr_Factor Real Factor value for neutralizer inflow 

Feed_PV STRUCT 
->Real 
->Byte 

Component inflow volume (feed) 

pH_DeadTime Real Delayed signal output in seconds (dead time) 

 

NOTICE When using the dead time function (pH_DeadTime > 0), a multi-variable 
controller (ModPreCon block) for dead time compensation and disturbance 
variable compensation must be used. 
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Outputs 

Table 10-13 

Output 
 

Data 
type 

Description 
 

pH STRUCT 
->Real 
->Byte 

pH simulation value 

 

Calculation of the pH value is performed in the following steps: 

1. Determine the products (multiplication) from the concentration differences, the 
component inflow volumes and the neutralizing agent 

2. Determine the total feed volume 

3. Calculate the factor (relative concentration difference) from the products and 
the total feed volume 

4. Convert the concentration difference into the actual pH value 

 

Simulation offers to adjust both the process-specific characteristic values of the 
titration curve, as well as the effect of the values for disturbance variable 
compensation (by changing the pH value of the components by ± 1) and the 
variable feed rates (changing the feed volume by ±500 mol/L).  
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10.7 Units of measure 

The units of measure are listed in the following table (in accordance with IEC 
61158). 

Table 10-14 

 

 

NOTE An overview of the units of measure you will find in the manuals „SIMATIC 
Process Control System PCS7 PCS 7 Advanced Process Library V7.1 SP5“ and 
“SIMATIC Process Control System PCS 7 PCS 7 Advanced Process Library 
V8.0”. 

 

 

  Value Display Description Value Display Description 

1000  K  Kelvin 1100  g/cm3 

 Grams per cubic 

 centimeter 

1001  °C  Degrees Celsius 1105  g/L  Grams per liter 

1002  °F  Degrees Fahrenheit 1120  N  Newton 

1005  °  Degrees 1123  mN  Millinewton 

1006  '  Minute 1130  Pa  Pascal 

1007  ''  Second 1133  kPa  Kilopascal 

1010  m  Meter 1137  bar  Bar 

1013  mm  Millimeter 1138  mbar  Millibar 

1018  ft  Foot 1149  mmH2O  Millimeters of water 

1023  m2  Square meter 1175  W·h  Watt hour 

1038  L  Liter 1179  kW·h  Kilowatt hour 

1041  hl  Hectoliter 1181  kcalth  Kilocalorie 

1054  s  Second 1190  kW  Kilowatt 

1058  min  Minute 1209  A  Ampere 

1059  h  Hour 1211  mA  Milliampere 

1060  d  Day 1221  A·h  Ampere hour 

1061  m/s  Meters per second 1240  V  Volt 

1077  Hz  Hertz 1342  %  Percent 

1081  kHz  Kilohertz 1349  m3/h  Cubic meters per  

1082  1/s  Per second 1353  L/h  Liters per hour 

1083  1/min  Per minute 1399  Mol/L  Mole per liter 

1088  kg  Kilogramm 1422  pH  pH value 

1092  t  Metric ton 

http://support.automation.siemens.com/WW/view/en/48034370
http://support.automation.siemens.com/WW/view/en/48034370
http://support.automation.siemens.com/WW/view/en/57265842
http://support.automation.siemens.com/WW/view/en/57265842
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